## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preface</strong></td>
<td>15</td>
</tr>
<tr>
<td>Documentation Set</td>
<td>16</td>
</tr>
<tr>
<td>Adobe Portable Document Format</td>
<td>17</td>
</tr>
<tr>
<td>Documentation Conventions</td>
<td>18</td>
</tr>
<tr>
<td><strong>What's New</strong></td>
<td>21</td>
</tr>
<tr>
<td>New Features and Enhancements</td>
<td>22</td>
</tr>
<tr>
<td><strong>Chapter 1. Introduction</strong></td>
<td>25</td>
</tr>
<tr>
<td>CUA Interface for Ease of Use</td>
<td>26</td>
</tr>
<tr>
<td>Logical Tuning Approach</td>
<td>27</td>
</tr>
<tr>
<td>Features</td>
<td>28</td>
</tr>
<tr>
<td>Batch Reporting Methods</td>
<td>30</td>
</tr>
<tr>
<td><strong>Chapter 2. Learning About the CUA Interface</strong></td>
<td>31</td>
</tr>
<tr>
<td>Panel Contents</td>
<td>32</td>
</tr>
<tr>
<td>CUA Interface Panel Characteristics</td>
<td>33</td>
</tr>
<tr>
<td>Action Bar</td>
<td>35</td>
</tr>
<tr>
<td>Navigating</td>
<td>38</td>
</tr>
<tr>
<td>Using Help</td>
<td>40</td>
</tr>
<tr>
<td>Enter Key</td>
<td>42</td>
</tr>
<tr>
<td>Function Keys</td>
<td>43</td>
</tr>
<tr>
<td>Exiting from OMEGAMON II</td>
<td>45</td>
</tr>
<tr>
<td><strong>Chapter 3. Getting Started with OMEGAMON II</strong></td>
<td>47</td>
</tr>
<tr>
<td>Logging Onto OMEGAMON II</td>
<td>48</td>
</tr>
<tr>
<td>Begin Your OMEGAMON II Session</td>
<td>53</td>
</tr>
<tr>
<td>Using the Region Status Panel</td>
<td>54</td>
</tr>
<tr>
<td>Using the Actions Pull-down</td>
<td>60</td>
</tr>
<tr>
<td>Using the GoTo Pull-down</td>
<td>61</td>
</tr>
<tr>
<td>Using the Index Pull-down</td>
<td>65</td>
</tr>
<tr>
<td>Using the View Pull-down</td>
<td>67</td>
</tr>
<tr>
<td>Using the Options Pull-down</td>
<td>72</td>
</tr>
<tr>
<td>Dynamic Profile Update Facility</td>
<td>96</td>
</tr>
<tr>
<td>Using the Help Pull-down</td>
<td>97</td>
</tr>
<tr>
<td><strong>Chapter 4. CICS Problem-Solving Approaches</strong></td>
<td>99</td>
</tr>
<tr>
<td>Excessive CPU Usage</td>
<td>100</td>
</tr>
<tr>
<td>Excessive Response Time for Users</td>
<td>104</td>
</tr>
<tr>
<td>Users Complaining about Bad Response</td>
<td>108</td>
</tr>
</tbody>
</table>
# OMEGAMON II for CICS User's Guide, Version 520

## Chapter 5. Monitoring Workloads
- New Application Experiencing Poor Response .................................................. 110
- Program's Changes Not Being Reflected ......................................................... 115
- CICS Is Not Responding .................................................................................. 122
- User Terminal Is Not Responding  ..................................................................... 126

## Chapter 6. Monitoring Resources
- CPU ................................................................................................................. 164
- DASD ............................................................................................................... 167
- DB2 .................................................................................................................. 170
- DBCTL ............................................................................................................. 173
- DL/I ................................................................................................................. 175
- Files .................................................................................................................. 177
- Journals .......................................................................................................... 182
- Local Shared Resources (LSR) ......................................................................... 189
- MRO/ISC .......................................................................................................... 192
- Paging .............................................................................................................. 195
- Storage ............................................................................................................ 197
- Tapes .............................................................................................................. 201
- TempStor (Temporary Storage) ......................................................................... 204
- TranData (Transient Data) ................................................................................ 208
- Web Interface .................................................................................................. 213
- TCP/IP Socket Activity .................................................................................... 214

## Chapter 7. Monitoring Message Queueing
- Overview .......................................................................................................... 216
- CUA Panels for MQ ......................................................................................... 217
- Implementing MQ ............................................................................................ 218
- MQ Monitoring Functions .............................................................................. 219
- Displaying Application Trace Data for MQ ..................................................... 226
- Resource Limiting of MQ Requests .................................................................. 228

## Chapter 8. Responding to Alerts
- Bottlenecks ...................................................................................................... 230
- CICS Loop (CICS Time-of-Day Clock) ............................................................... 234
- Dumps .............................................................................................................. 236
- Enqueues ......................................................................................................... 238
- I/O Rate .......................................................................................................... 241
| Chapter 9. | Defining Response Time Groups for Monitoring | 251 |
| Importance of Defining Groups | 252 |
| How to Use This Chapter | 253 |
| Managing Groups | 254 |
| Appendix A. | OMEGAVIEW Enhanced Zoom | 269 |
| Zooming from OMEGAVIEW to OMEGAMON II | 270 |
| Zoom Summary Table | 271 |
| Default or First Zoom Destination Choice | 273 |
| Alternate Zoom Destinations | 274 |
| Usage Notes | 276 |
| Appendix B. | Fast Pathing in the CUA Interface | 277 |
| Entering the Fast Path | 278 |
| Fast Path Tables | 279 |
| Appendix C. | Transplex Navigation and Session Switching | 289 |
| Session Switching | 290 |
| Transplex Navigation | 291 |
| Using Transplex Navigation with OMEGAMON II for CICS | 293 |
| Appendix D. | CUA Actions | 297 |
| Purpose | 298 |
| Summary of Panel Changes | 302 |
| Appendix E. | Guide to Candle Customer Support | 317 |
| Base Maintenance Plan | 318 |
| Enhanced Support Services | 322 |
| Customer Support Contact Information | 323 |
| Index | 325 |
## List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1.</td>
<td>Symbols in Command Syntax</td>
<td>19</td>
</tr>
<tr>
<td>Table 1.</td>
<td>OMEGAVIEW to OMEGAMON II for CICS Zoom Summary</td>
<td>271</td>
</tr>
<tr>
<td>Table 2.</td>
<td>CUA Panel Enhancements (CICS Release 2.1.2)</td>
<td>302</td>
</tr>
<tr>
<td>Table 3.</td>
<td>CUA Panel Enhancements (CICS Release 3.1.1 or 3.2.1)</td>
<td>305</td>
</tr>
<tr>
<td>Table 4.</td>
<td>CUA Panel Enhancements (CICS Release 3.3.0)</td>
<td>307</td>
</tr>
<tr>
<td>Table 5.</td>
<td>CUA Panel Enhancements (CICS Release 4.1.0)</td>
<td>310</td>
</tr>
<tr>
<td>Table 6.</td>
<td>CUA Panel Enhancements (CICS Release 5.1.0)</td>
<td>312</td>
</tr>
<tr>
<td>Table 7.</td>
<td>CUA Panel Enhancements (CICS Release 5.2.0)</td>
<td>315</td>
</tr>
</tbody>
</table>
Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Typical CUA Interface Panel</td>
<td>32</td>
</tr>
<tr>
<td>2</td>
<td>Action Bar</td>
<td>35</td>
</tr>
<tr>
<td>3</td>
<td>Region Status Panel, Options Pull-Down (Prior to CICS 5.1.0)</td>
<td>36</td>
</tr>
<tr>
<td>4</td>
<td>Date Format Selection Pop-up</td>
<td>37</td>
</tr>
<tr>
<td>5</td>
<td>Fast Pathing Entry</td>
<td>39</td>
</tr>
<tr>
<td>6</td>
<td>Pushbutton Mnemonics on the Response Times Panel</td>
<td>39</td>
</tr>
<tr>
<td>7</td>
<td>Help Pull-down Menu</td>
<td>40</td>
</tr>
<tr>
<td>8</td>
<td>Sign On Panel</td>
<td>48</td>
</tr>
<tr>
<td>9</td>
<td>Sign On Panel Showing Logon Options</td>
<td>50</td>
</tr>
<tr>
<td>10</td>
<td>Region Status Panel (CICS/ESA Version 5.1.0)</td>
<td>54</td>
</tr>
<tr>
<td>11</td>
<td>Region Status Panel (prior to CICS/ESA Version 5.1.0)</td>
<td>55</td>
</tr>
<tr>
<td>12</td>
<td>Analyze DASD Problems Panel</td>
<td>57</td>
</tr>
<tr>
<td>13</td>
<td>AIDs Summary with Actions Pull-down</td>
<td>60</td>
</tr>
<tr>
<td>14</td>
<td>GoTo Pull-down Menu</td>
<td>61</td>
</tr>
<tr>
<td>15</td>
<td>CICS Tables Panel</td>
<td>62</td>
</tr>
<tr>
<td>16</td>
<td>Task History Panel</td>
<td>63</td>
</tr>
<tr>
<td>17</td>
<td>CICS Memory Panel</td>
<td>64</td>
</tr>
<tr>
<td>18</td>
<td>Index Pull-down Menu</td>
<td>65</td>
</tr>
<tr>
<td>19</td>
<td>Search Index Pop-up Window</td>
<td>66</td>
</tr>
<tr>
<td>20</td>
<td>Typical View Pull-down Menu</td>
<td>67</td>
</tr>
<tr>
<td>21</td>
<td>View Some Pop-up Showing Filter Criteria</td>
<td>68</td>
</tr>
<tr>
<td>22</td>
<td>Tasks Panel with Filtered Tran IDs</td>
<td>69</td>
</tr>
<tr>
<td>23</td>
<td>View Some Pop-up for the Task History Panel</td>
<td>70</td>
</tr>
<tr>
<td>24</td>
<td>Region Status Panel, Options Pull-Down (Prior to CICS 5.1.0)</td>
<td>72</td>
</tr>
<tr>
<td>25</td>
<td>Preferences Pop-up Window</td>
<td>73</td>
</tr>
<tr>
<td>26</td>
<td>Controls Pop-up Window</td>
<td>75</td>
</tr>
<tr>
<td>27</td>
<td>Session Defaults Pop-up Window</td>
<td>76</td>
</tr>
<tr>
<td>28</td>
<td>Screen Print Output Routing Options Pop-up Window</td>
<td>78</td>
</tr>
<tr>
<td>29</td>
<td>Enable Authorized Commands Pop-up Window</td>
<td>79</td>
</tr>
<tr>
<td>30</td>
<td>Collection Controls Pop-up Window</td>
<td>80</td>
</tr>
<tr>
<td>31</td>
<td>Internal Bottleneck Collection Pop-up Window</td>
<td>81</td>
</tr>
<tr>
<td>32</td>
<td>Internal Bottleneck Display Controls Panel</td>
<td>82</td>
</tr>
<tr>
<td>33</td>
<td>Response Time Collection Pop-up Window</td>
<td>83</td>
</tr>
<tr>
<td>34</td>
<td>Interval Recording Pop-up Window</td>
<td>84</td>
</tr>
<tr>
<td>35</td>
<td>Task History Collection Pop-up Window</td>
<td>85</td>
</tr>
<tr>
<td>36</td>
<td>CICS File/Database Collection Pop-up Window</td>
<td>86</td>
</tr>
<tr>
<td>37</td>
<td>Resource Limiting Pop-up</td>
<td>87</td>
</tr>
<tr>
<td>38</td>
<td>CICS Shutdown Option Pop-up</td>
<td>89</td>
</tr>
<tr>
<td>39</td>
<td>Tasks Thresholds Pop-up Window</td>
<td>90</td>
</tr>
<tr>
<td>40</td>
<td>Userid Profiles Panel</td>
<td>92</td>
</tr>
<tr>
<td>FIGURE</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>41</td>
<td>Region Profiles Panel</td>
<td>94</td>
</tr>
<tr>
<td>42</td>
<td>Help Pull-down Menu</td>
<td>97</td>
</tr>
<tr>
<td>43</td>
<td>Region Status Panel (prior to CICS/ESA Version 5.1.0)</td>
<td>100</td>
</tr>
<tr>
<td>44</td>
<td>CPU Rates Panel</td>
<td>101</td>
</tr>
<tr>
<td>45</td>
<td>Task Details Panel</td>
<td>102</td>
</tr>
<tr>
<td>46</td>
<td>Task Details Panel Displaying Actions Pull-down</td>
<td>103</td>
</tr>
<tr>
<td>47</td>
<td>Region Status Panel with Critical Response Status Bar</td>
<td>104</td>
</tr>
<tr>
<td>48</td>
<td>Response Times Panel</td>
<td>105</td>
</tr>
<tr>
<td>49</td>
<td>Internal Bottlenecks Panel</td>
<td>105</td>
</tr>
<tr>
<td>50</td>
<td>External Contention Panel</td>
<td>106</td>
</tr>
<tr>
<td>51</td>
<td>External Contention Details Panel</td>
<td>107</td>
</tr>
<tr>
<td>52</td>
<td>Response Times Panel</td>
<td>108</td>
</tr>
<tr>
<td>53</td>
<td>Response Time Detail for LU Group</td>
<td>109</td>
</tr>
<tr>
<td>54</td>
<td>Response Times Panel</td>
<td>110</td>
</tr>
<tr>
<td>55</td>
<td>Response Time Details Panel</td>
<td>111</td>
</tr>
<tr>
<td>56</td>
<td>Task History Panel</td>
<td>112</td>
</tr>
<tr>
<td>57</td>
<td>Task History Details Panel</td>
<td>113</td>
</tr>
<tr>
<td>58</td>
<td>Task History FCT</td>
<td>114</td>
</tr>
<tr>
<td>59</td>
<td>GoTo Pull-down Menu</td>
<td>115</td>
</tr>
<tr>
<td>60</td>
<td>CICS Tables Panel</td>
<td>116</td>
</tr>
<tr>
<td>61</td>
<td>Programs Panel</td>
<td>117</td>
</tr>
<tr>
<td>62</td>
<td>View Some Pop-up over Programs Panel</td>
<td>118</td>
</tr>
<tr>
<td>63</td>
<td>Filtered Programs Panel</td>
<td>118</td>
</tr>
<tr>
<td>64</td>
<td>Program Entry Panel</td>
<td>119</td>
</tr>
<tr>
<td>65</td>
<td>Datasets Allocated to CICS Panel</td>
<td>120</td>
</tr>
<tr>
<td>66</td>
<td>Datasets Allocated to CICS Panel</td>
<td>120</td>
</tr>
<tr>
<td>67</td>
<td>Region Status with Critical Storage Status Bar</td>
<td>122</td>
</tr>
<tr>
<td>68</td>
<td>CICS Storage Panel</td>
<td>123</td>
</tr>
<tr>
<td>69</td>
<td>Storage Allocation by Components Panel</td>
<td>124</td>
</tr>
<tr>
<td>70</td>
<td>Storage Allocation by Tasks Panel</td>
<td>125</td>
</tr>
<tr>
<td>71</td>
<td>Task Details Panel</td>
<td>126</td>
</tr>
<tr>
<td>72</td>
<td>Task Time Analysis Panel (CICS Version 4.0 and above)</td>
<td>127</td>
</tr>
<tr>
<td>73</td>
<td>AIDs Summary Panel</td>
<td>130</td>
</tr>
<tr>
<td>74</td>
<td>Kill Confirmation Pop-up for a Single AID</td>
<td>131</td>
</tr>
<tr>
<td>75</td>
<td>Kill Confirmation Pop-up for Multiple AIDs (Terminal)</td>
<td>132</td>
</tr>
<tr>
<td>76</td>
<td>Kill Confirmation Pop-up for Multiple AIDs (Transaction)</td>
<td>133</td>
</tr>
<tr>
<td>77</td>
<td>AID Details Panel</td>
<td>133</td>
</tr>
<tr>
<td>78</td>
<td>Analyze AID Problems Panel</td>
<td>134</td>
</tr>
<tr>
<td>79</td>
<td>ICEs Summary Panel</td>
<td>135</td>
</tr>
<tr>
<td>80</td>
<td>Kill Confirmation Pop-up for a Single ICE</td>
<td>136</td>
</tr>
<tr>
<td>81</td>
<td>Kill Confirmation Pop-up for Multiple ICES (Terminal)</td>
<td>137</td>
</tr>
<tr>
<td>82</td>
<td>Kill Confirmation Pop-up for Multiple ICES (Transaction)</td>
<td>137</td>
</tr>
<tr>
<td>83</td>
<td>ICE Details Panel</td>
<td>138</td>
</tr>
<tr>
<td>84</td>
<td>Analyze ICE Problems Panel</td>
<td>139</td>
</tr>
<tr>
<td>85</td>
<td>Response Times Panel</td>
<td>141</td>
</tr>
<tr>
<td>FIGURE</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>FIGURE 86.</td>
<td>Response Time Details Panel</td>
<td>142</td>
</tr>
<tr>
<td>FIGURE 87.</td>
<td>Internal Bottlenecks Panel</td>
<td>143</td>
</tr>
<tr>
<td>FIGURE 88.</td>
<td>Analyze Response Time Problems Panel</td>
<td>144</td>
</tr>
<tr>
<td>FIGURE 89.</td>
<td>Tasks Summary Panel</td>
<td>145</td>
</tr>
<tr>
<td>FIGURE 90.</td>
<td>Purge Confirmation Pop-up for a Single Task</td>
<td>147</td>
</tr>
<tr>
<td>FIGURE 91.</td>
<td>Force Purge Confirmation Pop-up for a Single Task</td>
<td>148</td>
</tr>
<tr>
<td>FIGURE 92.</td>
<td>Kill Confirmation Pop-up for a Single Task</td>
<td>149</td>
</tr>
<tr>
<td>FIGURE 93.</td>
<td>Force Kill Confirmation Pop-up for a Single Task</td>
<td>149</td>
</tr>
<tr>
<td>FIGURE 94.</td>
<td>Task Details Panel</td>
<td>151</td>
</tr>
<tr>
<td>FIGURE 95.</td>
<td>Analyze Task Problems Panel</td>
<td>153</td>
</tr>
<tr>
<td>FIGURE 96.</td>
<td>Transaction Rates Panel</td>
<td>154</td>
</tr>
<tr>
<td>FIGURE 97.</td>
<td>Analyze Transaction Rate Problems Panel</td>
<td>155</td>
</tr>
<tr>
<td>FIGURE 98.</td>
<td>Analyze UOW Problems Panel</td>
<td>157</td>
</tr>
<tr>
<td>FIGURE 99.</td>
<td>UOWs Panel Filtered for Shunted UOWs</td>
<td>158</td>
</tr>
<tr>
<td>FIGURE 100.</td>
<td>UOW Details Panel</td>
<td>159</td>
</tr>
<tr>
<td>FIGURE 101.</td>
<td>UOW Links Panel</td>
<td>160</td>
</tr>
<tr>
<td>FIGURE 102.</td>
<td>UOW Enqueues Panel</td>
<td>161</td>
</tr>
<tr>
<td>FIGURE 103.</td>
<td>UOW Statistics Panel</td>
<td>162</td>
</tr>
<tr>
<td>FIGURE 104.</td>
<td>CPU Rates Panel</td>
<td>164</td>
</tr>
<tr>
<td>FIGURE 105.</td>
<td>Analyze CPU Problems Panel</td>
<td>166</td>
</tr>
<tr>
<td>FIGURE 106.</td>
<td>CICS DASD Performance Panel</td>
<td>167</td>
</tr>
<tr>
<td>FIGURE 107.</td>
<td>DASD Details for a Device Panel</td>
<td>168</td>
</tr>
<tr>
<td>FIGURE 108.</td>
<td>Analyze DASD Problems Panel</td>
<td>169</td>
</tr>
<tr>
<td>FIGURE 109.</td>
<td>DB2 Activity Panel</td>
<td>170</td>
</tr>
<tr>
<td>FIGURE 110.</td>
<td>DB2 Transaction Details Panel</td>
<td>171</td>
</tr>
<tr>
<td>FIGURE 111.</td>
<td>Analyze DB2 Problems Pane</td>
<td>172</td>
</tr>
<tr>
<td>FIGURE 112.</td>
<td>DBCTL Activity Panel</td>
<td>173</td>
</tr>
<tr>
<td>FIGURE 113.</td>
<td>Analyze DBCTL Problems Panel</td>
<td>174</td>
</tr>
<tr>
<td>FIGURE 114.</td>
<td>DL/I Activity Panel</td>
<td>175</td>
</tr>
<tr>
<td>FIGURE 115.</td>
<td>Analyze DL/I Problems Panel</td>
<td>176</td>
</tr>
<tr>
<td>FIGURE 116.</td>
<td>Open VSAM Files Panel (CICS/ESA Version 4 and earlier)</td>
<td>177</td>
</tr>
<tr>
<td>FIGURE 117.</td>
<td>VSAM Details Panel</td>
<td>178</td>
</tr>
<tr>
<td>FIGURE 118.</td>
<td>Analyze File Problems Panel</td>
<td>179</td>
</tr>
<tr>
<td>FIGURE 119.</td>
<td>Open VSAM Files Panel (CICS/ESA Version 5.1.0)</td>
<td>180</td>
</tr>
<tr>
<td>FIGURE 120.</td>
<td>Journals Panel (CICS/ESA Version 5.1.0)</td>
<td>182</td>
</tr>
<tr>
<td>FIGURE 121.</td>
<td>Journal Details Panel</td>
<td>184</td>
</tr>
<tr>
<td>FIGURE 122.</td>
<td>Datasets Allocated to CICS Panel</td>
<td>185</td>
</tr>
<tr>
<td>FIGURE 123.</td>
<td>File Details Panel</td>
<td>186</td>
</tr>
<tr>
<td>FIGURE 124.</td>
<td>Analyze Journal Problems Panel</td>
<td>187</td>
</tr>
<tr>
<td>FIGURE 125.</td>
<td>LSR Pools Panel</td>
<td>189</td>
</tr>
<tr>
<td>FIGURE 126.</td>
<td>LSR Buffer Pool Details Panel</td>
<td>190</td>
</tr>
<tr>
<td>FIGURE 127.</td>
<td>Analyze LSR Problems Panel</td>
<td>191</td>
</tr>
<tr>
<td>FIGURE 128.</td>
<td>Terminal Control Table System Entries Panel</td>
<td>192</td>
</tr>
<tr>
<td>FIGURE 129.</td>
<td>TCT System Entry Panel</td>
<td>193</td>
</tr>
<tr>
<td>FIGURE 130.</td>
<td>Analyze MRO/ISC Problems Panel</td>
<td>194</td>
</tr>
<tr>
<td>FIGURE 131.</td>
<td>Working Set Size and Paging Rates Panel</td>
<td>195</td>
</tr>
<tr>
<td>FIGURE 132.</td>
<td>Analyze Paging Problems Panel</td>
<td>196</td>
</tr>
<tr>
<td>FIGURE 133.</td>
<td>CICS Storage Panel (CICS Version 4 and above)</td>
<td>197</td>
</tr>
<tr>
<td>FIGURE 134.</td>
<td>CICS Storage Panel</td>
<td>198</td>
</tr>
<tr>
<td>FIGURE 135.</td>
<td>Storage Allocation by Components Panel</td>
<td>199</td>
</tr>
<tr>
<td>FIGURE 136.</td>
<td>Analyze Storage Problems Panel</td>
<td>200</td>
</tr>
<tr>
<td>FIGURE 137.</td>
<td>Tape Drives Pane</td>
<td>201</td>
</tr>
<tr>
<td>FIGURE 138.</td>
<td>Tape Drive Details Panel</td>
<td>202</td>
</tr>
<tr>
<td>FIGURE 139.</td>
<td>Analyze Tape Problems Panel</td>
<td>203</td>
</tr>
<tr>
<td>FIGURE 140.</td>
<td>Temporary Storage Panel</td>
<td>204</td>
</tr>
<tr>
<td>FIGURE 141.</td>
<td>Temporary Storage Queues Panel</td>
<td>205</td>
</tr>
<tr>
<td>FIGURE 142.</td>
<td>Analyze Temporary Storage Problems Panel</td>
<td>207</td>
</tr>
<tr>
<td>FIGURE 143.</td>
<td>Transient Data Panel</td>
<td>208</td>
</tr>
<tr>
<td>FIGURE 144.</td>
<td>Destination Control Table Panel</td>
<td>210</td>
</tr>
<tr>
<td>FIGURE 145.</td>
<td>DCT Intrapartition Information Panel</td>
<td>211</td>
</tr>
<tr>
<td>FIGURE 146.</td>
<td>Analyze Transient Data Problems Panel</td>
<td>212</td>
</tr>
<tr>
<td>FIGURE 147.</td>
<td>Web Interface panel</td>
<td>213</td>
</tr>
<tr>
<td>FIGURE 148.</td>
<td>TCP/IP Thresholds</td>
<td>214</td>
</tr>
<tr>
<td>FIGURE 149.</td>
<td>TCP/IP Socket Activity</td>
<td>214</td>
</tr>
<tr>
<td>FIGURE 150.</td>
<td>CICS File/Database Collection pop-up</td>
<td>218</td>
</tr>
<tr>
<td>FIGURE 151.</td>
<td>Region Status Panel (CICS/ESA Versions 3.3 and 4.1)</td>
<td>219</td>
</tr>
<tr>
<td>FIGURE 152.</td>
<td>Region Status Panel (CICS/ESA Version 5.1 and higher)</td>
<td>220</td>
</tr>
<tr>
<td>FIGURE 153.</td>
<td>MQ Thresholds Panel</td>
<td>221</td>
</tr>
<tr>
<td>FIGURE 154.</td>
<td>MQ Activity Panel</td>
<td>222</td>
</tr>
<tr>
<td>FIGURE 155.</td>
<td>CICS Tasks using MQ Panel</td>
<td>223</td>
</tr>
<tr>
<td>FIGURE 156.</td>
<td>MQ Statistics Panel</td>
<td>224</td>
</tr>
<tr>
<td>FIGURE 157.</td>
<td>API Requests Panel</td>
<td>225</td>
</tr>
<tr>
<td>FIGURE 158.</td>
<td>Application Trace panel</td>
<td>226</td>
</tr>
<tr>
<td>FIGURE 159.</td>
<td>Application Trace Entry panel</td>
<td>227</td>
</tr>
<tr>
<td>FIGURE 160.</td>
<td>Internal Bottlenecks Panel</td>
<td>230</td>
</tr>
<tr>
<td>FIGURE 161.</td>
<td>Internal Bottleneck Details Panel</td>
<td>232</td>
</tr>
<tr>
<td>FIGURE 162.</td>
<td>Analyze Bottleneck Problems Panel</td>
<td>233</td>
</tr>
<tr>
<td>FIGURE 163.</td>
<td>CSA Panel</td>
<td>234</td>
</tr>
<tr>
<td>FIGURE 164.</td>
<td>Analyze CICS Loop Problems Panel</td>
<td>235</td>
</tr>
<tr>
<td>FIGURE 165.</td>
<td>Dumps Panel</td>
<td>236</td>
</tr>
<tr>
<td>FIGURE 166.</td>
<td>Analyze Dump Problems Panel</td>
<td>237</td>
</tr>
<tr>
<td>FIGURE 167.</td>
<td>Enqueues Pane</td>
<td>238</td>
</tr>
<tr>
<td>FIGURE 168.</td>
<td>Enqueue Details panel</td>
<td>239</td>
</tr>
<tr>
<td>FIGURE 169.</td>
<td>Analyze Enqueue Problems Panel</td>
<td>240</td>
</tr>
<tr>
<td>FIGURE 170.</td>
<td>DASD I/O Rate Panel</td>
<td>241</td>
</tr>
<tr>
<td>FIGURE 171.</td>
<td>DASD Details for a Device Panel</td>
<td>243</td>
</tr>
<tr>
<td>FIGURE 172.</td>
<td>Analyze I/O Problems Panel</td>
<td>244</td>
</tr>
<tr>
<td>FIGURE 173.</td>
<td>Terminal Control Table Prefix (TCTFX) Panel</td>
<td>245</td>
</tr>
<tr>
<td>FIGURE 174.</td>
<td>Analyze VTAM Problems Panel</td>
<td>246</td>
</tr>
<tr>
<td>FIGURE 175.</td>
<td>XRF Information Panel</td>
<td>247</td>
</tr>
</tbody>
</table>
FIGURE 176. System Console Panel ............................................................... 249
FIGURE 177. Analyze XRF Problems Panel ................................................. 250
FIGURE 178. Start Response Time Collection Pop-up ................................. 254
FIGURE 179. Stop Response Time Collection Pop-up .................................... 255
FIGURE 180. Response Time Groups Panel .................................................. 256
FIGURE 181. Elements in a Group Panel ....................................................... 260
FIGURE 182. Element Manipulation Panel .................................................... 262
FIGURE 183. Confirm Request to Delete a Group ......................................... 265
FIGURE 184. Confirm Request to Delete an Element ..................................... 266
FIGURE 185. Analyze AID Problems Panel .................................................. 273
FIGURE 186. Open VSAM Files Panel (CICS/ESA Version 4 and earlier) .......... 274
FIGURE 187. Region Status Panel (prior to CICS/ESA Version 5.1.0) ............ 275
FIGURE 188. Transplex Navigation Pushbutton ............................................. 291
FIGURE 189. Action Codes on the Programs Panel ...................................... 299
FIGURE 190. Actions Pulldown Menu for the Program Entry Panel ................ 300
FIGURE 191. Entry Fields on the Transaction Statistics Panel ....................... 301
About this document

This guide is an introduction to OMEGAMON II™ for CICS (hereafter referred to as OMEGAMON II). It describes the Common User Access (CUA) interface and gets you started monitoring the performance of your CICS system.

Who should use this guide

This guide is intended for data center personnel who are responsible for monitoring CICS performance, systems programmers and performance analysts who are responsible for a CICS system, and application programmers who wish to monitor their programs.

You can use this guide in conjunction with an OMEGAMON II session or read it by itself in order to become familiar with the capabilities of OMEGAMON II.

Note: This document refers to Version 2 of CICS as CICS/MVS, and Versions 3 and greater as CICS/ESA.
Introduction

Candle provides a complete set of documentation for OMEGAMON II for CICS. Each manual in this documentation set contains a specific type of information to help you use the product.

- **OMEGAMON II for CICS Configuration and Customization Guide**, document number C251-6363
  
  Explains how to configure and customize OMEGAMON II after it is installed.

- **OMEGAMON II for CICS User’s Guide**, document number C254-6312
  
  Provides a task-oriented guide to using OMEGAMON II. Explains basic features and navigation methods.

- **OMEGAMON II for CICS Reference Manual, Volume I** document number C253-6313
  
  Provides comprehensive reference information about the features of OMEGAMON II and explains how to access OMEGAMON II data in the CUA interface.

- **OMEGAMON II for CICS Reference Manual, Volume II** document number C253-6314
  
  Provides comprehensive reference information about the features of OMEGAMON II and explains how to access OMEGAMON II data in the menu system interface.

- **OMEGAMON II for CICS Historical Reporting Manual**, document number C299-6316
  
  Describes how to use the SMF records created by OMEGAMON II to produce historical reports.

- **OMEGAMON II for CICS Problem Determination Manual**, document number C257-6315
  
  Describes how to diagnose and solve problems that you may encounter with OMEGAMON II, get the best possible problem-solving help from Candle Support Services, and prevent or reduce the recurrence of problems.

  
  Provides reference summary of all OMEGAMON II and OMEGAVIEW messages.

  
  Describes ETE planning and installation considerations and ETE commands; lists error messages, return codes, and sense codes.
Adobe Portable Document Format

Printing this book

Candle supplies documentation in the Adobe Portable Document Format (PDF). The Adobe Acrobat Reader will print PDF documents with the fonts, formatting, and graphics in the original document. To print a Candle document, do the following:

1. Specify the print options for your system. From the Acrobat Reader Menu bar, select **File > Page Setup...** and make your selections. A setting of 300 dpi is highly recommended as is duplex printing if your printer supports this option.

2. To start printing, select **File > Print...** on the Acrobat Reader Menu bar.

3. On the Print pop-up, select one of the **Print Range** options for
   - All
   - Current page
   - Pages from: [ ] to: [ ]

4. (Optional). Select the Shrink to Fit option if you need to fit oversize pages to the paper size currently loaded on your printer.

Printing problems?

The print quality of your output is ultimately determined by your printer. Sometimes printing problems can occur. If you experience printing problems, potential areas to check are:

- settings for your printer and printer driver. (The dpi settings for both your driver and printer should be the same. A setting of 300 dpi is recommended.)
- the printer driver you are using. (You may need a different printer driver or the Universal Printer driver from Adobe. This free printer driver is available at www.adobe.com.)
- the halftone/graphics color adjustment for printing color on black and white printers (check the printer properties under **Start > Settings > Printer**). For more information, see the online help for the Acrobat Reader.
- the amount of available memory in your printer. (Insufficient memory can cause a document or graphics to fail to print.)

For additional information on printing problems, refer to the documentation for your printer or contact your printer manufacturer.

Contacting Adobe

If additional information is needed about Adobe Acrobat Reader or printing problems, see the Readme.pdf file that ships with Adobe Acrobat Reader or contact Adobe at www.adobe.com.
Documentation Conventions

Introduction
Candle documentation adheres to accepted typographical conventions for command syntax. Conventions specific to Candle documentation are discussed in the following sections.

Panels and figures
The panels and figures in this document are representations. Actual product panels may differ.

Revision bars
Revision bars (|) may appear in the left margin to identify new or updated material.

Variables and literals
In examples of command syntax, uppercase letters are actual values (literals) that the user should type; lowercase letters are used for variables that represent data supplied by the user. Default values are underscored.

LOGON APPLID (cccccccc)

In the above example, you type LOGON APPLID followed by an application identifier (represented by cccccccc) within parentheses.

Note: In ordinary text, variable names appear in italics.
Symbols

The following symbols may appear in command syntax:

Table 1. Symbols in Command Syntax

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The “or” symbol is used to denote a choice. Either the argument on the left or the argument on the right may be used. Example: **YES</td>
</tr>
<tr>
<td>[ ]</td>
<td>Denotes optional arguments. Those arguments not enclosed in square brackets are required. Example: <strong>APPLDEST DEST [ALTDEST]</strong> In this example, DEST is a required argument and ALTDEST is optional.</td>
</tr>
<tr>
<td>{ }</td>
<td>Some documents use braces to denote required arguments, or to group arguments for clarity. Example: **COMPARE {workload} - REPORT={SUMMARY</td>
</tr>
<tr>
<td>_</td>
<td>Default values are underscored. Example: **COPY infile outfile - [COMPRESS={YES</td>
</tr>
</tbody>
</table>
Introduction

This section details the new features and enhancements incorporated into OMEGAMON II for CICS Version 520.

Highlights

OMEGAMON II for CICS Version 520 includes the following new features and enhancements:

- Allows printing a SNAPSHOT of a CICS region.
- Added the Exchange Logname Status exception.
- Added Transaction Server 1.3 Task Monitoring Data and Statistics
- Enhanced RLIM Interval Settings
- Added User Defined Event Monitoring
- Enhanced ADABAS statistics reporting
- Added support for ADABAS 7.1

The following features are no longer supported by OMEGAMON II for CICS Version 520:

- Support for CICS/ESA Version 3.x.x
- Documentation for BookManager no longer supported
New Features and Enhancements

Print SNAPSHOT of CICS Region

The SNAP facility is composed of a sequence of pre-defined OMEGAMON II screens which contain every OMEGAMON Classic command you can use to report on the state and content of your CICS region.

This facility is now accessible in the C2/CUA interface to OMEGAMON II for CICS product. A new item was added to the Options/Controls pulldown which upon selection will route the output to the JES print queue under the common interface (Menu System) Job JCL.

Exchange Logname Status Exception

Exchange Logname status is a new OMEGAMON II for CICS exception added to the list of existing ones under the MRO/ISC. Once enabled the MRO/ISC light will alert users when the Exchange Log Name or XLN is ‘Notdone’ between two, APPC type connected, CICS systems.

Online Global Facility

The Online Global Facility is introduced to eliminate the requirement for re-assembly and linking of the product global data area module(s). Using the C2/CUA interface, this facility will enable users to SAVE the currently running global module to the library defined by the RKC2GLBL DD statement.

Using the Candle Installation/Configuration Assistance Tool (CICAT), users can edit and verify any of the existing global data area modules. Note that utilities are provided to migrate the previous versions of the global data area to the new format in V520. Refer to the OMEGAMON II for CICS Configuration and Customization Guide for more information.
New Features and Enhancements

Transaction Server 1.3 Task Monitoring Data and Statistics

The OMEGAMON II for CICS product has been enhanced to support the new performance monitoring data and statistics introduced in Transaction Server release 1.3. Non-3270 statistics such as WEB Send and Receive request counts are now displayable in active transactions as well as the Online History (ONDV) component.

The Task Time Analysis screens have been enhanced to include the newly introduced performance monitoring data such as JVM elapsed and suspend times, IMS(DBCTL) wait time, DB2 wait times, Socket I/O wait time, Global ENQ delay, among others. In addition, the Task Timings panels have been redesigned to display a categorical view of Timings attributed to a transaction or task.

Resource Limiting (RLIM) Interval Settings

The Resource Limiting feature of OMEGAMON II for CICS product has been enhanced to introduce a set of user defined intervals. This enhancement will allow users to activate the previously defined rules based on a user modifiable interval. The new RLIM interval may be set in three different ways:

- By TIME.
- By the number of EXEC CICS calls made by a task.
- By the number of Database calls made by a task.

User Defined Event Monitoring

The User Defined Event Monitoring (USREVNT1) describes a way for application programmers to clock and count the number of requests being made to an in-house database, program or procedure. Similar to other Third Party Products such as ADABAS, DATACOM, IDMS and SUPRA, this facility may be enabled from the Options pulldown in the C2/CUA interface under the CICS File/Database collection option.
ADABAS Statistics Reporting

ADABAS statistics in the OMEGAMON II for CICS product have been traditionally based on DB ID and File number. With the specification of a new operand in the product’s global data area module, users may request OMEGAMON to collect statistics based on DB ID, File number, and Command Code.

Support for ADABAS V7.1

The new release of ADABAS V7.1 supports DB IDs greater than 255. The relevant OMEGAMON II for CICS product panels were enhanced to display a 5-digit database ID.

Online Documentation

With version 520, Candle Corporation has moved OMEGAMON II for CICS manuals from IBM BookMaster to Adobe FrameMaker. This move was made to better enable us to address our customers’ needs by providing tools that enhance productivity.

One of the results of the move is that it is no longer possible to create BookManager versions of the OMEGAMON II for CICS manuals. However, the manuals remain available online in the Adobe PDF version on CD-ROM and are also available on the Candle Corporation website at www.Candle.com.

The documentation CD being provided with this release has robust and easy-to-use search capabilities. You can search for information in multiple volumes, multiple versions, and across products. The CD also provides easy setup of search indexes with a single click of the mouse.

If you want to order printed copies of the documentation, please contact your Candle Support Services representative.
Introduction

Overview

OMEGAMON II is a comprehensive software performance monitor for the IBM Customer Information Control System (CICS).

The OMEGAMON II realtime monitor alerts you to CICS response time degradation and overall system problems through color-coded status bars or through user-defined status words. Through online help, OMEGAMON II recommends corrective actions.

The OMEGAMON II historical facility collects transaction and resource-related information to enable you to meet service-level objectives and plan for system upgrades.

Chapter Contents

CUA Interface for Ease of Use ................................................................. 26
Logical Tuning Approach ................................................................. 27
Features ......................................................................................... 28
Batch Reporting Methods ............................................................... 30
The OMEGAMON II realtime monitor includes two user interfaces: the Common User Access (CUA) interface and the menu system. This document focuses only on the CUA interface. For information on the menu system, see Part 2 of the OMEGAMON II for CICS Reference Manual.

The CUA interface of OMEGAMON II complies with the IBM SAA/CUA Systems Application Architecture/Common User Access guidelines, which promote ease of use in software interfaces. For more information about CUA, see the IBM Common User Access: Basic Interface Design Guide.

Accessed either directly or through OMEGAVIEW®, the OMEGAMON II CUA interface provides a high-level overview of and detailed information on the performance of CICS regions. With its CUA-compliant panels, color-coded status bars, and point-and-shoot navigation facility, the CUA interface is ideally suited for monitoring CICS regions and responding to a problem as soon as it occurs.
Logical Tuning Approach

All of OMEGAMON II’s features and facilities are designed around the concept of a logical tuning approach. The logical tuning approach consists of the following activities:

- setting standards for CICS performance at your installation
- monitoring your CICS to measure actual performance against these standards
- identifying the cause of performance problems and taking action to correct them

Setting Performance Standards

You set standards for CICS performance in such areas as:

- transaction response time
- transaction throughput
- CPU utilization
- DASD response time
- paging rate
- storage utilization

Monitoring Performance

Monitoring CICS performance consists of asking two basic questions:

- Are your performance measurements within an acceptable range?
- What are the problems in the system?

Identifying and Solving Performance Problems

When you select a status bar next to a component on the Region Status panel, you can follow the status condition for the component that was indicated by a light of a particular color (for example, red). You follow the status condition by navigating through panels with the same color light until you reach a panel that has the information you need. You can then determine the nature of the problem and its appropriate solutions.
Features

The following features are available to help you manage the operation and performance of CICS:

- internal bottleneck collection
- CICS system analysis
- external contention analysis
- response time collection

The following sections provide brief descriptions of these features.

Internal Bottleneck Collection

A CICS task waits many times during normal processing. OMEGAMON II’s internal bottleneck collection feature monitors and categorizes the resources for which CICS tasks are waiting. Typical waits can be I/O events, VSAM buffer and string waits, enqueue waits, and short-on-storage conditions.

As the applications grow and change, so does the use of resources in the CICS system. By highlighting resources for which contention is greatest, OMEGAMON II enables you to focus your tuning efforts where they will do the most good.

CICS System Analysis

A CICS system at a typical installation is constantly undergoing change. OMEGAMON II displays control blocks, parameter settings, and current performance on such items as:

- AID/ICE activity
- transient data usage
- temporary storage usage
- CICS table entries
- CICS control blocks
- CICS storage usage
- VSAM files
- DB2 connection
- DL/I activity and status
- DASD usage
- CPU usage and paging
- CICS workload and task history

External Contention Analysis

OMEGAMON II’s external contention analysis feature identifies other workloads running on MVS that are impacting CICS by competing with it for MVS resources. These workloads can be batch jobs, started tasks, TSO users, or even other CICS regions. The displays not only identify the main sources of impact, but also show how CICS is being affected so you can take immediate action to address those areas that will result in the most significant improvement.
Response Time Collection

OMEGAMON II’s response time collection feature provides displays of CICS internal response time for transactions, terminals, and programs, as well as end-to-end response time for VTAM logical units (LUs). OMEGAMON II compares response time against user-specified performance standards for any of these resources or groups of resources.
**Batch Reporting Methods**

You can select from the following software to produce batch reports from System Management Facilities (SMF) records generated by OMEGAMON II:

- Statistical Analysis System (SAS)
- OMEGAMON II historical reporter (formerly called EPILOG 1000)
- User-written programs

**SAS**

SAS reporting allows you to use the OMEGAMON II historical component to generate historical reports based on your CICS performance data. Daily, weekly, and monthly reports display your data at varying levels of detail. As an alternative to the historical reporter for reporting SMF data, the SAS support package can help you identify potential performance problems and test the effects of your changes to CICS performance parameters. This facility is especially useful for reporting CICS performance to upper management and for making long-range CICS tuning decisions.

**OMEGAMON II Historical Reporter**

The OMEGAMON II historical reporter generates reports based on data that was collected from CICS regions, written to an SMF dataset, and converted to the reporter format.

You can request reports that analyze such areas of performance and capacity as:

- response time
- transaction volume and resource use
- program usage
- usage by terminal

See the *Historical Reporting Guide* for more information.

**User-written Programs**

You can use the interval, system-related, and task-related records that OMEGAMON II writes to SMF in programs that you write to produce historical reports of your system’s performance.

See “SMF Considerations” in the *OMEGAMON II for CICS Configuration and Customization Guide* and “Collecting and Storing Historical Data” in the *OMEGAMON II for CICS Reference Manual* for information on how to start, stop, and limit the logging of these records to SMF.
Introduction

This chapter acquaints you with the general features of the CUA interface panels and offers some guidelines for using these features.

If you are already familiar with the CUA interface, skip this chapter and proceed to “Getting Started with OMEGAMON II” on page 47.

Chapter Contents

Panel Contents ................................................................. 32
CUA Interface Panel Characteristics ........................................ 33
Action Bar ................................................................. 35
Navigating ................................................................. 38
Using Help ................................................................. 40
Enter Key ................................................................. 42
Function Keys ................................................................. 43
Exiting from OMEGAMON II .................................................. 45
Panel Contents

Panels within the CUA interface are composed of the elements described below. The following figure shows a typical panel.

FIGURE 1. Typical CUA Interface Panel

---

Action Bar

An action bar (1) appears as the top line on each panel. The items on the action bar represent choices that, when selected, display pull-down menus. See “Action Bar” on page 35 for more information.

Panel Body

Data is displayed in the body of the panel(2). The format of the data varies depending on its type. The panel body may contain status bars, tables, or graphs.

Some fields in the panel body are preceded by an underscore (_) to indicate that you can enter an action code for this field. See “Navigating” on page 38 for more information on entering action codes on panels.

Pushbuttons

These are words that appear in angled brackets or parentheses, located near the bottom of the panel (3). You can use pushbuttons to move directly to the panel named within the brackets. Words within parentheses indicate the panel that you are currently viewing. (Pushbuttons do not appear on all panels.)

Function Keys

Function keys that are active for the current panel are displayed at the bottom of the panel (4). See “Function Keys” on page 43 for more information.
CUA Interface Panel Characteristics

This section describes the features of the CUA interface panels.

Status Bars

The panel body uses **status bars** to represent a set of thresholds applied against a CICS component. The color of the status bar indicates whether or not a problem exists and its severity:

- **Red** Critical problem that requires immediate attention.
- **Yellow** Warning of a potential problem.
- **Green** Satisfactory performance.
- **Turquoise** No data is being collected.

On a monochrome terminal, words indicate the status of the component. You can specify the words you want to display in the status bars through the Session Defaults pop-up window of the Options pull-down. See “Controls” on page 75 for information on setting session defaults.

The default status words that display are as follows:

- Crit (critical status)
- Warn (warning status)
- OK (okay status)
- Idle (component not being monitored)

Text and Field Colors and Highlighting

Attributes such as color, highlighting, and underlining, as well as certain characters, are used in these panels to identify types of text and fields. On a color terminal, colors are used as follows:

- **White** Items that are available for selection. On a monochrome terminal, the field is the display color for that terminal.
- **Green with underscore or highlighted** Fields that accept input. On a monochrome terminal, the field is underscored. Entry fields followed by a plus (+) sign are used with the F4 key to see selection lists or to toggle between settings.
- **Blue** Items that are unavailable for selection, either temporarily or permanently. On a monochrome terminal, an asterisk (*) appears as the first character of the selection.
- **Turquoise** Items in nonselectable fields; default text.

**Note:** If you are using 3270 emulation hardware and software on a personal computer, various panel attributes (such as color, highlight, underline, and reverse video) may appear significantly different from the way they appear on an actual 3270 device. You may have to change definitions in your 3270 emulator to achieve desired color mapping. Refer to the appropriate 3270 emulator manuals or consult your system administrator.
Ellipsis

An ellipsis (...) following a selection indicates that further selection is required after you make the initial selection. You make selections from another menu or add data to complete the task.

Scrolling

On many panels, when more information is available than can be displayed on one panel, a scroll indicator is available as one of the following:

- **Lines n to nn of nn**
  You can overtype this line to specify the line that you want to view (see Figure 1 on page 32). Just type the number of the line of information you want to see and press Enter.

  **Note:** This line does not display on panels that have only one screen of data; such panels are not scrollable.

- **More**
  Displayed on some panels in the upper right corner, this indicator is followed by a plus (+) sign, a minus (-) sign, or both. The plus (+) sign means that pressing F8 scrolls forward to display more data. A minus (-) sign means that pressing F7 scrolls backward to display more data. When both plus and minus display next to More, you can scroll forward or backward.

Displaying All Uppercase Characters

By default, OMEGAMON II displays the data on its panels in both uppercase and lowercase letters. If any of your terminals reserve the lowercase codes for international characters, you must edit the KLVSYSIN member in the rhilev.RKANPAR dataset to specify all-uppercase displays for OMEGAMON II.

Add the following statement to KLVSYSIN:

```
UPPERDLG(Y)
```
Action Bar

The action bar is the first line at the top of a panel. See the following figure.

FIGURE 2. Action Bar

The first position of the action bar is the home position and is used for selecting action bar choices. The action bar choices are as follows:

**Actions**  Act upon selected objects in the panel body; exit the panel to the previous panel. For more information on Actions, see “Using the Actions Pull-down” on page 60.

**GoTo**  From the current area, transfer to a related panel of CICS monitoring. For more information on GoTo, see “Using the GoTo Pull-down” on page 61.

**View**  Filter or sort the data displayed on applicable panels. For more information on View, see “Using the View Pull-down” on page 67.

**Index**  Access panels by selecting either a subcategory or a panel title, or search the panel title index when you do not know a particular panel title. For more information on Index, see “Using the Index Pull-down” on page 65.

**Options**  Customize the CUA interface. For more information on Options, see “Using the Options Pull-down” on page 72.

**Help**  Access the various types of help available in the CUA interface. For more information about Help, see “Using Help” on page 40.

Using the Action Bar

To move the cursor to the home position of the action bar:

- Press F10. The cursor position is stored and the cursor is returned to the same position when you press F10 again.
- Press the Home key. The position of the cursor in the panel body is *not* retained.

To select from the action bar, do either of the following:

- Press the Tab key to move the cursor to the entry field of your choice and press Enter.
- Type the first letter of the choice in the home position and press Enter.
Action Bar

Pull-down Menu

When you make a selection from the action bar, a pull-down menu is displayed. A pull-down menu provides a list of further selections that you can make. For example, the Options pull-down menu is displayed when you select Options from the action bar, as shown below.

**FIGURE 3. Region Status Panel, Options Pull-Down (Prior to CICS 5.1.0)**

```
<table>
<thead>
<tr>
<th></th>
<th>Actions</th>
<th>GoTo</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>---</td>
<td>---------</td>
<td>------</td>
<td>-------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>KC2B01D</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>Select one component w</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>S=Show details</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>A=Auto(60)</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>1. Preferences</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>2. Controls...</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>3. Collection controls...</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>4. CICS shutdown option</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>Workloads</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>5. Thresholds...</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ AIDs Warn</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ ICEs OK</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ Response OK</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ Tasks OK</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ TranRate OK</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>6. Response time groups</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>7. Userid profiles</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>8. Region profiles</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>9. Close print log</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ Files OK</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ Journals OK</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ TranData OK</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ VTAM ACB OK</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>_ XRF Crit</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
<td>_ _ _</td>
</tr>
<tr>
<td>F1=Help F3=Exit F4=Prompt F5=Refresh F6=Console F10=Action Bar F11=Print</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Although part of the underlying panel is visible, it is not usable while the pull-down menu is displayed. If you move the cursor outside the pull-down menu and press a key, the cursor returns to the pull-down menu.
Pop-up Window

A pop-up window is displayed when you make a selection from a pull-down menu or press a function key. Pop-up windows prompt you for further selections, display help, or explain errors and how to correct them. Even though more than one pop-up window may appear at one time (overlapping each other), only the last pop-up window displayed accepts data.

FIGURE 4. Date Format Selection Pop-up

Although pop-up windows and pull-down menus share several features, you can distinguish them as follows:

- A pull-down menu appears when you make a selection from the action bar.
- A pop-up window appears when additional information is required to complete a function or when an error occurs.
Navigating

The CUA interface gives you several ways to use OMEGAMON II’s features and functions.

Ways of Selecting Items

Use one of the following methods to select an item from a panel, a pull-down menu, or a pop-up window:

- Move the cursor to the entry field of your selection and press Enter (provided Implicit Action is on in the Preferences option).
- Type the action code in the entry field and press Enter.
- Type the number of the selection in the entry field of the first selection and press Enter.
- If you are using a monochrome terminal, type the character in parentheses (called a mnemonic) in the entry field and press Enter. (Mnemonics is turned on in the Preferences option).
- Tab to a pushbutton and press Enter or type a mnemonic in the home position to move directly to the panel named in the pushbutton.

For example, to select and display the pull-down menu for Options, enter O in the home position. The Options pull-down menu is displayed. You can then select a menu choice by typing its number in the entry field and pressing Enter.

Fast Pathing

Fast pathing in the CUA interface allows you to quickly access pull-down menus, items on pull-down menus, and panels. You do this by entering a mnemonic in the action bar entry field (home position). The mnemonic can be a single character or a string. You can use fast paths to access all panels or, if the panel contains pushbuttons, only panels related to the one you are viewing.

All-Panel Fast Pathing

When you enter the fast path character, the equals sign (=), followed by a mnemonic, OMEGAMON II takes you directly to the panel represented by that mnemonic.

For example, to access the Tasks panel, follow these steps:

1. Type =WT in the action bar entry field. (The = stands for fast path, the W for Workloads, and the T for Tasks.)
2. Press Enter. The Tasks panel displays.

Note: In some cases an intermediate pop-up may appear so you can select from it before accessing the panel. The pop-up contains items related to the panel, such as transaction IDs, file IDs, task numbers, devices, and program IDs. After you select the item you want from the pop-up and press Enter, the panel appears.

The following figure shows how a fast path entry would appear on the action bar.
Note: You type the fast path character (\(=\)) as part of the entry only when navigating between panels, not pull-down menus.

The appendix titled “Fast Pathing in the CUA Interface” on page 277 lists the fast path mnemonics you can use to access panels in the OMEGAMON II CUA interface.

**Pushbutton Fast Pathing**

You can also fast path to the destinations specified in the pushbuttons. This type of fast pathing uses the left angle bracket (\(<\)) as the fast path character.

Each pushbutton has a highlighted character. To fast path to a particular pushbutton destination, type the fast path character followed by the highlighted character of the desired pushbutton. Then press Enter.

For example, in the panel shown below, you would enter \(<H\) to go to the Response Time History panel.

**Transplex Navigation**

Through Transplex™ navigation, you can follow a specific transaction from a panel in one OMEGAMON to a panel in another OMEGAMON that contains information corresponding to that transaction. You invoke this feature with a context-sensitive pushbutton that provides the mechanism to navigate between OMEGAMON panels. See “Transplex Navigation and Session Switching” on page 289 for more information.
Using Help

Help can be accessed from the Help pull-down, from a panel, and from fields on a panel.

The OMEGAMON II help system is comprehensive and contains everything from a glossary of terms and tuning considerations to guides for immediate action. Use the system as a detailed reference and for help in solving problems.

Action Bar Help

To display help from the action bar, move the cursor to the help choice or type H in the home position. Then press Enter.

The Help pull-down menu is displayed, as shown in the following figure.

**FIGURE 7. Help Pull-down Menu**

To display a help topic, move the cursor to the entry field of your selection, or type its number or mnemonic in the entry field. Then press Enter.

---

*OMEGAMON II for CICS User’s Guide, Version 520*
The following selections are available from the Help pull-down menu:

**Help for help**  
Explains how to navigate through the OMEGAMON II help panels.

**Extended help**  
Panel level help for the current panel. This can also be accessed using F1 on any panel.

**Keys help**  
Describes the function keys used in the CUA interface

**Help Index**  
Provides an alphabetic index of help panels. Press F6 in the Help Index pop-up to see the Search Index pop-up, which you can use to search for specific help topics.

**Tutorial**  
Gives instruction on navigating around &OII., tells how to use the parts of the screen, and tells how to get help from fields, the glossary, and the help index. This selection also lists tips on using OMEGAMON II. These tips introduce you to new product features and advanced navigation techniques that will help you use the product more efficiently.

**Glossary**  
Defines words and phrases for components, functions, and features of CICS and OMEGAMON II. Press F6 in the Glossary pop-up to see the Search Glossary pop-up window. Use this pop-up to search for specific glossary terms.

**About**  
Shows logo, copyright, and product version information.

**User Information**  
Shows information about your current session, such as user ID, terminal ID, system ID, VTAM logmode name, and current ACB name.

**New Features**  
Describes the new features of this release.

---

**Panel Help**

To see help for the panel that you are currently using, make sure the cursor is at the home position, then press F1. A topic describing the panel is displayed in a pop-up window.

When you have finished viewing Help, press F12 or F3 to exit.

**Field Help**

To display help for an input field on a panel, position the cursor on the underscore of the field, then press F1. A topic defining the field is displayed in a pop-up window. When you have finished viewing Help, press F12 or F3 to exit.
Pressing Enter tells the application to do one of the following:

- display the choice selected from a pull-down menu
- save changes or additions to entries made on a pop-up window; then exit
- save changes made to data on panels
- refresh data displayed on panels
Function Keys

Function keys are used to perform many tasks in OMEGAMON II. The keys and their uses are displayed at the bottom of each panel.

Only the function keys that are available for the current panel are displayed. For example, panels with data that may continue over several screens display the backward and forward function keys, F7 and F8, respectively, while single-screen panels do not display them.

To display descriptions of the function keys, select **Keys help** from the Help pull-down menu.

General Function Keys

The following keys are generally active throughout the CUA interface:

- **F1 = Help** Displays a help window for the current panel or window.
- **F2 = Keys** Toggles (turns on or off) the function key display at the bottom of the panel.
- **F3 = Exit** Returns to a higher level panel. From a help panel, returns to the panel where help was requested. Cancels changes made to a panel. From the Region Status panel, exits the CUA interface.
- **F4 = Prompt** Displays a list of valid selections for an input field. Promptable fields are indicated by the presence of a plus (+) sign. Where there are only two valid selections for an input field, such as yes/no or on/off, F4 acts as a toggle, switching between the two selections.
- **F5 = Refresh** Clears and updates the display panel data. From a data entry panel, restores the last saved value. If the cursor is on a field, the last saved value is restored for that field. If the cursor is not on a field, the last saved values for all fields are restored. From a help panel, displays the Glossary.
- **F6 = Console** Presents the System Console panel from which you can issue CICS, MVS, JES, and VTAM commands.
- **F7 = Bkwd** Scrolls backward if more lines exist than can be displayed on the current panel. If you are on the first panel, two asterisks (**) are displayed instead of the function key name.
- **F8 = Fwd** Scrolls forward if more lines exist than can be displayed on the current panel. If no additional information exists, two asterisks (**) are displayed instead of the function key name.
- **F9 = Retrieve** On the System Console panel, retrieves the previous command issued from the command line.
- **F10 = Action Bar** Moves the cursor to the action bar at the top of the panel or back to where it was in the panel body the last time you pressed F10.
- **F11 = Print** Prints the screen. To route the screen to the printer, select the Options pull-down, then select Close print log. From a help panel, displays the Help index.
- **F12 = Cancel** Exits the current pull-down menu or pop-up window without saving entered data.
- **F15 = Region Status** Returns directly to the Region Status panel.
**Function Keys**

- **F18=Defaults**  Displays default settings. If the cursor is on a field, the default is restored for that field. If the cursor is not on a field, the defaults for all fields will be restored. (Available in some pop-up windows.)

- **PA2=Default trigger key**  Use to return from the OMEGAMON menu system. To change the key, select the Options pull-down, then Controls, then Session Defaults.
Exiting from OMEGAMON II

To exit from the CUA interface, follow these steps:

1. From the Region Status panel, press F3.
2. When the Exit Confirmation pop-up window displays, type X or 1.
3. Press Enter.
Exiting from OMEGAMON II
Getting Started with OMEGAMON II

Introduction
OMEGAMON II for CICS allows you to see the status of a CICS region. Status bars displayed on the Region Status panel indicate the health of a particular region. Starting from this panel you can learn more about how a region is performing by navigating to show details for the region or to view problem analysis panels. You can also select from the action bar to:

- see which action codes are valid for the panel you are viewing
- navigate to panels related to the one you are viewing
- filter the contents of a panel
- select panels by category
- customize the CUA interface
- see help topics in the help facility

This chapter tells how to log onto OMEGAMON II directly, describes the layout and use of the Region Status panel, and discusses each action bar choice available on it.

Chapter Contents

Logging Onto OMEGAMON II ................................................................. 48
Begin Your OMEGAMON II Session .................................................... 53
Using the Region Status Panel ............................................................. 54
Using the Actions Pull-down ............................................................... 60
Using the GoTo Pull-down ................................................................. 61
Using the Index Pull-down ................................................................. 65
Using the View Pull-down ................................................................. 67
Using the Options Pull-down ............................................................. 72
Dynamic Profile Update Facility ......................................................... 96
Using the Help Pull-down ................................................................. 97
Logging On to OMEGAMON II

Access to the OMEGAMON II CUA interface is either direct or through OMEGAVIEW. This section contains procedures for logging on directly and tells where to get information for logging on through OMEGAVIEW.

Logging On Directly

You can log onto OMEGAMON II directly by entering your VTAM application ID (applid).

Before logging on, be sure that the OMEGAMON II address space has been initialized. See the OMEGAMON II for CICS Configuration and Customization Guide for details on initializing the OMEGAMON II address space.

Entering Your VTAM Applid

To log on, issue the following command at a VTAM terminal (the OMEGAMON II address space must be initialized):

```
LOGON APPLID(aaaaaaaa)
```

where aaaaaaaa is the VTAM applid specified to the CL/Engine address space when it was started.

Finishing the Logon

After you’ve initiated the logon to OMEGAMON II, the Sign On panel displays to let you finish logging on. This panel validates you to your installation’s Logon Security system. The following figure shows the Sign On panel.

FIGURE 8. Sign On Panel
To sign on, enter your user ID, which is described below:

**User ID**  Enter your 1- to 8-character user ID. The user ID is mandatory even if your installation has no security system.

By default, you will use a userid profile with the same name as your user ID.

See “Defining a Different User ID Profile” on page 92 for more information.

You also may need to enter the following:

**Password**  Enter your 1- to 8-character password. The password is not visible as you type it. If you make a mistake, be sure to completely clear the field before retyping the password. The password is mandatory if a security system is in place.

**Change Password**  To change the current password, type Yes. The system prompts you for the new password information.

**Group**  Used only if your system security administrator has implemented group level security. Enter a 1- to 8-character group ID.

**Account**  Used only if your system security administrator has implemented account level security. Enter your installation security account number.

After you enter the signon information described above, you can begin your OMEGAMON II session unless you decide to specify logon options. See “Optional Step: Specifying Logon Options” on page 49 for that information, or see “Begin Your OMEGAMON II Session” on page 53.

**Optional Step: Specifying Logon Options**

Usually you can begin your OMEGAMON II session immediately after you have logged on through the Sign On panel and the system has initialized.

If, however, you want to verify defaults set up during customization, before you begin your session, access the Logon Options pop-up window (press F11 at the Sign On panel). Use this pop-up to specify startup information for the OMEGAMON II session you are starting.

The following figure shows the Sign On panel overlaid with the Logon Options pop-up.
The default values for logon options are obtained from `rhilev.RKANPAR(KC2IPAnn)`. These values were set up for your site during customization and display in this pop-up when you access it. (The user who installed and configured OMEGAMON II can tell you the high-level prefix for the dataset.)

Through the Logon Options pop-up, you can specify the following values:

**OMEGAMON II userid profile**

Enter the name of the OMEGAMON II userid profile you want to use for the current session.

If you have already supplied your userid on the OMEGAMON II Sign On panel, your default userid profile is displayed in this field. The default value is used as your OMEGAMON II userid profile.

To specify an alternate OMEGAMON II userid profile for this session, enter its name in this field. Press F4 to see a list of currently defined userid profiles.

See “Defining a Different User ID Profile” on page 92 for more information.

**OMEGAMON common interface applid**

Enter the 1- to 8-character VTAM application identifier for the OMEGAMON II for CICS common interface session you will use to monitor the CICS region.
Logging Onto OMEGAMON II

**OMEGAMON common interface password**
If desired, enter the 1- to 8-character password for the OMEGAMON II common interface (CANSOCnn) session you are trying to logon to.

Note: The nn variable in CANSOCnn designates an address space from 00-.55 in which to run the started task. For example, CANSOC03 specifies 03 as the address space.

This parameter is required only if security has been implemented for the OBVTAM subtask.

**CICS job name**
Enter the 1- to 8-character MVS job (or started task) name of the CICS region you are monitoring. Or, if the started task has a stepname, then enter the stepname.

**CICS region profile**
Enter the 1- to 8-character CICS region profile name to be used by the session you are defining.

The CICS region profile contains the OMEGAMON II thresholds settings for all performance measures.

If you specify a profile name in this field, it must have been previously defined in the OMEGAMON IICUA interface. Press F4 to see a list of currently defined CICS region profiles.

See “Defining A Different CICS Region Profile” on page 94 for more information.

**Migrate profile from OMEGAMON**
This option is a customization feature. See the OMEGAMON for CICS Configuration and Customization Guide for information.

**OMEGAMON profile to migrate from**
This option is a customization feature. See the OMEGAMON for CICS Configuration and Customization Guide for information.

**Password for authorized commands**
If you know that you will be using authorized commands, enter Yes and you will be prompted to set the password for the authorized commands used in OMEGAMON II displays.

Most OMEGAMON II displays use commands from the OMEGAMON II menu system. These commands can be protected by either a password or an external security exit which uses RACF or other security programs. Typically, commands are protected to prevent you from modifying the system or affecting other users (listing or changing memory, or killing a task, for example).

Once you enter a password, it is in effect until the end of your session or you reset it. To reset password authorization, use the Enable or Disable authorized commands option in the Options pull-down.
Logging onto OMEGAMON II

Logical rows for menu system

Enter the number of logical rows for the virtual terminal that the OMEGAMON II CUA interface uses to obtain data from the menu system. This number can be from 150-9999.

If the number of logical rows specified is insufficient to hold the output for a command, the command output is truncated. If the CUA interface detects that command output has been truncated, it issues a warning message that the CUA display may contain incomplete data.

Increasing the logical rows size increases the amount of virtual storage used by the virtual session in the OMEGAMON II common interface (CANSOCnn address space).

Note. The nn variable in CANSOCnn designates an address space from 00-55 in which to run the started task. For example, CANSOC03 specifies 03 as the address space.

Display the Tip of the Day

Each time you start a direct logon session, you can select one of the following for the Tips option:

Yes Presents the Tip of the Day when you log on.

No Does not present the Tip of the Day at logon.

Wait Displays the Tip of the Day when you log on until you press Enter to cancel it. This selection gives you a longer time to read the tip.

If you leave this field blank, the default value you specified in KC2IPAnn of DDname RKANPAR is used for the Tips option.

A different tip appears on each day of the month.

Logging on through OMEGAVIEW

An alternative method of logging onto OMEGAMON II is through OMEGAVIEW. See “OMEGAVIEW Enhanced Zoom” on page 269, for information on accessing OMEGAMON II through OMEGAVIEW.
Begin Your OMEGAMON II Session

After you have entered the required values on the Sign On panel and pressed Enter, the CICS Regions panel displays. This panel lists the available CICS regions that you can monitor. Select a region by typing an S in front of the CICS Jobname you want to monitor and press Enter. This displays the Region Status panel to begin your OMEGAMON II session. See “Using the Region Status Panel” on page 54 and the sections that follow it for introductory information you’ll need to know for a successful session.

If you would like an overview of what you might do during a typical session, see “CICS Problem-Solving Approaches” on page 99. This chapter contains scenarios that demonstrate typical situations you’ll encounter when using OMEGAMON II.
Using the Region Status Panel

The Region Status panel is the first panel you see after you finish logging on. It provides a high-level overview of a particular CICS region, displaying status bars for workloads, resources, and alerts. The name of the CICS region being monitored is in the upper right corner of the panel.

The following figures show the Region Status panel for CICS/ESA Version 5.1.0 and all earlier CICS versions.

FIGURE 10. Region Status Panel (CICS/ESA Version 5.1.0)

The following figure shows the Region Status panel for all versions of CICS/ESA prior to 5.1.0.

The following figure shows the Region Status panel for all versions of CICS/ESA prior to 5.1.0.
On the panel, the status bars are grouped into the following areas:

**Workloads**
Indicates the status of the useful work CICS is currently performing.
See Chapter 5, “Monitoring Workloads” on page 129, for information on each component in the Workloads section of the Region Status panel.

**Resources**
Indicates the status of resource usage.
See Chapter 6, “Monitoring Resources” on page 163, for information on each component in the Resources section of the Region Status panel.

**Alerts**
Indicates the status of exceptional conditions that can degrade response time and that may require immediate action.
See Chapter 7, “Responding to Alerts” on page 229, for information on each component in the Alerts section of the Region Status panel.
Status Bar Indicators

Status bar indicators report the current status of each CICS component on the Region Status panel, based upon thresholds set to measure performance.

On Color Terminals

On color terminals, the status bars contain lights that represent a component’s status, as follows:

- Red for critical
- Yellow for warning
- Green for normal
- Turquoise for not monitoring or data unavailable

Status words also display on a color terminal. The default status words are:

- Crit (for critical status)
- Warn (for warning status)
- OK (for normal status)
- Idle (for not monitoring)

You can change the status words on a color terminal by using the Session Defaults pop-up window of the Controls option on the Options pull-down menu. Enter up to five alphabetic or numeric characters. (Enter fast path OCS.)

On Monochrome Terminals

On monochrome terminals, words display in place of colors. The default words that display are as follows:

- Crit (for critical status)
- Warn (for warning status)
- OK (for normal status)
- Idle (for not monitoring)

You can change the default words that display on a monochrome terminal by using the Session Defaults pop-up window of the Controls option on the Options pull-down menu. Enter up to five alphabetic or numeric characters. (Enter fast path OCS.)

Showing Details/Analyzing Problems

You can get more information on the status of a component by entering S next to a status bar to show details or A to analyze problems.

Enter S to Show Details

If a status bar for a component indicates that it is performing well (either green or characters indicate an OK condition), or indicates a warning or a critical condition, you can enter action code S (Show details) to get more information about the component being monitored. In most instances, a panel showing summary information for the component displays.
Enter A to Analyze Problems

If the color of a status bar for a component indicates that it is performing poorly (you see yellow or red, or characters indicate a warning or critical condition), you can enter action code A to analyze the problem by displaying the performance measures and thresholds values that have been exceeded. A panel then displays listing one or more problems for the component. The following figure shows a problem analysis panel.

**FIGURE 12. Analyze DASD Problems Panel**

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Response time for 0328 (OMON24)</td>
<td>34ms</td>
<td>30ms</td>
<td>40ms</td>
</tr>
<tr>
<td>_Response time for 031C (OMON23)</td>
<td>33ms</td>
<td>30ms</td>
<td>40ms</td>
</tr>
<tr>
<td>_Response time for 0319 (OMON30)</td>
<td>31ms</td>
<td>30ms</td>
<td>40ms</td>
</tr>
</tbody>
</table>

**Note:** You should enter A next to a status bar only if its color or characters indicate the component is having problems. If you enter A next to a healthy status bar, you will get an error message such as the one shown below.

**DASD is not currently experiencing any problems**

Viewing the Frequency of Data Collection

Enter action code L (control data collection) next to a component to display a Thresholds pop-up window that shows the performance measures and thresholds for the component and the frequency of data collection. This field indicates how often OMEGAMON II collects data for the Region Status panel. Setting the frequency of data collection gives you control over resource usage.
Switching to Another CICS Region

The name of the CICS region currently being monitored displays in the Region field of the Region Status panel (see Figure 11 on page 55). If you want to monitor another CICS region, you can switch to it by overtyping the name displayed in the field. A different region will then be monitored.

*Note:* If you are running OMEGAMON II under OMEGAVIEW, you cannot switch to another CICS region by changing the name in the Region field on the Region Status panel. You can change regions by using the OMEGAVIEW Switch Session key. See “Transplex Navigation and Session Switching” on page 289 for information on using this key.

When you switch regions, OMEGAMON II searches for the region profile in the following order:

1. It looks for a profile with the same name as the region name.
2. If it does not find a profile with the same name as the region, and there is a region profile specified in member KC2IPAnn, it uses that name.
3. If it does not find a region profile specified in member KC2IPAnn (from dataset rhilev.RKANPAR), it uses $DEFAULT.

If you need to see the list of CICS regions that you can monitor, press F4. The CICS Region pop-up window displays. Tab to the desired region and press Enter.

Date/Time Stamp

The Region Status panel displays the current date and current time. You can specify the format of the date and time that display through the Preferences pop-up of the Options pull-down. See “Using the Options Pull-down” on page 72 for details. (Enter fast path OP.)

Auto Refresh Interval

The auto refresh interval, which indicates the elapsed time, in seconds, before the screen automatically refreshes, is displayed on the Region Status panel. To change the length of the interval, use the Session Defaults pop-up on the Options pull-down. (Enter fast path OCS.)
Region Status Panel Function Keys

The following keys are available for the Region Status panel:

- **F1=Help** Displays help for the Region Status panel or fields on the panel.
- **F2=Keys** (This notation does not display but the key may be used) Toggles (turns on or off) the function key display at the bottom of the panel.
- **F3=Exit** From the Region Status panel, exits the CUA interface.
- **F4=Prompt** Displays the list of CICS regions that you can monitor, when the cursor is on the Region input field.
- **F5=Refresh** Clears and updates the data on the panel.
- **F6=Console** Presents the System Console panel from which you can issue CICS, MVS, JES, and VTAM commands.
- **F10=Action Bar** Moves the cursor to the action bar at the top of the panel or back to where it was in the panel body the last time you pressed F10.
- **F11=Print** Prints the screen. To route the screen to the printer, select the Options pull-down, then select **Close print log**. (Enter fast path **OL**.)
Using the Actions Pull-down

The Actions pull-down menu enables you to choose an action for an item selected on a data panel or for the object described on a detail panel. Use the Actions pull-down menu when you need to see which action codes are available for the item you’ve selected. If you do not need to see the available action codes, enter the desired action code directly in a selectable field.

On a color terminal, actions colored blue are currently unavailable for selected items. On a monochrome terminal, an asterisk (*) appears as the first character of the selection.

To use the Actions pull-down, follow these steps:

1. Enter / on the panel next to the item you want. Press Enter. The Actions pull-down menu displays. The following figure shows an example.

FIGURE 13. AIDs Summary with Actions Pull-down

2. In the Actions pull-down menu, do one of the following:
   - move your cursor to the item and press Enter (see “Implicit Action” on page 74).
   - type the number of the item and press Enter
   - type the underlined letter and press Enter
   - on monochrome terminals, type the letter in parentheses and press Enter

The action you selected from the Actions pull-down takes place.
Using the GoTo Pull-down

The GoTo pull-down menu lets you navigate to an area of CICS monitoring related to the current panel. The choices on this pull-down vary for each panel. You can access this menu by entering `G` in the action bar entry field.

On Region Status, the GoTo serves a different purpose. It allows you to navigate to panels that cannot be reached through status bars.

The following figure shows the GoTo pull-down from the Region Status panel.

**FIGURE 14.** GoTo Pull-down Menu

For maps of the panels you can navigate to from this pull-down, see the navigation flowcharts appendix in the *OMEGAMON II for CICS Reference Manual*. 
Access CICS Tables

Through this pull-down you can access CICS Tables, which represents a selection of CICS control blocks that are not directly associated with other specific monitoring functions. Selecting CICS Tables from the GoTo pull-down causes the following panel to display.

FIGURE 15. CICS Tables Panel

See the chapter on CICS tables in the OMEGAMON II for CICS Reference Manual for more information on the panels you can access from here.
Access Task History

You can access Task History information through the GoTo pull-down on the Region Status panel. Task History presents the historical data collected for all completed transactions in a CICS region. Further details for each completed transaction are available by selecting a row of the Task History panel.

The following figure shows the Task History panel.

FIGURE 16. Task History Panel

See the chapter on task history in the OMEGAMON II for CICS Reference Manual for more information.

Access CICS Memory

You can access the CICS Memory panel through the GoTo pull-down menu. The CICS Memory panel displays storage in the CICS address space and is useful for looking at the unformatted contents of virtual storage in the address space.

Areas not formatted by other panels can be examined here. You can also scan virtual storage or chase control block chains to look for specific strings.

Enter action codes in the fields of the Contents section of the panel to select the processing you want. The available action codes are displayed above the table on the panel, and are also listed on the Actions pull-down menu. Also, press Enter in the input field next to any address to display memory at that address.

The following figure shows the CICS Memory panel.
FIGURE 17. CICS Memory Panel

For more information, see the chapter on CICS memory in the OMEGAMON II for CICS Reference Manual.

Zooming to the Menu System

Select this choice on the GoTo pull-down to access the facilities provided by the OMEGAMON II menu system. A pop-up window prompts you to specify an OMEGAMON II screen space to which to zoom. Enter the fast path for the topic to which to zoom. To see a list of fast paths for the menu system, press F1 on the Zoom to OMEGAMON Menu System pop-up, or see the appendix containing menu system fast paths in the OMEGAMON II for CICS Reference Manual.

To return to the CUA interface from the OMEGAMON II menu system, you use the trigger key that you specify through the Session Defaults selection on the Controls pop-up window. Follow these steps to specify the trigger key:

1. Select the Options pull-down menu.

2. Select Controls. The Controls pop-up window displays.

3. Select Session Defaults. The Session Defaults pop-up window displays.

4. Specify the trigger key in the Trigger Key to Return from Zoom field. Enter either of the following:

   - any key between PA1 and PA3 inclusive
   - any function key between F1 and F24 inclusive
Using the Index Pull-down

The Index pull-down menu allows you to access panels within OMEGAMON II without going through normal navigation paths. Using this pull-down menu, you can access a panel by selecting a subcategory to which the panel belongs or a panel name. You can also use this pull-down to search the panel title index.

In addition, the fast path mnemonics you use to navigate directly to all panels are based on the choices available through this menu. For example, the fast path for the Response Times panel, =WR, stands for the navigation path that starts at the Workloads selection on the Index pull-down, then goes to the Response selection on the Workloads menu, then to the Response Time selection on the Response menu, then to the Response Times panel.

See “Fast Pathing in the CUA Interface” on page 277 for a list of available fast path mnemonics.

The following figure shows the Index pull-down menu.

FIGURE 18. Index Pull-down Menu

Select Search for on the Index pull-down to display the Search Index pop-up window. The following figure shows the pop-up.
FIGURE 19. Search Index Pop-up Window

This pop-up lets you perform a search of the panel title index for all panels containing the specified text in their titles. This selection helps you find information about a particular feature of CICS when you do not know the relevant panel title.

To perform a search,

1. Select **Search for** from the Index pull-down. The Search Index pop-up window displays.

2. Enter one or more words on the Search field, making sure the word or words you enter are contained in the title of the panel you want to see. For example, if you enter **Address Space**, a list of the names of all panels that contain the phrase Address Space in their titles will appear in the Search Argument pop-up window.

3. Move the cursor to the panel title that matches the panel you want to see. Press Enter. The panel you searched for displays.
Using the View Pull-down

Use the View pull-down menu to filter and sort items displayed on the panel you are viewing. The choices on this pull-down allow you to filter the contents of a panel to see All, Some, and, in some cases, Problem items. You can also sort by specific columns on the panel, and sort the items in the columns in ascending or descending order.

The View pull-down menu is not available on all panels of OMEGAMON II.

The following figure shows a typical View pull-down menu.

**FIGURE 20. Typical View Pull-down Menu**

![Typical View Pull-down Menu](image)

Selecting All

Select **All** from the View pull-down to display all currently available data on the panel. If you set the default view in Session Defaults to show only problems, selecting All will cause all available data for the panel to display instead. See “Controls” on page 75 for information on setting session defaults.

Selecting Some

Select **Some** from the View pull-down to display the View Some pop-up window. This section tells you how to use the View Some selection with all panels except Task History or how to use it with Task History.
Using View Some with All Panels Except Task History

Use the View Some pop-up to enter filtering criteria so only specific information displays on the panel. For example, to exclude specific Tran IDs from displaying on the Tasks panel, follow the steps described below:

1. Select **Some** from the View pull-down on the Tasks panel. The View Some pop-up displays, overlaying the panel.

2. On the pop-up, move the cursor to the Transaction ID field and enter **NE** (not equal) in the Operator column.

3. In the Value column, enter the name of the Tran ID you do not want to see displayed on the panel. In this case, enter **CSSY**.

   The View Some pop-up then appears as follows.

   ![FIGURE 21. View Some Pop-up Showing Filter Criteria](image)

4. After you’ve finished entering the filter criteria, press Enter. The Tasks panel redisplay, showing all Tran IDs except CSSY.

   The following figure shows the panel.
Promptable Fields and Columns

Some values on the View Some pop-up may have a plus sign (+) at the end of the field. This means you can display a list of choices by tabbing to the field and pressing F4. Similarly, to see a list of valid comparative operators, move the cursor to the Operator column and press F4. Valid comparative operators are as follows:

- EQ (equal)
- NE (not equal)
- LE (less than or equal)
- LT (less than)
- GE (greater than or equal)
- GT (greater than)

Asterisks in the Value Column

An asterisk in the Value column of View Some means all values will display. You can use the asterisk as the last character of a string, for example, JOB*, and only the data that starts with JOB will be displayed.

Two or More Search Criteria

When you specify two or more search criteria, all specified search criteria must match for the data to be displayed.
Saving Filter Criteria and Restoring Values

Filter criteria are saved when you press Enter. You can press F5 on any input field to restore the last saved value. If you press F5 on any non-input field, all values are restored.

Using View Some with the Task History Panel

Unlike the View Some pop-up for all other panels, the pop-up for the Task History panel differs primarily as follows:

- in its layout
- its comparative operators, GE and EQ, are not selectable
- you can specify inclusion and exclusion criteria

Like the View Some pop-up used with other panels, however, you use this pop-up to specify filter criteria that limit the information displayed. Users of file-based data stores can sort the Task History panel with the most recent records displayed first (that is, in descending order of task start time).

The View Some pop-up is shown in the following figure:

FIGURE 23. View Some Pop-up for the Task History Panel

For example, to display tasks that had response times of at least 0.5 seconds, type the following in the Response Time field:

Response time GE ___.5 (sss.t)
When you specify two or more search criteria in the fields on the upper part of the pop-up window (Response Time through SUPRA), they must all be met (ANDed) in order for a task to be displayed on the Task History panel. For example, to display tasks that had response times of at least 2 seconds and used at least 4K of storage at any time, type the following:

- **Response time GE 2.0 (sss.t)**
- **Storage HWM . GE 4096**

The inclusion and exclusion criteria filters on the lower part of the pop-up (Tran ID, Terminal ID, User ID, Group Name, Abend Code, Unit of Work ID, and Transaction Group ID) allow you to determine which tasks will or will not be displayed (search criteria are ORed). Exclusion criteria take precedence over inclusion criteria. For example, to include tasks that

- had tran IDs starting with the characters “GO”, or
- were associated with terminals starting with the character “M”,

type the following in the Inclusion Criteria column:

- **Tran ID . . EQ GO**
- **Terminal ID . EQ M**

### Selecting Problems

Select **Problems** from the View pull-down to display only those items that have exceeded their thresholds. If you set the default view in Session Defaults to show all data available, selecting Problems will cause only problems to display for the panel instead. See “Controls” on page 75 for information on setting session defaults.
Using the Options Pull-down

When you log onto OMEGAMON II for the first time, it loads a copy of the default set of options.

The Options pull-down menu contains choices to help you customize the CUA interface options. The following figure shows the menu.

FIGURE 24. Region Status Panel, Options Pull-Down (Prior to CICS 5.1.0)

Using this menu you can
- change controls for your OMEGAMON II session; for example, the status of collection subtasks, and display and print options
- set thresholds for all panels
- set preferences such as date and time formats, mnemonics, and function key displays

After changing various values in the Options pull-down, OMEGAMON II prompts you to save them for the duration of the current CUA interface session or to save them in either the region profile or the userid profile. The values you saved for the current session will be discarded when you log off.

The Options menu choices are described below.
**Preferences**

Select this option to set standard defaults for your displays. The following figure shows the selections available.

**FIGURE 25. Preferences Pop-up Window**

<table>
<thead>
<tr>
<th>KC2B01D</th>
<th>Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td>S=Show details</td>
<td>Type any changes, then press Enter.</td>
</tr>
<tr>
<td>+----------</td>
<td>Mnemonics . . . . . . On_ + On/Off</td>
</tr>
<tr>
<td>Workloads</td>
<td>Beep . . . . . On_ + On/Off</td>
</tr>
<tr>
<td>_ AIDs Warn</td>
<td>Panel ID . . . . Off + On/Off</td>
</tr>
<tr>
<td>_ ICEs OK</td>
<td>Time/Date Display . . . On_ + On/Off</td>
</tr>
<tr>
<td>_ Response OK</td>
<td>Function Key Area . . . On_ + On/Off</td>
</tr>
<tr>
<td>_ Tasks OK</td>
<td>Implicit Action . . . On_ + On/Off</td>
</tr>
<tr>
<td>_ TranRate OK</td>
<td>National Language . . . English . . . . . . . . . . . . . . . . . . . +</td>
</tr>
<tr>
<td>_ Response OK</td>
<td>Date Format . . . . . mm/dd/yy . . . . . . . . . . . . . . . . . . . . . . . . . +</td>
</tr>
<tr>
<td>_ Tasks OK</td>
<td>Time</td>
</tr>
<tr>
<td>_ TranRate OK</td>
<td>Format . . . . . 24 + 12/24 hour</td>
</tr>
<tr>
<td>_ Response OK</td>
<td>Separator character . .</td>
</tr>
<tr>
<td>_ Tasks OK</td>
<td>Morning indicator . . AM</td>
</tr>
<tr>
<td>_ TranRate OK</td>
<td>Afternoon indicator . PM</td>
</tr>
<tr>
<td>F1=Help F4=Prompt F12=Cancel</td>
<td>F1=Help F3=Exit F4=Prompt F5=Refresh F6=Console F10=Action Bar F11=Print</td>
</tr>
</tbody>
</table>

**Mnemonics**

When Mnemonics is on, an input field displays to allow the entry of fast path mnemonics for quick access to the various pull-down menus. When Mnemonics is off, the input field no longer displays and you must tab to your selection and then press Enter. The default setting is On.

**Beep**

When Beep is on, the terminal alarm sounds for input errors that are detected by OMEGAMON II. A beep also sounds whenever you press a function key that is not currently available. When Beep is off, the terminal alarm does not sound. The default setting is On.

**Panel ID**

Displaying the panel ID may be useful if you have to report any problems with the current panel. The default setting is Off.
Time/Date Display
When Time/Date Display is on, the current time and date display on the right side of the action bar separator line. When off, the current time and date do not display. The default setting is On. Press F4 to toggle between On and Off.

Function Key Area
When Function Key Area is on, the currently available function keys display on the bottom one or two lines of the panel. When off, the function key area does not display. In some cases, this allows you to see more information on the panel. The default setting is On. Press F4 to toggle between On and Off.

Implicit Action
When Implicit Action is on, you can simply position the cursor in the entry field of a panel selection and press Enter for an implicit action to occur. The implicit action is panel dependent. When Implicit Action is off, you must type an explicit action code in the entry field. The default setting is On.

Exit Confirmation
When Exit Confirmation is on, a prompt displays to confirm an exit from the current application.

The default setting is On. Press F4 to toggle between On and Off.

Delete Confirmation
When Delete Confirmation is on, a prompt displays to confirm a delete action that you requested.

The default setting is On. Press F4 to toggle between On and Off.

National Language
Press F4 to see a list of available languages.

Date Format
Select the date format you want to use for the current date at the top of each panel. The default format is mm/dd/yy. Press F4 to see a list of available formats.

The only valid date formats used within panels are mm/dd/yy and dd.mm.yy.
Time
Select the time format you want to use for the current time at the top of each panel. You can select the following:

**Format**
Select either the 12 or 24 to specify the 12- or 24-hour time format. The default format is 24.

**Separator character**
The character that displays between the hours, minutes, and seconds portion of the time stamp. The default character is a colon. Any character is valid.

**Morning indicator**
The two-character code that indicates morning hours when the 12-hour time format is selected. The default value is AM. Any two characters are valid.

**Afternoon indicator**
The two-character code that indicates hours after 11:59:59 in the morning, when the 12-hour time format is selected. The default value is PM. Any two characters are valid.

The only valid time format used within panels is 24-hour format, hh:mm:ss.

Controls
Select this option to specify such administrative details as settings for session defaults, the routing of screen print output, and the enabling or disabling of your Authorized Command Facility password. The following figure shows the pop-up window that displays.

FIGURE 26. Controls Pop-up Window

```
<table>
<thead>
<tr>
<th>KC2B01D</th>
<th>Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>KC2QCTL</td>
<td>Select one component w</td>
</tr>
<tr>
<td>---------</td>
<td>S=Show details A=A</td>
</tr>
<tr>
<td>---------</td>
<td>+-----------------------</td>
</tr>
<tr>
<td></td>
<td>Workloads</td>
</tr>
<tr>
<td></td>
<td>AIDs  OK</td>
</tr>
<tr>
<td></td>
<td>ICEs  OK</td>
</tr>
<tr>
<td></td>
<td>Response OK</td>
</tr>
<tr>
<td>---------</td>
<td>+-------------------</td>
</tr>
<tr>
<td></td>
<td>Tasks  OK</td>
</tr>
<tr>
<td></td>
<td>TranRate Crit</td>
</tr>
<tr>
<td>---------</td>
<td>DBCTL  Warn</td>
</tr>
<tr>
<td>---------</td>
<td>Storage Crit</td>
</tr>
<tr>
<td>---------</td>
<td>TranData Crit</td>
</tr>
<tr>
<td>---------</td>
<td>Enqueues OK</td>
</tr>
<tr>
<td>---------</td>
<td>I/O Rate OK</td>
</tr>
<tr>
<td>---------</td>
<td>VTAM ACB OK</td>
</tr>
<tr>
<td>---------</td>
<td>XRF      Crit</td>
</tr>
</tbody>
</table>

F1=Help  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar  F11=Print
```
A pop-up window displays for each selection on the Controls pop-up window. The following pop-up windows display:

- Sessions Defaults
- Screen Print Output Routing Options
- Enable Authorized Commands
- Print SNAPSHOT of CICS Region

### Session Defaults

The following figure shows the Session Defaults pop-up.

**FIGURE 27. Session Defaults Pop-up Window**
This pop-up allows you to specify the session controls described below.

**Auto Refresh Interval**
This field indicates the elapsed time, in seconds, before the screen is automatically refreshed.

The default for this option is no auto refresh (Off).

**Trigger to Return from Zoom**
This field indicates which key will act as a trigger to return from the OMEGAMON II menu system interface to the CUA interface of OMEGAMON II.

Valid options are the function keys 1-24 and the PA keys 1-3. See “Zooming to the Menu System” on page 64 for the procedure to follow to set a trigger key.

**Default View**
This field indicates the default view of data panels.

- **All**
  Displays all of the available data.

- **Problems**
  Displays only those items that have exceeded their thresholds.

To toggle between All and Problems, press F4.

The default view is in effect until you select a view different from the default on the View pull-down menu.

**Use Status Words**
This field indicates whether status words are displayed on the Region Status panel.

Status characters reflect the threshold status.

Enter Yes in this field if you are using a monochrome terminal, or if you want to display characters as well as color on a color terminal.

To toggle between Yes and No, press F4.

**Critical Status Word**
The alphanumeric critical status word used on the Region Status panel when the critical threshold has been exceeded.

**Warning Status Word**
The alphanumeric warning status word used on the Region Status panel when the warning threshold has been exceeded.

**OK Status Word**
The alphanumeric OK status word used on the Region Status panel when no thresholds have been exceeded.

**Idle Status Word**
The alphanumeric idle status word used on the Region Status panel when no data is being collected for a component.

**Saving Your Session Default Settings**
After changing settings, OMEGAMON II prompts you to save them for the duration of the current session or to save them in the userid profile.

**Screen Print Output Routing Options**
This pop-up window lets you set up the destination information for screen prints. The following figure shows the pop-up.
The following fields display on the pop-up:

**Sysout Class**  The sysout class that you normally use for your print jobs.

**Copies**  Enter the number of copies to be printed. Specify 1-999.

**Destination**  Enter your printer destination. This field can contain up to 17 characters, and you can choose between two forms to specify the destination. The first form is `node.name`, which is generally used to specify remote printers. The components of this form, node and name, can each be up to 8 characters long. These components are delimited by the period. The second form of the destination lets you specify just the name of the printer. In this case, the destination can be only 8 characters long.

**Form name**  If desired, enter a print form name.

**Hold output**  Indicate whether you want the print output held in the input queue before it is printed. Press F4 to toggle between Yes and No.

**Fold to uppercase**  Indicate whether you want the print output in uppercase. Press F4 to toggle between Yes and No.

**Routing information**  You may enter a description in this field. Your logon ID will be specified automatically.
Enable Authorized Commands

This pop-up window allows you to enter the OMEGAMON II Authorized Command Facility password. The following figure shows the pop-up.

FIGURE 29. Enable Authorized Commands Pop-up Window

If you try to navigate and receive a message saying you are not authorized to view the information, then you need to enter the OMEGAMON II password. Once you type the password and press Enter, you will be able to display information and take actions that are password protected. Once you enter a password, it is in effect until the end of your session.

Disable Authorized Commands

To prevent the display of password-protected information, select Disable Authorized Commands from the Controls pop-up. A message displays stating that the command was successfully reset.

Print SNAPSHOT of CICS Region

Selecting Print SNAPSHOT of CICS region from the Controls pop-up will cause a SNAPSHOT to be taken for the current CICS region. The resulting output is written to the OMEGAMON II for CICS log file, then is automatically routed to the JES Print Queue under the OMEGAMON II for CICS address space job JCL. An informational message is displayed upon successful completion of the SNAPSHOT function.
Collection Controls

This option allows you to manage the collection of performance data for CICS regions, set internal bottleneck display controls, and predetermine the amount of CICS resources a task may use (resource limiting). Data collection can be managed for the following:

- internal bottlenecks
- interval recording
- response time
- task history
- CICS file and database statistics

The following figure shows the Collection Controls pop-up window:

FIGURE 30. Collection Controls Pop-up Window

The following sections describe the collection controls.

Internal Bottleneck Collection

The Internal Bottleneck Collection pop-up window enables you to control the collection of internal resource bottleneck information for the current CICS region. Internal bottleneck analysis identifies the various reasons why tasks in your CICS region are waiting.

Bottleneck data is collected in a common area for each CICS region. This information is shared by all OMEGAMON II sessions monitoring that region.

Use this pop-up to see the current status of the bottleneck collector and to change collection options. The following figure shows the Internal Bottleneck Collection pop-up.
Using the Options Pull-down

FIGURE 31. Internal Bottleneck Collection Pop-up Window

You can display the collected internal bottleneck data by selecting the Bottleneck status bar on the Region Status panel. The status bar indicates when the percentage of wait time for any resource exceeds the bottleneck threshold.

For more information on the Internal Bottleneck Collection pop-up, see the OMEGAMON II for CICS Reference Manual.

Internal Bottleneck Display Controls

Internal bottleneck analysis is a realtime facility that looks over a short-term time interval and identifies the various reasons why CICS tasks in your CICS region are waiting.

The Internal Bottleneck Display Controls panel shows all the possible internal bottlenecks that may exist in your CICS region. The following figure shows the panel.
For more information on internal bottlenecks, see the OMEGAMON II for CICS Reference Manual.

Response Time Collection
The Response Time Collection pop-up window enables you to control the collection of response time information. The following figure shows the pop-up.
FIGURE 33. Response Time Collection Pop-up Window

Response time data is collected into a common area for each CICS region. This information is shared by all OMEGAMON II sessions monitoring that region.

For more information on the response time collection, see the OMEGAMON II for CICS Reference Manual.

Interval Record Collection

The Interval Recording pop-up window enables you to control the collection of interval records. Use this pop-up to see the current status of the interval record collector and to change collection options. The following figure shows the pop-up.
Using the Options Pull-down

FIGURE 34. Interval Recording Pop-up Window

The interval record collector analyzes each CICS region at a specified interval, collecting response time, bottleneck, and resource information. This data is then formatted and written to SMF for later analysis.

For more information on interval recording, see the OMEGAMON II for CICS Reference Manual and the OMEGAMON II for CICS Historical Reporting Guide.

Task History Collection

The Task History Collection pop-up window enables you to control the collection of task history information. The following figure shows the pop-up.
Task history data is collected into a separate dataspace or file for each CICS region. This information is shared by all OMEGAMON II sessions monitoring that region.

For more information on the Task History pop-up, see the Collection Controls section in the OMEGAMON II for CICS Reference Manual.

**Collection of CICS File/Database Information**

The CICS File/Database Collection pop-up window enables you to dynamically control the collection of statistics for VSAM, DB2, DL/I, and third-party database products. The following figure shows the pop-up.
For VSAM, task statistics are always collected if CICS Monitoring is active. You also have the option to collect file statistics.

For DB2, only task statistics may be collected.

For the other products, you can decide whether you want to collect only summary statistics at the task level, or if you also want to collect detailed statistics for each file or database.

See the _OMEGAMON II for CICS Reference Manual_ for more information.

### Resource Limiting

Resource limiting allows you to predetermine the amount of CICS resources that a task may use. Any tasks exceeding these thresholds will be abended by OMEGAMON II. Thresholds can be set for the following resources used by a task:

- CPU time
- elapsed time
- number of file and database requests
- current amount of CICS task storage in use

The following figure shows the Resource Limiting pop-up window.
Monitoring Control

The Monitoring Control pop-up lets you change the levels of monitoring within a CICS region that is being monitored. You can select an Active or Inactive state for monitoring CICS, OMEGAMON, and SMF data collection.

CICS monitoring produces performance monitoring data. When the SIT parameters, MN and MNPER, are both active, CICS produces the performance data in the form of SMF records. CICS must be active to produce SMF data. To suppress SMF data, either CICS monitoring must be inactive, or OMEGAMON monitoring must be active.

OMEGAMON monitoring is provided by the OMEGAMON global user exits inside CICS. These exits report on task history, interval record collection, response time analysis, and SMF data suppression. CICS must be active for the global user exits to be active.
The following table shows the effect of the different setting combinations for monitoring.

<table>
<thead>
<tr>
<th>Monitoring States</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>All monitoring is Active.</td>
<td>OMEGAMON global user exits are active, and SMF records are written.</td>
</tr>
<tr>
<td>SMF data collection is Inactive, CICS and OMEGAMON monitoring are Active.</td>
<td>OMEGAMON global user exits are active, but SMF records are suppressed.</td>
</tr>
<tr>
<td>OMEGAMON monitoring is Inactive, CICS monitoring and SMF data collection are Active.</td>
<td>OMEGAMON global user exits are inactive, and SMF records are written without OMEGAMON data.</td>
</tr>
<tr>
<td>Only CICS monitoring is Active.</td>
<td>An error results. SMF records are suppressed.</td>
</tr>
</tbody>
</table>

**VSAM Analysis**

The VSAM Analysis pop-up lets you control the interval of time for collecting VSAM statistics. This setting controls the collection interval of statistics for

- VSAM CA splits
- CI splits
- extents
- RLS timeouts

You can specify a value between 0-1440 minutes. A value of zero collects and evaluates statistics every time the Region Status or VSAM panels are refreshed.

Changing these settings affects all OMEGAMON II sessions monitoring the current CICS region.

**Storage Violation Analysis**

The Storage Violation Analysis pop-up lets you control the floating time interval for storage violation analysis. It also lets you reset the current count and restart the interval clock.

Changing these settings affects all OMEGAMON II sessions monitoring the current CICS region. To make a permanent change to the interval, use the VIOLATIONS_MONITORING_INTERVAL parameter of the EXCEPTION_ANALYSIS_INTERVALS parameter in the global data area module.

**Dump Analysis**

The Dump Analysis pop-up lets you control the interval of time over which dump counts are collected. It also lets you reset the current count.

Changing these settings affects all OMEGAMON II sessions monitoring the current CICS region. To make a permanent change to the interval, use the DUMPS_MONITORING_INTERVAL parameter in the global data area module.
Application Trace Facility

The Application Trace Control panel lets you activate or deactivate the collection of application trace data within CICS/ESA systems. It also lets you add, modify, or delete application trace filters.

When activated, the application trace is in effect for all transactions running within the CICS region that have a filter defined. If no filters are defined, the application trace is in effect for all transactions that are running in the CICS region.

The OMEGAMON application trace facility is independent of trace features in CICS. For more information, see the OMEGAMON II for CICS Reference Manual.

CICS Shutdown Option

This option allows you to specify whether or not to purge waiting conversational tasks in CICS at CICS shutdown, or to prompt the MVS console operator so they can determine whether to terminate waiting conversational tasks. The following figure shows the pop-up.

FIGURE 38. CICS Shutdown Option Pop-up
Thresholds

You can use this option to set performance measures (service level indicators such as CPU rate or response time) for workloads, resources, and alerts. Each CICS component on the Region Status panel has one or more performance measures with warning and critical thresholds. When one of the thresholds has been reached, the status bar on the Region Status panel changes color. Moreover, on panels, many fields show highlighting depending on the status of thresholds set for the component.

This option also allows you to indicate how often OMEGAMON II collects data for the Region Status panel. Setting the frequency of data collection gives you control over resource usage.

As an example of how to set warning or critical thresholds for performance measures and the frequency for data collection, follow these steps:

3. Select Tasks. The Tasks Thresholds pop-up window displays, showing this component’s performance measures and threshold values.

The following figure shows the thresholds pop-up for Tasks.

**FIGURE 39. Tasks Thresholds Pop-up Window**

Each performance measure has warning and critical threshold settings, as well as an option to have OMEGAMON II monitor the measure.
4. Overtype these settings to conform to your service level agreements. For the Warning and Critical fields, enter numeric values and On and Off. For the Monitor field in the pop-up, specify Yes or No to have OMEGAMON II monitor specific performance measures. To start monitoring, move the cursor to the field, then press F4 to toggle the setting to Yes. Press Enter.

**Important**

If you select No for all performance measures, the status bar on the Region Status panel will show Idle. (The detailed panel can still be viewed, however, if the information is available.)

You may want to select No for conditions your site considers unimportant. Setting the Monitor fields to No saves overhead on the Region Status panel.

5. Enter a number from 1-99 in the Frequency of data collection field to indicate how often OMEGAMON II should collect data for the Region Status panel. Press Enter.

After changing any threshold values, you are prompted to save them for the duration of the current CUA interface session or to save them in the region profile.

**Response Time Groups**

This option allows you to access the Response Time Groups panel, which shows you all the groups currently defined. You can use the panel to change the attributes of existing groups or to create new groups.

Response time thresholds may be set for transaction, program, terminal, or LU elements belonging to one or more groups.

Response time and bottleneck data collection and interval recording collect data by groups. If the response time collection subtask has been activated, the groups you’ve defined or changed will display in the Response Times panel (only if there has been activity).

For more information, see “Defining Response Time Groups for Monitoring” on page 251.

**Userid Profiles**

This option shows you all the userid profiles currently defined. It allows you to manage your userid profiles by copying, printing, or deleting them, or by switching to another profile from the current profile. You can create new userid profiles and delete all the profiles listed except the default profile. The following figure shows the panel that displays through this selection.
OMEGAMON II allows you to enter a userid profile when you log on. The userid profile contains the settings from the Preferences selection on the Options pull-down menu, and from two subcategories of the Controls selection on the Options pull-down, Screen Output Routing Options and Session Defaults.

If the default userid profile does not suit your needs, you can define a different userid profile. You can enter the profile in the OMEGAMON II Userid Profile field of the Logon Options pop-up when you log onto OMEGAMON II.

To define a different userid profile, follow these steps:

1. Copy an existing userid profile:
   A. Log onto OMEGAMON II using the default user ID profile.
   B. Access the Options pull-down menu on the Region Status panel.
   C. Select Userid Profiles. Press Enter. The Userid Profiles panel displays.
   D. Type C next to an existing profile to copy that profile to the profile you will name. Press Enter. The Copy a Profile pop-up window displays.

   ![Userid Profiles Panel](image-url)
2. Specify a name for a new user ID profile:
   A. At the Copy a Profile pop-up, specify a unique name for the userid profile you want to create.
   B. Type 1-8 characters on the New Profile Name field, then tab to the New Profile Description field and type a description of the profile. Press Enter. The user ID profile name you specified is added to the list of profiles in the Userid Profiles panel.

3. Change settings in Preferences and Controls.
   A. Access the Options pull-down menu.
   B. At this point make changes to settings in the Preferences option and in Controls through the Session Defaults and Screen Output Routing Options selections. Be sure to press Enter after each change you make. When you change a setting, the Save Userid Options pop-up window displays.
   C. Press 2 to save the changes you are making to your profile.
   D. When finished changing settings in Preferences, Session Defaults, and Screen Output Routing Options, return to the Options pull-down menu. Press F12. The underlying panel redisplay.

Your profile now contains the changes you made in Preferences, Session Defaults, and Screen Output Routing Options.

Region Profiles

This option displays all currently defined region profiles. It enables you to copy, delete, print, export, import, and migrate specified profiles using action codes or the Actions pull-down menu.

You can also use this option to switch to another profile from the current profile. The following figure shows the Region Profiles panel.
Defining A Different CICS Region Profile

The region profile contains the threshold settings for all performance measures for a given CICS region. This profile is used by all userids that monitor a specific region.

If the default region profile does not suit your needs, you can define a different region profile. You can enter this profile in the CICS Region Profile field of the Logon Options pop-up when you log onto OMEGAMON II.

To define a different region profile, follow these steps:

1. Copy an existing region profile:
   A. Log onto OMEGAMON II using the default region profile.
   B. Access the Options pull-down menu on the Region Status panel.
   C. Select Region Profiles. The Region Profiles panel displays.
   D. Type C next to an existing region profile to copy it to the profile you will name. Press Enter. The Copy a Profile pop-up window displays.

For more information about the actions you can perform on the Region Profiles panel, see the “Region Profiles” section in the OMEGAMON II for CICS Reference Manual.
2. Specify a name for a new region profile:
   A. At the Copy a Profile pop-up, enter 1-characters on the New Profile Name field to specify a name for a new region profile.
   B. Tab to the New Profile Description field and enter a description of the profile. Press Enter. The new profile name is added to the list of profiles in the panel.

3. Change threshold settings for the component you want:
   A. Return to the Options pull-down menu.
   B. Elect Thresholds. The Thresholds pop-up window displays.
   C. Select a category from the Thresholds pop-up. For example do the following:
      b. Select a component from the Workloads Thresholds pop-up. For example, select AIDs. Press Enter. The AIDs Thresholds pop-up window displays showing the current threshold settings for the component.
      c. Change as many threshold settings for the component as you want. Press Enter after each change. The Save Region Options pop-up displays.
      d. Enter 2 to save the threshold changes to your profile. Press Enter. The Workloads Thresholds pop-up redisplays.
      e. Press F12 to exit the Workloads pop-up. The Thresholds pop-up redisplays.
      f. Press F12 to exit the Thresholds pop-up. The Options pull-down menu redisplays.
   D. You can continue to change threshold settings for as many components as you want by repeating this procedure starting from step 3. Be sure to press Enter after changing each setting.

Close Print Log

This option allows you to close the screen print dataset that contains screens you’ve selected for printing using the F11 key, and it routes the screens to be printed.
Dynamic Profile Update Facility

The Dynamic Profile Update Facility allows users to export and import individual CUA profiles dynamically to and from a partitioned dataset. This facility can be invoked externally through an MVS console command.

Observe these considerations when using the import and export dialogs:

- Invoke KC2EXP and KC2IMP by using the MVS Modify command.
- Use KC2EXP to export a profile to a partitioned dataset and KC2IMP to import a profile from a partitioned dataset.
- When you export a profile, its data is written in a standard format to a partitioned dataset member.
- The partitioned dataset should be allocated as fixed blocked, LRECL of 80, and BLKSIZE of 8880, with an appropriate number of directory blocks.
- Make sure KC2PROC, the OMEGAMON II for CICS started task name, has write authority to the partitioned dataset.
- Importing reverses the above process, and recreates a profile based on the exported information.

The MVS Modify command for exporting a profile is as follows:

```
/F KC2PROC,NTD KC2EXP 'PDSNAME MEMBER PROFILE'
```

Where **PDSNAME** is the name of the target partitioned dataset, **MEMBER** is the target partitioned dataset member, and **PROFILE** is the source profile.

The MVS Modify command for importing a profile is as follows:

```
/F KC2PROC,NTD KC2IMP 'PDSNAME MEMBER PROFILE'
```

Where **PDSNAME** is the name of the source partitioned dataset, **MEMBER** is the source partitioned dataset member, and **PROFILE** is the target profile.

After exporting a profile to a PDS, do not modify the PDS member. Otherwise unpredictable results may occur when importing the profile.

If you want to see messages indicating success or failure in the MVS SYSLOG, be sure you have WTO(Y) specified in the KC2SYSIN parameter member in the RKANPAR dataset. The messages are as follows:

- KC2EXP00 - Profile *profile* was exported successfully.
- KC2EXPFF - Export failed for profile *profile*.
- KC2IMP00 - Profile *profile* was imported successfully.
- KC2IMPFF - Import failed for profile *profile*.

For more information on these messages, see the *OMEGAMON II for CICS Messages Manual*. 
Using the Help Pull-down

The OMEGAMON II help system is comprehensive and contains everything from a glossary of terms and tuning considerations to guides for immediate action. Use the system as a detailed reference and for help in solving problems.

One way to access the help system is through the Help pull-down menu. Simply move the cursor to the Help choice on the action bar or type \textbf{H}. in the home position. Then press Enter. The Help pull-down menu displays, as shown in the following figure.

**FIGURE 42. Help Pull-down Menu**

To display a help topic, move the cursor to the entry field of your selection, or type its number or mnemonic in the entry field. Then press Enter.

For an explanation of each selection on the Help pull-down, see “Action Bar Help” on page 40.

Online help can also be accessed through panels and panel fields with the F1 key. See “Panel Help” on page 41 and “Field Help” on page 41 for details.
Using the Help Pull-down
Introduction

This chapter provides examples of how to use OMEGAMON II to identify and solve the following typical CICS problems:

- excessive CPU usage
- excessive response time for users
- users complaining about bad response
- new application experiencing poor response
- program’s changes not being reflected
- CICS is not responding
- User terminal is not responding

Chapter Contents

- Excessive CPU Usage .............................................................. 100
- Excessive Response Time for Users ..................................... 104
- Users Complaining about Bad Response .............................. 108
- New Application Experiencing Poor Response ...................... 110
- Program’s Changes Not Being Reflected .............................. 115
- CICS Is Not Responding ....................................................... 122
- User Terminal Is Not Responding ........................................ 126
Excessive CPU Usage

The CPU status bar on the Region Status panel indicates a critical problem for the resource, CPU.

FIGURE 43. Region Status Panel (prior to CICS/ESA Version 5.1.0)

To determine the nature of the problem, type S (Show Details) next to CPU. The following panel then displays.
This panel shows all the tasks in the CICS region. You can see that the BURN transaction is using excessive CPU time. To see more detail on this transaction, type **S** next to BURN. The Task Details panel displays.
FIGURE 45. Task Details Panel

From the Task Details panel, you can confirm that the BURN transaction is not giving up control to other transactions. (Look at the Task State field; the status remains as RUNNING.) You suspect that the transaction may be in a loop and needs to be terminated. Enter A (Actions) at the top of the panel to select the Purge task choice from the Actions pull-down menu.
Excessive CPU Usage

After typing P or 2 in the entry field on the Actions pull-down menu, a confirmation pop-up window will display so you can confirm that the task is to be terminated. At the window, verify that the number of the task to be purged is correct and then press Enter. To cancel the purge, press F12.

Once the task is purged, other transactions can run normally again.
Excessive Response Time for Users

On the Region Status panel, you see that the Response status bar indicates a critical problem. The Region Status panel is shown below.

FIGURE 47. Region Status Panel with Critical Response Status Bar

To determine the cause of the problem, type S in the entry field next to Response (in the Workloads section) to show details. The Response Times panel then displays.
From the Response Times panel, you can see that the Payroll group is experiencing poor response time. To determine what factors may be affecting those transactions belonging to the group, enter a B (for Bottlenecks) next to Payroll in the Group Name column. The Internal Bottlenecks panel displays.

FIGURE 49. Internal Bottlenecks Panel
Looking at the Internal Bottlenecks panel, you see that all is well. No bottlenecks have been detected within the CICS region that are affecting the Payroll group. You then decide to see if external bottlenecks might be affecting the group, so you select the External Contention pushbutton at the bottom of the panel. (Tab the cursor to the pushbutton and press Enter.) The External Contention panel displays.

FIGURE 50. External Contention Panel

From this panel, you can see that there is a batch job called TESTPAY that is competing with CICS. If you want to find out what resources are being contended by TESTPAY, select it by placing an S next to the address space and pressing Enter. The External Contention Details panel then displays.
FIGURE 51. External Contention Details Panel

From this panel, you can see that the resource being contended is VOL054, a volume needed by CICS. You realize this is a batch job that is normally run during nonpeak periods, and you can now take steps to cancel it.
Users Complaining about Bad Response

You have received several calls from users in a remote office complaining about poor response time. The Response status bar on the Region Status panel indicates a critical problem. You enter an S next to Response to find out what may be happening. The Response Times panel is displayed.

**FIGURE 52. Response Times Panel**

The users calling are all from the same office. A network problem is indicated by the high response times for the first LU group and by the subsecond internal response times for the group types Prog, Tran, and Term.

You enter S next to the LU group associated with the users (Remote LUs). A panel showing response times for all the LUs in the selected group appears.
This panel breaks down all the elements of a group, in this case the VTAM LUs, and gives you the required detail to determine the cause of your response time problem. Here, you can see that the problem is indeed in the network since response time there is over 15 seconds and the host time is subsecond. Because of this detail, you have not wasted time trying to determine if there was an application or MVS problem when your problem was in the network.
New Application Experiencing Poor Response

The Response status bar on the Region Status panel indicates a critical problem with response times. You select Response by entering S next to it on the Region Status panel. The Response Times panel then displays.

FIGURE 54. Response Times Panel

You see here that the group INVNTORY is experiencing poor response time. You know that transactions in this group invoke new programs recently put into production. It had subsecond response time in the test environment, but is experiencing 20- to 30-second response time in production.

You can look at this group in more detail by entering an S in the entry field next to it.
Figure 55. Response Time Details Panel

From the Response Time Details panel for the inventory application, it seems that one transaction, ASMA, is having a problem and, because of it, application performance is being degraded. Therefore, you may want to see detailed historical data for this transaction ID. To do so, enter an S next to ASMA to show details. The Task History panel displays...
From the Task History summary panel for the ASMA transaction, you see that all occurrences of the transaction have an unusually high file I/O. As all occurrences of ASMA are essentially the same in this regard, enter an **S** next to any Task Start Time field to obtain still more detailed information. The Task History Details panel displays.
New Application Experiencing Poor Response

FIGURE 57. Task History Details Panel

From the Task History Details panel, you see the large number of FCT requests the transaction has made. To see which files have been accessed, enter an S in the entry field next to FCT requests to show details. The Task History FCT panel displays.
FIGURE 58. Task History FCT

| Task number . . . . . : 402 | Transaction ID . . . . : ASMA  |
| Browses . . . . . . . : 0    | Browse time . . . . . : 0       |
| Deletes . . . . . . . : 25392 | Delete time . . . . . : 6.802s   |
| Reads . . . . . . . : 45923  | Read time . . . . . . : 9.832s   |
| Updates . . . . . . . : 45251 | Update time . . . . . : 10.054s  |
| Writes . . . . . . . : 30    | Write time . . . . . . : 0.014s  |
| Miscellaneous requests: 10 | Misc request time . . . : 0     |

From this panel, it can be seen that the majority of file requests have been issued against a file called ASMF02A. You can use this fact to isolate the cause of the problem within the application program.

**Note:** VSAM file-level statistics are collected by OMEGAMON only when a file request invokes the EXEC interface program, DFHEIP. Detailed statistics will not be collected for a file, therefore, for any transaction that does not access the file through an EXEC CICS call. For example, detailed statistics for file DFHCSD are not available for transaction CEDA.
One of your applications has caused storage violations because of a coding error in one of its programs. You know that this program, LARM001, was changed last night to correct this problem. But you have been contacted and told that storage violations are still occurring in CICS production, and you suspect LARM001. So you want to check to make sure that the new copy of LARM001 is the one being executed in your CICS production region.

At the Region Status panel, enter G in the entry field on the action bar to select the GoTo pull-down menu.

FIGURE 59. GoTo Pull-down Menu

Then, from the GoTo pull-down menu, select 1 for CICS Tables. The following figure shows the CICS Tables panel.
You want to look at the Program entries. OMEGAMON II allows you to see the load library from which the program represented by a Program entry was loaded. To display the Programs panel, enter S next to PROG. The Programs panel displays.
Since you have many programs in the CICS region, you decide to limit the search for the program you want. To limit the search, type V on the action bar to see the View pull-down menu. Then type S on the menu to use the View Some filter.
Fig 62. View Some Pop-up over Programs Panel

Using View Some, you can filter the contents of the Programs panel to see only the programs you want to view. In this case, you type LARM001 next to the Program ID field of View Some, then press Enter. The filtered Programs panel displays.

Fig 63. Filtered Programs Panel

Now, type S in the Program ID column next to LARM001. The Program Entry panel then displays, giving you detailed information about the selected program.
This panel displays the name of the problem program, LARM001, in its Program ID field. You can see from this panel that LARM001 is being loaded from an RPL dataset called CICSPROD.APPL.LOAD, but you know that this is not the dataset that contains the new version of the program.

To see where CICSPROD.APPL.LOAD is in the RPL concatenation, type **G** in the action bar entry field to select the GoTo pull-down menu. When the menu displays, type **4** to select Datasets Allocated to CICS. The Datasets Allocated to CICS panel displays, showing an overview of datasets allocated to the CICS region.
FIGURE 65. Datasets Allocated to CICS Panel

At this panel, type **RPL** in the Dataset Type field. The Datasets Allocated to CICS panel displays.

FIGURE 66. Datasets Allocated to CICS Panel
In this panel, CICSPROD.APPL.LOAD is shown fourth in the concatenation order. If the new version of the program is in CICSPROD.AR.LOAD or CICSPROD.GL.LOAD, the new version will not be loaded by CICS because it finds the old version in the dataset that was concatenated earlier. With this information available, you can choose to delete the old version from CICSPROD.APPL.LOAD.
CICS Is Not Responding

The Storage status bar on the Region Status panel indicates a critical problem with the Storage component.

FIGURE 67. Region Status with Critical Storage Status Bar

To determine the cause of the problem, type S next to the Storage status bar in the Resources section of Region Status. The CICS Storage panel (for CICS Version 3) displays.
FIGURE 68. CICS Storage Panel

This panel shows that storage is constrained in the DSA. To determine what is causing the constraint, select DSA in the Area column on the panel and navigate to the Storage Allocation by Components panel.
While viewing this panel, you see that task storage is at the critical level. To determine which tasks are using excessive storage, type S in the entry field next to the word Task in the Components column. The Storage Allocation by Tasks panel then displays.
This panel shows that the transaction TAPP is using an excessive amount of storage, possibly due to an application coding error. At this point, you can purge the task and disable the transaction so that the problem can be resolved before the transaction is again invoked.
User Terminal Is Not Responding

You use CICS/ESA Version 4 and above and you would like to know why your terminal has not responded yet. At the Task summary panel, you select the task that corresponds to the user terminal (see the Facility ID column) and navigate to the Task Details panel. The following figure shows the panel.

FIGURE 71. Task Details Panel

At this panel, you see that the task is running, but the task elapsed time is only a few seconds. You also notice that the task attach time is a few minutes ago. You then select the Timings pushbutton on Task Details and navigate to the Task Time Analysis panel for CICS Version 4 and above. The following figure shows this panel.
On this panel you see that the 1st Dispatch Delay interval was a few minutes. You can then look at the first three items in the Wait Time Description column to determine whether the delay was due to a transaction class delay (TCLASS), the system being at the maximum task limit (MXT) or some other delay.
User Terminal Is Not Responding
Introduction

This chapter discusses the Workloads portion of the Region Status panel. Workloads, the amount of work CICS performs on behalf of transactions, can be selected for further information on system performance, or analyzed for CICS problem-solving. The Region Status panel of OMEGAMON II allows you to see details or analyze problems for the following workloads:

- automatic initiate descriptors (AIDs)
- interval control elements (ICEs)
- response times
- tasks
- transaction rates

The following sections discuss the various workloads and their usage in OMEGAMON II.

Chapter Contents

Automatic Initiate Descriptors (AIDs) ........................................... 130
Interval Control Elements (ICEs) ................................................. 135
Response ................................................................. 140
Tasks ................................................................. 145
TranRate (Transaction Rate) .................................................. 154
UOWs ................................................................. 156
Automatic Initiate Descriptors (AIDs)

The Automatic Initiate Descriptors (AIDs) panel displays summary information on all the AIDs in the CICS region. It shows you the work waiting on terminals and remote systems.

The AIDs summary panel allows bottlenecks involving terminals or printers to be identified. For example, a request to start a task connected to a printer appears as an AID when the target printer is not available. If many AIDs have accumulated, response time may be adversely affected because CICS attempts to start each AID on every dispatch of the terminal control program.

The AIDs panels allow you to analyze AIDs problems, display information about a specific AID, or request that an AID be removed from the system.

Select AIDs from the Region Status

By selecting AIDs from the Region Status panel (type $ to show details) you can see a summary of all the AIDs in the CICS region.

The following figure shows the AIDs summary panel.

FIGURE 73. AIDs Summary Panel
**Using the View Pull-down**

Use the View pull-down to filter the contents of the AIDs summary panel by selecting Some. Sort the contents of the panel using one of the following:

- Sort by request ID
- Sort by transaction ID
- Sort by terminal ID
- Sort by terminal status
- Sort by owning system
- Sort by AID type

**Terminating AID(s)**

You can terminate AIDs in your CICS region when they accumulate due to a printer, terminal, or remote connection error. The AIDs component allows you to terminate

- a single AID
- all AIDs for a terminal
- all AIDs for a transaction

*Note:* The action codes used in the following procedures are not case sensitive.

**Terminate a Single AID**

To terminate a single AID, do one of the following:

- On the AIDs summary panel, type K in the entry field next to the AID you want to kill. Then press Enter.
- On the AIDs summary panel, type / next to an AID to see the Actions pull-down. At the Actions pull-down type K or 2 in the entry field. Press Enter.
- On the AID Details panel, type A in the home position to access the Actions pull-down, then type K or 2. Press Enter.

The following Confirm Request pop-up appears when you attempt to kill a single AID. From this window you can either continue processing the request for termination (enter 1 or P), or cancel the request for termination (enter 2 or C).

**FIGURE 74. Kill Confirmation Pop-up for a Single AID**
**Automatic Initiate Descriptors (AIDs)**

**Terminate All AIDs for a Terminal**

To terminate all AIDs for a particular terminal, do one of the following:

- On the AIDs summary panel, type `m` in the entry field next to the AID you want to kill. Press Enter.
- On the AIDs summary panel, type `/` next to an AID and press Enter to see the Actions pull-down. On the Actions pull-down menu, type `m` or `3` in the entry field. Press Enter.
- On the AID Details panel, type `A` in the home position to access the Actions pull-down, then type `m` or `3`. Press Enter.

The following Confirm Request pop-up appears when you attempt to kill multiple AIDs for a terminal. From this window you can either continue processing the request for termination (enter `1` or `P`), or cancel the request for termination (enter `2` or `C`).

**Terminate All AIDs for a Transaction**

To terminate all AIDs for a particular transaction, do one of the following:

- On the AIDs summary panel, type `n` in the entry field next to the AID you want to kill. Then press Enter.
- On the AIDs summary panel, type `/` next to an AID and press Enter to see the Actions pull-down menu. On the Actions pull-down menu, type `n` or `4` in the entry field. Press Enter.
- On the AID Details panel, type `A` in the home position to access the Actions pull-down, then type `n` or `4`. Press Enter.

The following Confirm Request pop-up appears when you attempt to kill multiple AIDs for a transaction. From this window you can either continue processing the request for termination (enter `1` or `P`), or cancel the request for termination (enter `2` or `C`).

---

**FIGURE 75. Kill Confirmation Pop-up for Multiple AIDs (Terminal)**

+------------------------------------------------+
|          KC2CONF     Confirm Request         |
| Confirm kill for all AIDs for terminal LV01 |
| _ 1. Process request |
|  2. Cancel request  |
| F1=Help   F12=Cancel|
+------------------------------------------------+
Automatic Initiate Descriptors (AIDs)

Note: If OMEGAMON II internal security restricts you from accessing the kill facility, a pop-up will appear indicating that you must enter the OMEGAMON II password (via the Options pull-down) to use the facility (see “Enable Authorized Commands” on page 79 for more information).

Select an AID for Details
After viewing the AIDs in the summary panel, you can select a specific AID and gain further information. To do this, enter S in the entry field next to the AID in question.

The following figure shows the AID Details panel.

FIGURE 77. AID Details Panel
The AID Details panel helps you analyze the target terminal so that you can determine why the AID is delayed. On this panel, you can select the following fields:

- Transaction ID
- Supplementary data
- Terminal ID
- Active transaction ID
- TCTTE address
- Task number

For more information on the AIDs panels, see the *OMEGAMON II for CICS Reference Manual*.

**Analyze AIDs Problems from the Region Status**

You can analyze problems for AIDs when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or the default thresholds) have been exceeded. Enter **A** in the entry field next to AID to view the Analyze AID Problems panel, shown in the following figure.

**FIGURE 78. Analyze AID Problems Panel**

```
<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of AIDs</td>
<td>175</td>
<td>100</td>
<td>300</td>
</tr>
</tbody>
</table>
```

This panel does not refresh on entry so you can continue to see conditions that caused a problem on the Region Status panel.

Select the Number of AIDs field to display a list of all AIDs in the system.
Interval Control Elements (ICEs)

Interval control elements (ICEs) represent tasks that CICS is scheduled to start after a specified time interval or at a certain time of day. Upon expiration of this interval, CICS starts the task or creates an AID, pending the availability of some resource.

The ICEs component allows you to identify scheduled work in the system.

Through the ICE panels you can analyze ICE problems, display a summary list of all ICEs in the system, display detailed information about a specific ICE, or request that an ICE be removed from the system.

Select ICEs from the Region Status

By selecting ICEs from the Region Status panel (enter S to show details) you can see a summary of all the ICEs in the CICS region.

The following figure shows the ICEs summary panel.

FIGURE 79. ICEs Summary Panel

Select an ICE in the Request ID column to navigate to the ICE Details panel.

Using the View Pull-down

Use the View pull-down to filter the contents of the ICEs summary panel by selecting Some.
Sort the contents of the panel using one of the following:

- Sort by request ID
- Sort by transaction ID
- Sort by terminal ID
- Sort by expiry time
- Sort by expiry date
- Sort by ICE type
Terminating ICE(s)

You can terminate ICEs in your CICS region when you determine that the scheduled event
should not start. The ICEs component allows you to terminate

- a single ICE
- all ICEs for a particular terminal
- all ICEs for a particular transaction

**Note:** The action codes used in the following procedures are not case sensitive.

**Terminate a Single ICE**

To terminate a single ICE, do one of the following:

- On the ICEs summary panel, type **K** in the entry field next to the ICE you want to kill. Then press Enter.
- On the ICEs summary panel, type / next to an ICE to see the Actions pull-down and press Enter. At the Actions pull-down type **K** or **2** in the entry field. Press Enter.
- On the ICE Details panel, type **A** to access the Actions pull-down, then type **K** or **2**. Press Enter.

The following Confirm Request pop-up appears when you use the Kill ICEs feature for a single ICE. From this window you can either continue processing the request for termination (enter **1** or **P**), or cancel the request for termination (enter **2** or **C**).

**Terminate All ICEs for a Terminal**

To terminate all ICEs for a particular terminal, do one of the following:

- On the ICEs summary panel, type **m** in the entry field next to the ICE you want to kill. Then press Enter.
- On the ICEs summary panel, type / next to an ICE and press Enter to see the Actions pull-down. On the Actions pull-down menu, type **m** or **3** in the entry field. Press Enter.
- On the ICE Details panel, type **A** to access the Actions pull-down, then type **m** or **3**. Press Enter.
The following Confirm Request pop-up appears when you attempt to kill all ICEs for a terminal. From this window you can either continue processing the request for termination (enter 1 or P), or cancel the request for termination (enter 2 or C).

**FIGURE 81. Kill Confirmation Pop-up for Multiple ICEs (Terminal)**

![Image of pop-up window](image)

**Terminate All ICEs for a Transaction**

To terminate all ICEs for a particular transaction, do one of the following:

- On the ICEs summary panel, type n in the entry field next to the ICE you want to kill. Then press Enter.
- On the ICEs summary panel, type / next to an ICE and press Enter to see the Actions pull-down menu. On the Actions pull-down menu, type n or 4 in the entry field. Press Enter.
- On the ICE Details panel, type A in the home position to access the Actions pull-down, then type n or 4. Press Enter.

The following Confirm Request pop-up appears when you attempt to kill all ICEs for a transaction. From this window you can either continue processing the request for termination (enter 1 or P), or cancel the request for termination (enter 2 or C).

**FIGURE 82. Kill Confirmation Pop-up for Multiple ICEs (Transaction)**

![Image of pop-up window](image)

**Note:** If OMEGAMON II internal security restricts you from accessing the kill facility, a pop-up will appear indicating that you must enter the OMEGAMON II password (via the Options pull-down) to use the facility (see “Enable Authorized Commands” on page 79 for more information).
Select an ICE for Details

After viewing the ICEs in the summary panel, you can select a specific ICE and gain further information for problem analysis. To do this, on the summary panel enter S in the entry field of the Request ID column next to the ICE in question.

The following figure shows the ICE Details panel.

**FIGURE 83. ICE Details Panel**

This panel displays detailed information for the selected ICE. For Wait and Post type ICEs, information on the waiting task is also displayed.

On this panel, you can select the following fields:
- Transaction ID
- Terminal ID
- ICE address
- Transaction ID
- Task number

For more information on the ICE panels, see the *OMEGAMON II for CICS Reference Manual*. 
Analyzing ICE Problems from the Region Status

You can analyze problems for ICEs when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to ICE to view the Analyze ICE Problems panel, shown in the following figure.

**FIGURE 84. Analyze ICE Problems Panel**

This panel does not refresh on entry so you can continue to see conditions that caused a problem on the Region Status panel.

Select the Number of ICEs field to display a list of all ICEs in the system.
Response

OMEGAMON II collects, analyzes, and displays CICS response time for predefined groups of transactions, terminals, and programs. It also collects end-to-end response time data for logical unit (LU) groups, when the End-to-End™ (ETE) feature is active.

Response time is the elapsed time difference calculated by subtracting the start time from the end time of a CICS logical unit of work. End-to-end response time is the elapsed time between the user sending a request to CICS and receiving a response at the terminal.

The Response Time component of OMEGAMON II collects response times at the element level for the previous 9 minutes of activity, and also for every time slot defined to OMEGAMON II. This provides the Response Time panels with response time details at the element level and group level for the current minute and last 8 minutes, and for the previous 24-hour period.

To collect and analyze response time data, you may define one or more response time groups and their thresholds, or you can use the predefined groups shipped with OMEGAMON II. You have the option of changing one or more groups and their thresholds permanently or only for the duration of an OMEGAMON II session. See “Defining Response Time Groups for Monitoring” on page 251 for information on changing response time groups for the duration of a session, and the OMEGAMON II for CICS Configuration and Customization Guide for information on changing them permanently.

Select Response from the Region Status

By selecting Response from the Region Status panel (enter S to show details), you display a summary of recent response times in your CICS region.

Response times can only be reviewed when the Response Time collector is active. To display or change the status of the collector, select the Response Time Collection panel, accessible through the Collection Controls item of the Options menu, and turn on collection using the New Subtask Status field. See “Response Time Collection” on page 82 for more information.

The following figure shows the Response Times summary panel.
This summary display includes transaction, terminal, program, and VTAM logical unit groups for the previous 9 minutes of activity in the system. Response time outside of this 9-minute range is included in the Response Time History panel.

Enter S next to a group in the Group Name column to see the Response Time Details panel (see “Select a Response Time Group for Details” on page 142), or enter B next to a group to see the Internal Bottlenecks panel (see “Select a Response Time Group for Bottlenecks” on page 143).

Using the View Pull-down

Use the View pull-down to filter the contents of the Response Times summary panel by selecting Some or Problems. Sort the contents of the panel using one of the following:

- Sort by group name
- Sort by group type
- Sort by current minute

Response Times Pushbutton

The pushbutton at the bottom of the Response Times panel navigates to the Response Time History panel, which shows response times over the previous 24-hour period for the current region.
Select a Response Time Group for Details

After viewing the response times for the current minute through the previous 8 minutes in the Response Times summary panel, you can select a specific group name to analyze the response times for all elements within the group. To do this, enter S in the entry field next to the group name in question, then press Enter. The Response Time Details panel displays, shown in the following figure.

FIGURE 86. Response Time Details Panel

This panel displays response time in seconds for all elements within the specified group that have recorded activity for the last 9 minutes. You can enter an asterisk (*), in the Group Name field to view active elements for all groups.

For transactions, programs, and terminals, OMEGAMON II displays the internal CICS response time. For logical units, OMEGAMON II displays the end-to-end response time.

You can select only transaction and terminal type elements for further detail (the Task History panel displays). Programs and logical units may not be selected.

For more information on the Response panels, see the OMEGAMON II for CICS Reference Manual.

Using the View Pull-down

Use the View pull-down to filter the contents of the Response Time Details panel by selecting Some or Problems. Sort the contents of the panel using one of the following:

- Sort by element ID
- Sort by element type
- Sort by current minute
**Response Time Details Pushbuttons**

Pushbuttons at the bottom of the Response Time Details panel navigate to the panels listed below.

- Internal Bottlenecks
- External Contention

**Select a Response Time Group for Bottlenecks**

In addition to viewing the response time details for a specific group, you can also view the bottlenecks affecting a specific group. To do this, enter B next to a group name in the Group Name column of the Response Times summary panel, then press Enter. The Internal Bottlenecks panel displays.

**FIGURE 87. Internal Bottlenecks Panel**

This panel shows either all of the detected bottlenecks in the target CICS region, or just those impacting the specified group. The bottlenecks are displayed in descending bottleneck ratio order. Most resource types have an associated resource name, which is the name of the resource causing the bottleneck.

You can select a particular resource type on the panel to see bottleneck details by group. The Internal Bottlenecks Details panel displays.

For more information on Internal Bottlenecks, see the *OMEGAMON II for CICS Reference Manual*.
**Using the View Pull-down**

Use the View pull-down to filter the contents of the Internal Bottlenecks panel by selecting Some or Problems. Sort the contents of the panel using one of the following:

- Sort by resource type
- Sort by resource name
- Sort by wait type
- Sort by bottleneck ratio

**Pushbuttons for Internal Bottlenecks**

Pushbuttons at the bottom of Internal Bottlenecks take you to the panels listed below:

- External Contention
- Response Time Details

### Analyze Response Time Problems from Region Status

You can analyze response time problems when the Response status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to Response to view the Analyze Response Time Problems panel, shown in the following figure.

**FIGURE 88. Analyze Response Time Problems Panel**

This panel does not refresh on entry so you can continue to see conditions that caused a problem on the Region Status panel.

Select any group to display its Response Time details.
Tasks

The Tasks component of OMEGAMON II allows you to monitor currently running CICS tasks and see an instantaneous display of system activity. As tasks complete, OMEGAMON II saves pertinent resource usage data for online viewing and batch reporting. (For information on batch reporting, see “Batch Reporting Methods” on page 30.) The statistical information available for analysis is collected both by CICS and OMEGAMON II.

The task analysis panels allow you to display the current workload of a CICS region and how close it is running to capacity, display information about a specific transaction, and request that a task be removed from the system.

Select Tasks from the Region Status

By selecting Tasks from the Region Status panel (type $ to show details) you can see a summary of all the tasks in the CICS region.

The following figure shows the Tasks summary panel.

FIGURE 89. Tasks Summary Panel

Note:

- The % of AMXT field does not appear on the panel for CICS Version 4 and above.
- The CPU Time field is not highlighted for excluded tasks. See the GLOBAL_OPTIONS parameters section in the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.
This panel displays the current workload of the CICS address space and how close it is running to the task limits.

You can select the following fields on this panel:
- Highest % of CMXT
- % of MXT
- % of AMXT (not available in CICS Version 4 and above)
- Task Number

By analyzing the wait resource type and name you may be able to determine the existence and cause of bottlenecks that are degrading performance. For CICS/ESA wait reasons, see the IBM CICS Problem Determination Guide; for additional CICS/ESA wait reasons provided by OMEGAMON II, press F1 to see online help for the Tasks summary panel.

**Using the View Pull-down**

Use the View pull-down to filter the contents of the Tasks summary panel by selecting Some or Problems. Sort the contents of the panel using one of the following:
- Sort by task number
- Sort by transaction ID
- Sort by facility ID
- Sort by CPU time
- Sort by task state
- Sort by resource type
- Sort by resource name

**Terminating Tasks**

You can perform the following actions to terminate tasks:
- Purge task
- Force purge task
- Kill task
- Force kill task

Candle recommends trying the Purge task or Force purge task actions before you try to kill a task. Purge and Force Purge are CICS transactions and the best choices to terminate a task.

**Caution**

You should consider the risks of losing data integrity or terminating CICS when you choose to force purge, kill, or force kill a task. To prevent unauthorized use, OMEGAMON II is shipped with these facilities secured by default. See the OMEGAMON II for CICS Configuration and Customization Guide for more information on authorized commands.
**Purge a Task**

The CICS Purge feature terminates the task you select. Termination occurs only when the system and data integrity can be maintained. You may want to consider purging a task when, for example, a task

- loops
- consumes excessive resources
- holds locks that are preventing other tasks from running
- causes a short-on-storage condition

To terminate a task, do one of the following:

- On the Tasks summary panel, type `P` in the entry field next to the task you want to purge. Then press Enter.
- On the Tasks summary panel, type `/` next to the task to see the Actions pull-down. On the Actions pull-down, type `P` or `2`. Then press Enter.
- On the Task Details panel, type `A` in the home position to access the Actions pull-down, then type `P` or `2`. Press Enter.

When you specify a purge action, a confirmation pop-up window will be presented before the task is purged. From this window, you can either continue processing the request for termination (enter `1` or `P`), or cancel the request for termination (enter `2` or `C`).

![FIGURE 90. Purge Confirmation Pop-up for a Single Task](image)

**Force Purge a Task**

Use the Force purge action to initiate the immediate termination of the selected task, even when it is not certain that system and data integrity can be maintained.

**Important**

If you select this option, data integrity is not guaranteed.
Tasks

To force purge a task, do one of the following:

- On the Tasks summary panel, type O in the entry field next to the task you want to kill. Then press Enter.
- On the Tasks summary panel, type I next to the task to see the Actions pull-down. On the Actions pull-down, type an O or 3. Then press Enter.
- On the Task Details panel, type A in the home position to access the Actions pull-down, then type O or 3. Press Enter.

When you specify a force purge action, a confirmation pop-up window will be presented before the task is purged. From this window, you can either continue processing the request for termination (enter 1 or P), or cancel the request for termination (enter 2 or C).

The following Confirm Request pop-up appears when you specify a force purge action.

FIGURE 91. Force Purge Confirmation Pop-up for a Single Task

+----------------------------------------+
| KC2CONF     Confirm Request            |
| Confirm force purge of task 71 (WORX) |
| – 1. Process Request                   |
|    2. Cancel Request                   |
| F1=Help  F12=Cancel                    |
+----------------------------------------+

Kill a Task

Before killing a task, try using the Purge or Force Purge actions to terminate a task. The CICS Kill feature terminates the task you select. Termination occurs only when the system and data integrity can be maintained.

To kill a task, do one of the following:

- On the Tasks summary panel, type K in the entry field next to the task you want to kill. Then press Enter.
- On the Tasks summary panel, type I next to the task to see the Actions pull-down. On the Actions pull-down, type K or 4. Then press Enter.
- On the Task Details panel, type A in the home position to access the Actions pull-down, then type K or 4. Press Enter.

When you specify a kill action, a confirmation pop-up window will be presented before the task is killed. From this window, you can either continue processing the request for termination (enter 1 or P), or cancel the request for termination (enter 2 or C).

The following Confirm Request pop-up appears when you specify a kill action.
**Force Kill a Task**

Before using force to kill a task, try the Purge, Force Purge, or Kill actions to terminate the task. The Force Kill action initiates the immediate termination of the selected task, even when it is not certain that system and data integrity can be maintained.

**Important**

If you select this option, data integrity is not guaranteed.

To force kill a task, do one of the following:

- On the Tasks summary panel, type `F` in the entry field next to the task you want to kill. Then press Enter.
- On the Tasks summary panel, type `/` next to the task to see the Actions pull-down. On the Actions pull-down, type an `F` or `5`. Then press Enter.
- On the Task Details panel, type `A` in the home position to access the Actions pull-down, then type `F` or `5`. Press Enter.

When you specify a force kill action, a confirmation pop-up window will be presented before the task is killed. From this window, you can either continue processing the request for termination (enter 1 or P), or cancel the request for termination (enter 2 or C).

The following Confirm Request pop-up appears when you specify a force kill action.
Abends Issued After Task Termination

Depending on your release of CICS and what state the task is in, OMEGAMON II issues an OCKC, S0C6, or EIKI abend when a task is purged or killed. OMEGAMON II issues these abends under the conditions listed in the following table.

<table>
<thead>
<tr>
<th>Abend</th>
<th>CICS Version</th>
<th>Task Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCKC</td>
<td>CICS/MVS</td>
<td>Suspended tasks; KCP not waiting</td>
</tr>
<tr>
<td>S0C6</td>
<td>CICS/MVS</td>
<td>Task currently running or KCP waiting on VSAM I/O</td>
</tr>
<tr>
<td>EIKI</td>
<td>CICS/ESA</td>
<td>Tasks waiting, but not in VSAM I/O</td>
</tr>
<tr>
<td>S0C6</td>
<td>CICS/ESA</td>
<td>Currently running task (QR, RO, CO TCB only; the FEPI TCB, ZS, is not checked.)</td>
</tr>
<tr>
<td>--</td>
<td>CICS/ESA</td>
<td>When a task is waiting on file I/O, OMEGAMON II issues a force purge</td>
</tr>
</tbody>
</table>

Select a Task for Details

OMEGAMON II collects detailed task statistics using exit facilities in CICS/MVS. For CICS/ESA, OMEGAMON II uses exit facilities and the CICS Monitoring Facility.

From the Task summary panel, you can select a specific task for further analysis. To do this, enter S in the entry field next to the task number in question and press Enter. The Task Details panel, shown in the following figure, displays.
**FIGURE 94. Task Details Panel**

<table>
<thead>
<tr>
<th>Task number</th>
<th>52___ +</th>
<th>Transaction ID</th>
<th>: BURN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facility ID</td>
<td>M552</td>
<td>CICS transaction ID</td>
<td>: BURN</td>
</tr>
<tr>
<td>Facility type</td>
<td>Term</td>
<td>Originating tran ID</td>
<td>: BURN</td>
</tr>
<tr>
<td>Task state</td>
<td>RUNNING</td>
<td>First CICS program ID : BURNA100</td>
<td></td>
</tr>
<tr>
<td>Task queue</td>
<td>Executbl</td>
<td>Current CICS program ID : BURNA100</td>
<td></td>
</tr>
<tr>
<td>Resource type</td>
<td>RUNNING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resource name</td>
<td>RUNNING</td>
<td>Storage used above 16M : 17K</td>
<td></td>
</tr>
<tr>
<td>Userid</td>
<td>CICSUSER</td>
<td>Storage used below 16M : 2K</td>
<td></td>
</tr>
<tr>
<td>EXEC CICS command</td>
<td>x'100A'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attach time</td>
<td>12:24:16</td>
<td>Purgeable suspend : Yes</td>
<td></td>
</tr>
<tr>
<td>CPU time</td>
<td>2.767s</td>
<td>Purgeable status : No purge</td>
<td></td>
</tr>
<tr>
<td>Task elapsed time</td>
<td>15.771</td>
<td>Suspend timeout due : None</td>
<td></td>
</tr>
<tr>
<td>Time of suspend</td>
<td>16:45:00</td>
<td>Suspend type : Suspend</td>
<td></td>
</tr>
<tr>
<td>Time in suspend</td>
<td>0:00:15</td>
<td>UOW state : Inflight</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The CPU Time field is not highlighted for excluded tasks. See the GLOBAL OPTIONS parameter section in the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.

This panel displays detailed information about a CICS task. You can select the following fields:

- Task number
- Facility ID
- CICS transaction ID
- First CICS program ID
- Current CICS program ID

**Task Details Pushbuttons**

Pushbuttons at the bottom of Task Details take you to the panels listed below.

<table>
<thead>
<tr>
<th>This Pushbutton:</th>
<th>Leads to this Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addresses</td>
<td>Task Addresses</td>
</tr>
<tr>
<td>Files</td>
<td>Task File Statistics</td>
</tr>
<tr>
<td>Remote</td>
<td>Task Remote Information</td>
</tr>
</tbody>
</table>
**Tasks**

<table>
<thead>
<tr>
<th>This Pushbutton:</th>
<th>Leads to this Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistics</td>
<td>Task Statistics Information</td>
</tr>
<tr>
<td>Storage</td>
<td>Task Storage</td>
</tr>
<tr>
<td>Timings</td>
<td>Task Time Analysis</td>
</tr>
<tr>
<td>Umbrella</td>
<td>Task Umbrella Data</td>
</tr>
<tr>
<td><strong>FEPI</strong> (Appears if you use FEPI with CICS)</td>
<td>Front End Programming Interface</td>
</tr>
<tr>
<td><strong>Task Terminal</strong></td>
<td>Task Terminal Statistics</td>
</tr>
</tbody>
</table>

**Note:** *Pushbuttons that allow transplex navigation (for example, GoTo DB2, GoTo DBCTL, and GoTo Remote CICS) appear on the Task Details panel only when the following conditions are met:*

- You are running OMEGAMON II under OMEGAVIEW, with the appropriate level of maintenance.
- For the GoTo DB2 and GoTo DBCTL pushbuttons, the task is currently processing a request in DB2 and DBCTL.

See “Transplex Navigation and Session Switching” on page 289 for more information on transplex navigation.

For more information on the Task panels, see the *OMEGAMON II for CICS Reference Manual*.

**Analyze Task Problems from Region Status**

You can analyze problems for Tasks when the Tasks status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to Tasks to view the Analyze Task Problems panel, shown in the following figure.
FIGURE 95. Analyze Task Problems Panel

This panel does not refresh on entry so you can continue to see conditions that caused a problem on the Region Status panel.

You may select any of the problems listed to display the Tasks panel.
**TranRate (Transaction Rate)**

The transaction rate is a good indicator of CICS system throughput. OMEGAMON II calculates the number of CICS transactions executed per second or per minute, depending on the transaction rate unit you set previously through the Transaction Rate Thresholds panel.

**Select Transaction Rates from Region Status**

By selecting TranRate from the Region Status panel (type S to show details) you can see the total transaction attach rate and individual transaction dispatch rates for the current 1-minute interval.

The following figure shows the Transaction Rates panel.

**FIGURE 96. Transaction Rates Panel**

You can use this panel to monitor the activity level in CICS.

In the figure, the scale on the graph varies depending on the setting of the critical transaction rate high threshold. When you set this threshold in the Transaction Rates Thresholds pop-up, excessive transaction rates are flagged on the Transaction Rates and Region Status panels, and consequently in OMEGAVIEW.

None of the fields on this panel can be selected to navigate to any other panel.

**Transaction Interval**

The transaction rates displayed are not for the minute immediately preceding the last time the panel was updated. Rather, the rates are based on the number of transactions that have been dispatched since the current minute interval began. At the end of the current minute interval, all rate counters are reset to zero and the rates are recalculated.

For transactions that average less than 60 per minute, you may want to change the transaction rate unit setting from per second to per minute. To change the unit setting, press...
F4 on the Transaction Rate Unit field of the Transaction Rates Threshold pop-up to toggle between second and minute, then press Enter.

**Using the View Pull-down**

Use the View pull-down to filter the contents of the Transaction Rates panel by selecting **Some**. Sort the contents of the panel using one of the following:

- Sort by transaction ID
- Sort by transaction rate

**Analyze Transaction Rate Problems from Region Status**

You can analyze problems for Transaction Rate when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter **A** in the entry field next to TranRate to view the Analyze Transaction Rate Problems panel, shown in the following figure.

**FIGURE 97. Analyze Transaction Rate Problems Panel**

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ Transaction rate low</td>
<td>10/s</td>
<td>20/s</td>
<td>5/s</td>
</tr>
<tr>
<td>_ Transaction rate high</td>
<td>300/s</td>
<td>100/s</td>
<td>200/s</td>
</tr>
</tbody>
</table>

_F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print  F15=Region Status_

**Note:** This figure shows all the items that can appear on the panel, and is not a typical panel.

This panel does not refresh on entry so you can continue to see conditions that caused a problem on the Region Status panel.

Select any problem listed to display the Transaction Rates panel.
UOWs

You can access the information available in the CICS recovery manager (CICS/ESA Version 5.1.0). You can inquire about the Unit of Work (UOW) management of a CICS region. OMEGAMON II for CICS displays the workload, UOWs on the Region Status panel, and supplies four thresholds to track and display information about UOWs:

- Shunted UOWs
- Total time UOWs shunted
- Forced heuristic decisions
- Enqueue failures per UOW

You can use the path from the UOWs workload to

- identify shunted UOW problems, analyzing the shunted UOWs and total time UOWs shunted thresholds
- identify UOW enqueue failures
- identify forced heuristic decisions

User authority required

For CUA function level security, the resource `cisname.KC2.MEM.CEMT` controls user authorization for the UOW actions. For menu system security, user authorization for the UOW actions is controlled by restricting access to the CMT command.

Setting thresholds

To reset your UOW threshold settings

- From the Region Status panel, enter L next to the UOWs workload.

Result: The UOW Thresholds panel displays. Modify existing settings as required.

Identifying Shunted UOW Problems

You can display an overview of the recovery manager and all the UOWs in the region that is currently being managed. An authorized user can perform these actions against shunted UOWs:

- Force commit
- Force backout
- Force defined action

If a shunted UOW causes a problem by, for example, holding a lock resulting in enqueue failures, you can use the COMMIT or BACKOUT action to commit or back out the shunted UOW. To force a backout or commit as specified in the transaction definition for the UOW, use the FORCE action.
Analyse UOW Problems  
To access the Analyse UOW Problems panel:

- From the Region Status panel, enter A next to UOW.

**FIGURE 98. Analyse UOW Problems Panel**

List UOWs  
To list UOWs, access the UOWs panel:

- From the Analyse UOW Problems panel, enter S next to Shunted UOWs or Total time UOWs shunted.

**Result:** The UOWs panel, filtered for shunted UOWs and sorted in descending shunt time, is displayed.
FIGURE 99. UOWs Panel Filtered for Shunted UOWs

This panel displays an overview of the Recovery Manager domain and all the UOWs in the region. From this panel, you can:

- Enter **C**, **B**, or **F** next to the UOW ID for which you want to force an action.
- Enter **S** next to the UOW ID for which you want more detail.
- Enter **S** next to the Highest enqueue failures field to display the UOW enqueues panel. Go to “Identifying UOW Enqueue Failures” on page 160 for more information.
- Use the UOW Statistics pushbutton to display UOW statistics. Go to “Identifying Forced Heuristic Decisions” on page 161 for more information about this panel.

**UOW Details**

Action code **S** on the UOWs panel accesses this panel which provides detailed information about a particular UOW known to the recovery manager.
From this panel, you can:

- Use the UOW Enqueues pushbutton, if displayed, to view the UOW Enqueues panel. Go to “Identifying UOW Enqueue Failures” on page 160 for more information.
- Enter S next to UOW address to display the contents of storage at that address.
- Use the UOW Links pushbutton, if displayed, to display information about links. Go to “UOW Links” on page 159 for more information about the UOW Links panel.

**UOW Links**

The UOW Links panel displays a list of other CICS systems or resource managers, when applicable, that are involved in a unit of work. A link is the association between a UOW and a connection to a remote system or resource manager.

To access UOW Links:

- Use the UOW Links pushbutton from the UOW Details panel.

**Result:** If a connection has been discarded, you can delete a link by entering D next to the Link ID.
Identifying UOW Enqueue Failures

You can display information about locks held by a shunted UOW. If the unit of work is shunted in-doubt, all locks are retained. If it is shunted because of a commit or backout failure, only the locks on the failed resources are retained. Retained locks cause other transactions to receive a condition that usually results in an abend (locked response), while other lock conflicts cause the transaction to suspend.

If a shunted UOW causes a problem by, for example, holding a lock resulting in enqueue failures, you can use the COMMIT or BACKOUT action to commit or back out the shunted UOW. To force a backout or commit as specified in the transaction definition for the UOW, use the FORCE action.

UOW Enqueues

To access information about UOW Enqueue failures:

1. From the Region Status panel, enter A next to UOW to display the Analyze UOW Problems panel.
2. Enter S next to the Enq failures problem description.
Identifying Forced Heuristic Decisions

You can display the UOW statistics panel to view statistics for the Recovery Manager domain. This panel provides a summary of the number of times heuristic decisions have been applied to resolve in-doubt UOWs. To prevent data integrity exposures, it is recommended that you avoid forced heuristic decisions, when possible.
**UOW Statistics**

To access UOW Statistics:

1. From the Region Status panel, enter **A** next to **UOW** to display the Analyze UOW Problems panel.
2. From the Analyze UOW Problems panel, enter **S** next to **Forced heuristic decisions**.

**FIGURE 103. UOW Statistics Panel**

This panel displays statistics from the Recovery Manager domain.

For more information about enqueue failures, enter **S** in the input field to display the UOW Enqueues panel.
Introduction

The Resources portion of the Region Status panel lists CICS resources that you can select for further information on system performance. When a status bar indicates a warning or critical condition, you may select it to display a problem analysis panel.

The Resources portion of the panel gives you information such as

- how much CPU time each task is using
- storage usage and storage problems for the CICS region
- response times for DASD
- file usage

The following sections describe each component in the Resources portion of the Region Status panel.

Chapter Contents

- CPU ................................................................. 164
- DASD ............................................................... 167
- DB2 ................................................................. 170
- DBCTL ............................................................. 173
- DL/I ................................................................. 175
- Files ................................................................. 177
- Journals ............................................................ 182
- Local Shared Resources (LSR) ............................... 189
- MRO/ISC .......................................................... 192
- Paging ............................................................... 195
- Storage ............................................................. 197
- Tapes ................................................................. 201
- TempStor (Temporary Storage) ............................... 204
- TranData (Transient Data) .................................... 208
- Web Interface .................................................... 213
- TCP/IP Socket Activity ....................................... 214
Selecting CPU from the Region Status panel (enter S to show details) displays the CPU Rates panel, which shows the CPU consumption for all tasks. The following figure shows the panel.

**FIGURE 104. CPU Rates Panel**

- The CPU Time field is not highlighted for excluded tasks. See the GLOBAL_OPTIONS parameter section in the OMEGAMON II for CICS Configuration and Customization Guide for information on excluding tasks.

**See CPU Usage for the CICS Region**

The CPU Rates panel shows current CPU usage for this CICS region. At the top, you can see task control block (TCB) usage, system request block (SRB) usage, and current overall CPU usage for the region (TCB and SRB added together). Current tasks are listed in descending CPU time order. For each task, you can see the task number, transaction ID, and CPU usage.

This panel allows you to identify those tasks using excessive or unusually high amounts of CPU time and which may possibly be looping. If a CICS region is using excessive CPU, the tasks are displayed in descending order of CPU usage.
CPU

CPU Rates Pushbuttons

Pushbuttons at the bottom of CPU Rates navigate to the following panels:

<table>
<thead>
<tr>
<th>This Pushbutton:</th>
<th>Leads to This Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paging</td>
<td>Working Set Size and Paging Rates</td>
</tr>
<tr>
<td>ASID</td>
<td>CICS Address Space Information</td>
</tr>
<tr>
<td>Job</td>
<td>CICS Job Information</td>
</tr>
<tr>
<td>TCBs</td>
<td>CICS Address Space TCBs</td>
</tr>
<tr>
<td>Modules</td>
<td>MVS Loaded Modules</td>
</tr>
<tr>
<td>MVS Resources</td>
<td>MVS Resources</td>
</tr>
<tr>
<td>XRF</td>
<td>XRF Information</td>
</tr>
</tbody>
</table>

For more information on each of the above panels, see the OMEGAMON II for CICS Reference Manual.

Select a Task for Details

You may obtain details of any task by selecting the appropriate Task Number field on the CPU Rates panel. The Task Details panel displays.

At the Task Details panel, you can purge a task that you suspect is looping. See “Terminating Tasks” on page 146 for procedure on how to do this.

For more information on all the CPU panels, see the OMEGAMON II for CICS Reference Manual.

Analyze CPU Problems from the Region Status

You can analyze problems concerning CPU usage when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to CPU to view the Analyze CPU Problems panel, shown in the following figure.
This panel does not refresh on entry so you can continue to see conditions that caused a problem on the Region Status panel.

Select any problem to display the CPU Rates panel.
By selecting DASD from the Region Status panel (enter **S** to show details), you display the CICS DASD Performance panel.

**See How Devices Respond to CICS Demands**

On the CICS DASD Performance panel, you can obtain information about DASD devices allocated to CICS. You can use this information to observe how devices respond to the demands of CICS as it competes with the rest of the jobs in the system. The panel that displays after you select DASD is shown in the following figure.

**FIGURE 106. CICS DASD Performance Panel**

This panel lists DASD devices by volume in descending response time order. The response time is measured in milliseconds. The panel also displays the percent-busy measurement (in graphical form) for each device. The number of CICS DASDs that are dropped ready or that are not responding are also included. You can get more information for CICS DASDs that are dropped ready or not responding by entering **S** next to the fields in the top box of the panel. The CICS DASD Status panel then displays.

**Using the View Pull-down**

You can filter the contents of the CICS DASD Performance panel by selecting **Some** or **Problems** on the View pull-down menu. Sort the panel using the following selections:

- sort by devices
- sort by volume
- sort by response time
- sort by percent busy
CICS DASD Performance Pushbuttons

Pushbuttons available at the bottom of the CICS DASD Performance panel are listed below.

<table>
<thead>
<tr>
<th>This Pushbutton:</th>
<th>Leads to This Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Rate</td>
<td>DASD I/O Rate</td>
</tr>
<tr>
<td>Statistics</td>
<td>DASD Statistics</td>
</tr>
</tbody>
</table>

Select a Device for Details

To see more information for a particular device, enter S next to an item listed in the Device column on the CICS DASD Performance panel. Doing this navigates to the DASD Details for a Device panel, which allows you to see a breakdown of DASD response time. By pressing F4 at either the Device or Volume field on this panel, you can see a list of devices or volumes from which to select.

Note: If both the Device and Volume fields are entered and there is a discrepancy, Device takes precedence over Volume.

The following figure shows the DASD Details for a Device panel.

FIGURE 107. DASD Details for a Device Panel

Entering S in the CICS Open DCBs field on the DASD Details for a Device panel navigates to the CICS Datasets on a DASD Volume panel.

For more information on the DASD panels, see the OMEGAMON II for CICS Reference Manual.
Analyze DASD Problems from the Region Status

You can analyze DASD problems when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to DASD to view the Analyze DASD Problems panel, shown in the following figure.

FIGURE 108. Analyze DASD Problems Panel

This panel does not refresh on entry so you can continue to see conditions that caused a problem on the Region Status panel.

Selecting Unit Not Responding and DASD Dropped Ready problems will display the CICS DASD Status panel. Selecting Response Time and DASD Busy problems will display the DASD Details panel for the device.
By selecting DB2 from the Region Status panel (enter S to show details), you display the DB2 Activity panel.

**Determine the DB2 Attachment Status and See Transaction Statistics**

On the DB2 Activity panel, you can learn the current status of the DB2 attachment to the CICS region and see statistical information for transactions that are currently accessing DB2 databases. The following figure shows the panel that displays.

**FIGURE 109. DB2 Activity Panel**

On this panel, you can select the following fields:

- Active MVS subtasks
- All the error messages destinations
- Statistics destination

For information on each field and on all DB2 panels, see the *OMEGAMON II for CICS Reference Manual*. 
Using the View Pull-down

Use the View pull-down to filter the contents of the DB2 Activity panel by selecting Some or Problems. Sort the contents of the panel using one of the following selections:

- Sort by transaction ID
- Sort by number of calls
- Sort by % of waits
- Sort by % of aborts
- Sort by max. active threads
- Sort by % threads used HWM
- Sort by % threads in use

Select a Transaction for Details

Each field in the Tran ID column on the DB2 Activity panel is selectable and navigates to the DB2 Transaction Details panel. The following figure shows that panel.

FIGURE 110. DB2 Transaction Details Panel

This panel shows details for a specific transaction. None of the fields on the panel is selectable. You can, however, overtype the Transaction ID field. Press F4 at the field to see a list of the available IDs.
**Analyze DB2 Problems from the Region Status**

You can analyze problems for DB2 when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to DB2 to view the Analyze DB2 Problems panel, shown in the following figure.

**FIGURE 111. Analyze DB2 Problems Pane**

This panel does not refresh on entry so you can continue to see conditions that caused a problem on the Region Status panel.

Select any problem listed on this panel to see the DB2 Transaction Details panel.
DBCTL

By selecting DBCTL on the Region Status panel (enter S to show details), you can see the DBCTL Activity panel.

Monitor DBCTL Activity

Through the panel you can see the status of the DBCTL attachment to the CICS region. The DBCTL Activity panel also identifies the DBCTL address space. The following figure shows the panel.

FIGURE 112. DBCTL Activity Panel

None of the fields in the panel is selectable. You can set thresholds for only one field, DBCTL interface status.

For more information on the DBCTL panels, see the OMEGAMON II for CICS Reference Manual.

Analyze DBCTL Problems from the Region Status

You can analyze problems for DBCTL when the status bar indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to DBCTL to view the Analyze DBCTL Problems panel, shown in the following figure.
This panel does not refresh on entry so you can continue to see conditions that caused a problem on the Region Status panel.

After viewing the problems listed on the panel, you can further analyze a particular problem by selecting it (enter $S$ next to it.)
Selecting DL/I on the Region Status panel (enter S to show details) allows you to see the DL/I Activity panel.

Monitor DL/I Activity

Through the DL/I Activity panel, you can see information about local DL/I activity, including resource usage within the three IMS pool types: DMB, PSB, and ENQ. You can also see statistics on thread usage. The following figure shows the panel.

FIGURE 114. DL/I Activity Panel

For more information on the DL/I panels, see the OMEGAMON II for CICS Reference Manual.
DL/I Pushbuttons

Pushbuttons at the bottom of the DL/I Activity panel take you to the panels listed below.

<table>
<thead>
<tr>
<th>This Pushbutton:</th>
<th>Leads to This Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>DL/I Tasks</td>
<td>CICS Tasks Using DL/I</td>
</tr>
<tr>
<td>Config</td>
<td>DL/I Configuration</td>
</tr>
<tr>
<td>Buffers</td>
<td>DL/I OSAM Buffers</td>
</tr>
<tr>
<td>Addresses</td>
<td>DL/I Interface Addresses</td>
</tr>
<tr>
<td>ECBs</td>
<td>DL/I Interface ECBs</td>
</tr>
<tr>
<td>DBDs</td>
<td>DL/I Databases</td>
</tr>
</tbody>
</table>

Analyze DL/I Problems from the Region Status

You can analyze problems for DL/I when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to DL/I to view the Analyze DL/I Problems panel, shown in the following figure.

FIGURE 115. Analyze DL/I Problems Panel

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

After viewing the problems listed on the panel, you can further analyze a particular problem by selecting it (enter S) next to it.)
Files

By selecting Files on the Region Status panel (enter S to show details), you display the Open VSAM Files panel, which shows a summary of all open VSAM files for the CICS region.

Monitor File Access

File access is often the most significant component of CICS response time and therefore should be monitored and well tuned. See the chapter called “File Analysis,” in the OMEGAMON II for CICS Reference Manual for more information on VSAM files. The following figure shows the Open VSAM Files panel.

FIGURE 116. Open VSAM Files Panel (CICS/ESA Version 4 and earlier)

Data in the last six columns refers to the interval of time ending at “Time of last analysis” for the duration: “Splits/extents interval”.

Using the View Pull-down

Use the View pull-down menu to filter the contents of the Open VSAM Files panel by selecting Some or Problems. Sort the contents of the panel by selecting the following:

- Sort by file ID
- Sort by current string waits
- Sort by % string waits per I/O
- Sort by % current strings in use
- Sort by data CA splits/interval
Files

- Sort by data CI splits/interval
- Sort by data extents/interval
- Sort by index CA splits/interval
- Sort by index CI splits/interval
- Sort by index extents/interval

**Pushbuttons on Open VSAM Files Panel**

Pushbuttons at the bottom of the Open VSAM Files panel take you to the following panels:

**This Pushbutton:**

<table>
<thead>
<tr>
<th>Datasets</th>
<th>Datasets Allocated to CICS</th>
</tr>
</thead>
<tbody>
<tr>
<td>String Waits</td>
<td>VSAM String Waits</td>
</tr>
<tr>
<td>Buffer Waits</td>
<td>LSR Buffer Waits</td>
</tr>
<tr>
<td>LSR</td>
<td>Local Shared Resources Pools</td>
</tr>
</tbody>
</table>

**Select a File for Details**

You can select a particular file ID at this panel to see details for the file. The VSAM Details panel then displays.

**FIGURE 117. VSAM Details Panel**

____ Actions GoTo Index Options Help
--------------------------------------------------------------------------------------------------05/24/93 16:04:59
KC2H06D VSAM Details Region: CICSPROD
Fastpath: =RFV Auto(60)

| DDname . . . . . PAYROLL1 + |
| File organization . . : KSDS |
| Dataset name . . . : TDCICS1.FCTFILE.APPLMIS.CICSPRD.PAYMSTR___ + |
| _ Data component name . : TDCICS1.FCTFILE.APPLMIS.CICSPRD.PAYMSTR.DATA |
| _ Index component name . : TDCICS1.FCTFILE.APPLMIS.CICSPRD.PAYMSTR.INDX |

__ Volume serial number . : OMON35 __ Share control . . . : LSRPOOL5 |
| Creation date . . . : 05/21/93 __ Expiration date . . : None |
| LSR pool act strings HWM: 1 | LSR pool active strings: 0 |
| LSR pool strings . . . : 3 | FCT file . . . . . : Yes |
| Splits/extents interval : 5 min | Time of last analysis. : 12:33:30 |
| Data extents/interval . : 0 | Index extents/interval : 1 |
| Data CA splits/interval : 1 | Index CA splits/intrvl : 0 |
| Data CI splits/interval : 37 | Index CI splits/intrvl : 1 |

(Details) <FCTE> <FCTE Statistics> <FCTE Logging> <FCTE Data Table>
F1=Help F2=Keys F3=Exit F4= Prompt F5=Refresh F6=Console F10=Action Bar
F11=Print F15=Region Status
On this panel, you can overtype data in the DDname and Dataset Name fields. You can navigate to other panels for more information by selecting these fields:

- Data component name
- Index component name
- Volume serial number
- Share control

The fields displayed vary depending on the file organization (that is, on whether it is KSDS, ESDS, or RRDS), and on Share control (LSR or NSR).

See the OMEGamon II for CICS Reference Manual for more information on the Files panels.

### Analyze Files Problems from the Region Status

You can analyze problems for Files when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A. in the entry field next to Files to view the Analyze Files Problems panel, shown in the following figure.

**FIGURE 118. Analyze File Problems Panel**

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Selecting any problem associated with strings will display the Open VSAM Files panel. Any other problem will display the relevant VSAM Details panel.
Monitoring VSAM Record Level Sharing (RLS) Datasets

CICS/ESA Version 5.1.0 supports record level sharing of VSAM datasets between multiple CICS systems. Record level sharing allows multiple CICS systems to concurrently update the same VSAM dataset directly, without the use of a CICS file owning region, with full integrity.

You can display the datasets that have been opened by the monitored CICS region for RLS access and check the activity against those datasets. To access information about RLS datasets:

- From the Region Status panel, enter S next to FILES.

**Result:** The Open VSAM Files panel displays.

**FIGURE 119. Open VSAM Files Panel (CICS/ESA Version 5.1.0)**

From the Open VSAM Files panel you can:

- view the number of RLS timeouts that have occurred during the displayed interval. Information on RLS timeouts is collected on the VSAM analysis interval that appears at the top of the panel.
- select details for any of the files by using S(elect) or the pushbuttons

The count of RLS timeouts is incremented when a request for exclusive control of a record in an RLS dataset fails because the record is already held by another task.
Because multiple CICS regions may be accessing the RLS dataset, it is possible that the task holding the record is running in a CICS region other than the one you are monitoring.

RLS timeouts can indicate an application design problem. If, for example, your application uses a single control record in an RLS dataset, which is updated by every task that runs, and the control record was being held for update for excessive periods of time, you might see the RLS timeouts increasing.

Messages in the CICS log will indicate the task that owns the record causing the RLS timeout. RLS datasets will have strings allocated, beyond the FCT definition, as required to process file requests. This may cause the Current Strings in Use exception to trip, with little perceptible effect on the performance of RLS datasets.
Select **Journals** from the Region Status panel to display the Journals panel if you are using OMEGAMON II for CICS to manage a CICS/ESA Version 5.1.0 region. (The Datasets Allocated to CICS panel are displayed if you are using OMEGAMON II for CICS to manage earlier versions of CICS.)

**View the Journals Panel (CICS/ESA Version 5.1.0)**

The Journals panel displays a summary of the usage and status of the system log and general logs. This panel is shown in the following figure.

**FIGURE 120. Journals Panel (CICS/ESA Version 5.1.0)**

On this panel, an authorized user can enter an action code (E, I, F, or r) in the entry field preceding the journal name to perform the following actions against a journal:

- Enable journal
- Disable journal
- Flush journal
- Reset journal

For CUA function level security, resource *cicsname.KC2.MEM.CEMT* controls user authorization for the actions.

For menu system security, user authorization for the actions is controlled by restricting access to the CMT command.
To see whether a journal has experienced a log stream failure, check the Journal Status column.

You can use the View pull-down to sort the display. See “Sort the Journals Panel Contents” on page 183 for more information.

To see details on a particular journal name, enter S in the Journal Name column and press Enter. The Journal Details panel appears, which is described in the section titled “See Details on a CICS Journal (CICS/ESA Version 5.1.0)” on page 183.

Sort the Journals Panel Contents

To filter the contents of the Journals panel, use the View pull-down menu and select Some or Problems. Sort the contents of the panel by selecting one of the following:

- Sort by journal name
- Sort by journal status
- Sort by system log
- Sort by journal type
- Sort by log stream name

Pushbuttons on the Journals Panel

The following pushbuttons available at the bottom of the Journals panel navigate to a panel of the same name.

<table>
<thead>
<tr>
<th>This Pushbutton</th>
<th>Leads to This Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Streams</td>
<td>Log Streams</td>
</tr>
<tr>
<td>Journal Models</td>
<td>Journal Models</td>
</tr>
</tbody>
</table>

To navigate to these panels, position the cursor on the pushbutton you want and press Enter. See the OMEGAMON II for CICS Reference Manual for details on these panels.

See Details on a CICS Journal (CICS/ESA Version 5.1.0)

To see detailed information on a journal, you can select a specific journal on the Journals panel. The Journal Details panel then appears, as shown in the following figure.
FIGURE 121. Journal Details Panel (CICS/ESA Version 5.1.0)

To see details for a different journal, overtype the Journal Name field, or press F4 to see a list of journal names.

You can see whether or not a journal has experienced a log stream failure in the Journal Status field of this panel. Journal status may be one of the following:

- Ena Conn (Enabled Connected)
- Ena Disc (Enabled Disconnected)
- Disabled
- Failed

View a Summary of Journal Datasets (Prior to CICS/ESA Version 5.1.0)

In CICS versions prior to 5.1.0, the Datasets Allocated to CICS panel displays a summary of the datasets defined to the CICS region. When you navigate to this panel, it is filtered to show only journal datasets.
**FIGURE 122. Datasets Allocated to CICS Panel**

<table>
<thead>
<tr>
<th>DDname</th>
<th>Dataset Name</th>
<th>Volume</th>
<th>Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>_DFHJ01A</td>
<td>TDCICS1.TOC.TDOCS22.DFHJ01A</td>
<td>OMON29</td>
<td>Closed</td>
</tr>
<tr>
<td>_DFHJ01B</td>
<td>TDCICS1.TOC.TDOCS22.DFHJ01B</td>
<td>OMON29</td>
<td>In use</td>
</tr>
<tr>
<td>_DFHJ02A</td>
<td>TDCICS1.TOC.TDOCS22.DFHJ02A</td>
<td>OMON29</td>
<td>In use</td>
</tr>
<tr>
<td>_DFHJ02B</td>
<td>TDCICS1.TOC.TDOCS22.DFHJ02B</td>
<td>OMON30</td>
<td>Closed</td>
</tr>
<tr>
<td>_DFHJ03A</td>
<td>TDCICS1.TOC.TDOCS22.DFHJ03A</td>
<td>OMON29</td>
<td>In use</td>
</tr>
<tr>
<td>_DFHJ03B</td>
<td>TDCICS1.TOC.TDOCS22.DFHJ03B</td>
<td>OMON29</td>
<td>Closed</td>
</tr>
<tr>
<td>_DFHJ04A</td>
<td>TDCICS1.TOC.TDOCS22.DFHJ04A</td>
<td>OMON30</td>
<td>Closed</td>
</tr>
<tr>
<td>_DFHJ04B</td>
<td>TDCICS1.TOC.TDOCS22.DFHJ04B</td>
<td>OMON30</td>
<td>Closed</td>
</tr>
</tbody>
</table>

Note: If you are using CICS/ESA Version 5.1.0, the fast path for this panel is =RFA.

You can overtype the Dataset Type field in the upper portion of the panel. To see a pop-up window containing a list of valid dataset types, press F4. To see all datasets allocated to CICS, enter an asterisk (*) in the field. To navigate to the File Details panel, which is described in the section titled “Select a DDname for Details (Prior to CICS/ESA Version 5.1.0)” on page 186, select a ddname in the lower portion of the panel.

The Attribute column contains the most pertinent information about the file at the time of display. If a file qualifies for more than one attribute, only the first one in the list is displayed. For an explanation of the contents of the Attribute column, see the Dataset Attribute table in the *OMEGAMON II for CICS Reference Manual*.

**Sort the Datasets Allocated to CICS Panel Contents**

To filter the contents of the Datasets Allocated to CICS panel, use the View pull-down menu and select **Some** or **Problems**. Sort the contents of the panel by selecting one of the following:

- Sort by DDname
- Sort by dataset name
- Sort by volume

See “Using the View Pull-down” on page 67 for more information on sorting panel contents.
Pushbuttons on Datasets Allocated to CICS

The pushbuttons available at the bottom of the Datasets Allocated to CICS panel are as follows:

**This Pushbutton:**  
Open VSAM Files  
String Waits  
Buffer Waits  
LSR

**Leads to This Panel:**  
Open VSAM  
VSAM String Waits  
LSR Buffer Waits  
Local Shared Resources (LSR) Pools

To navigate to these panels, position the cursor on the pushbutton you want and press Enter.

See the *OMEGAMON II for CICS Reference Manual* for details on these panels.

Select a DDname for Details (Prior to CICS/ESA Version 5.1.0)

To see the File Details panel, you can select a ddname listed on the Datasets Allocated to CICS panel. An illustration of the File Details panel appears as shown in the following figure.

![File Details Panel](image)

This panel presents detailed information for closed VSAM and non-VSAM datasets. You can overtype both the DDname field (and, if applicable, its concatenation index, +nnn) and the Dataset Name fields. If you overtype both of these fields, the data in the DDname field takes precedence over that in the Dataset Name field.
When you select the Volume Serial field on the panel, OMEGAMON II navigates to the DASD Details for a Device panel.

The Related Information box gives a brief description of the function of the journal dataset displayed within it. One of the following journal dataset attributes is also displayed:

- Closed
- Switch
- In use
- Tapelog
- Waiting

To display detailed information on the journal dataset, enter $S$ in the field. The Journal Control Table Entry panel appears.

**Note:** The Related Information box also displays information for the following types of datasets:

- RPL
- trace

For more information on all the Journals panels, see the *OMEGAMON II for CICS Reference Manual*.

**Analyze Journal Problems from the Region Status**

You can analyze Journal problems when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter $A$ in the entry field next to Journals to view the Analyze Journal Problems panel, as shown in the following figure.

**FIGURE 124. Analyze Journal Problems Panel**

```
---+-------------------------------------+------------+-------------------------+---
| | Problem Description               |   Value    |   Warning     Critical  |
|-------------------------------------+------------+------------+------------|
| _ Journal 04 waiting for WTOR       | On         | On         | Off        |
```

**Note:** This panel is used for CICS/ESA Version 5.1.0 and earlier versions of CICS.
This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

If you are using CICS/ESA Version 5.1.0, this panel displays all the journals that have experienced log stream failure. You can then select a journal to see detailed information. The Journal Details panel appears.

If you are using earlier supported versions of CICS, select any problem listed on the Analyze Journal Problems panel to display a summary of all journal datasets defined to this region. The Datasets Allocated to CICS panel appears.
**Local Shared Resources (LSR)**

By selecting LSR from the Region Status panel (enter S to show details) you display the Local Shared Resources Pools panel.

**See a Summary of LSR Pools Built in CICS**

The Local Shared Resources (LSR) Pools panel shows summary information about current and past usage of LSR pools that have been built in CICS for both VSAM files and local DL/I databases. The panel includes both CICS and VSAM information.

The following figure shows the Local Shared Resources (LSR) Pools panel.

**FIGURE 125. LSR Pools Panel**

The Pool ID column in the panel lists all LSR pools defined to the system, including those not yet built. You can also get more information on Open LSR Files and on Open Files not Using LSR by entering S in the entry fields next to them. After you select either of the fields, the system navigates to the File Control Table (FCT) panel.

**Using the View Pull-down**

Use the View pull-down menu to filter the contents of the panel to see Some or Problems. Sort the contents of the panel using one of the following selections:

- Sort by pool ID
- Sort by open ACBs
- Sort by % active strings
- Sort by tasks waiting
- Sort by successful lookasides
- Sort by buffer reads
- Sort by buffer lookaside ratios

**Pushbuttons on LSR Pools**

Pushbuttons at the bottom of the LSR Pools panel navigate to the panels listed below.

<table>
<thead>
<tr>
<th>This pushbutton:</th>
<th>Leads to this panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open VSAM</td>
<td>Open VSAM Files</td>
</tr>
<tr>
<td>Datasets</td>
<td>Datasets Allocated to CICS</td>
</tr>
<tr>
<td>String Waits</td>
<td>VSAM String Waits</td>
</tr>
<tr>
<td>Buffer Waits</td>
<td>LSR Buffer Waits</td>
</tr>
</tbody>
</table>

**Select a Pool for Details**

You can get more information on a particular pool by entering S next to a pool ID on the LSR Pools panel. The LSR Buffer Pool Details panel then displays. The following figure shows the panel.

**FIGURE 126. LSR Buffer Pool Details Panel**

```
___ Actions GoTo Index Options Help
-------------------------------------------- 05/24/93 12:43:12
LSR Buffer Pool Details Region: CICSPROD
Auto(60)

<table>
<thead>
<tr>
<th>Pool ID . . . . . . . . . 01__+</th>
<th>Pool status . . . . . : Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ Open files for this pool: 1</td>
<td>Location . . . . . . . : &gt;16M</td>
</tr>
<tr>
<td>% active strings . . . : 0%</td>
<td>Tasks waiting . . . : 0</td>
</tr>
<tr>
<td>Total strings . . . : 2</td>
<td>Total string waits . . . : 0</td>
</tr>
<tr>
<td>Current active strings : 0</td>
<td>String waits (HWM) . . . : 0</td>
</tr>
<tr>
<td>Active strings (HWM) : 1</td>
<td>Maximum keylength . . . : 22</td>
</tr>
<tr>
<td>Time pool created . . . : 12:26:03</td>
<td>Time pool deleted . . . : n/a</td>
</tr>
</tbody>
</table>

Buffer Counts

| Data buffers . . . . : n/a | Hiperspace data buffers: n/a |
| Index buffers . . . : n/a  | Hiperspace index buffrs: n/a |
| _ Compound buffers . . . : 17 | _ Hiperspace compound bfs: n/a |
| Total buffers . . . . : 17  | Buffer lookaside ratio : 0%   |
```

F1=Help  F2=Keys  F3=Exit  F4=Prompt  F5=Refresh  F6=Console  F10=Action Bar
F11=Print  F15=Region Status
Local Shared Resources (LSR)

This panel shows detailed information about the selected LSR pool utilization and the buffers belonging to the pool.

Overtypethe Pool ID to select another LSR pool. Press F4 to see a list of available LSR pools. The Open Files for this Pool field is selectable and navigates to the File Control Table (FCT) panel. The Compound Buffers field is selectable and navigates to the LSR Compound Buffers panel.

For more information on all LSR panels, see the OMEGAMON II for CICS Reference Manual.

Analyze LSR Problems from the Region Status

You can analyze LSR problems when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to LSR to view the Analyze LSR Problems panel, shown in the following figure.

FIGURE 127. Analyze LSR Problems Panel

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Select any of the problems listed to display the LSR Buffer Pool Details panel for the desired pool.
By selecting MRO/ISC (multiregion operation/intersystem communication) from the Region Status panel (enter S to show details) you can see the Terminal Control Table System Entries panel. The following figure shows the panel.

**FIGURE 128. Terminal Control Table System Entries Panel**

<table>
<thead>
<tr>
<th>System ID</th>
<th>VTAM Netname</th>
<th>System Status</th>
<th>Connection Type</th>
<th>XLN Status</th>
<th>% Links</th>
<th>Waits for Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>_CICS</td>
<td>TDOCS22</td>
<td>Ins</td>
<td>Local</td>
<td></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>_CS02</td>
<td>TDOCS02</td>
<td>Ins</td>
<td>MRO</td>
<td></td>
<td>5%</td>
<td>0</td>
</tr>
<tr>
<td>_CS23</td>
<td>TDOCS23</td>
<td>Ins</td>
<td>MRO</td>
<td></td>
<td>5%</td>
<td>0</td>
</tr>
<tr>
<td>_CS40</td>
<td>TDOCS40</td>
<td>Rel Ins</td>
<td>LU 6.2</td>
<td>Xnotdone</td>
<td>0%</td>
<td>0</td>
</tr>
<tr>
<td>_CS43</td>
<td>TDOCS43</td>
<td>Ins</td>
<td>MRO</td>
<td></td>
<td>0%</td>
<td>0</td>
</tr>
<tr>
<td>_CS46</td>
<td>TDOCS46</td>
<td>Ins</td>
<td>MRO</td>
<td></td>
<td>0%</td>
<td>0</td>
</tr>
<tr>
<td>_XM30</td>
<td>TDOCS30</td>
<td>Ins</td>
<td>MRO</td>
<td></td>
<td>0%</td>
<td>0</td>
</tr>
<tr>
<td>_XM57</td>
<td>TDOCS57</td>
<td>Ins</td>
<td>MRO</td>
<td></td>
<td>0%</td>
<td>0</td>
</tr>
</tbody>
</table>

**XLN Status**

The XLN Status column indicates whether an Exchange Logname Status exception has occurred or not. This exception is enabled or disabled by entering L before MRO/ISC on the Region Status panel, and indicates that an LU 6.2 connection between two CICS regions has failed.

**See a List of All Remote Systems**

The Terminal Control Table System Entries panel displays a list of all remote systems to which this system has access. The status and type of each connection is displayed with statistics showing current and past availability.

**Using the View Pull-down**

Use the View pull-down to filter the contents of the panel by selecting Some or Problems. Sort the contents of the panel using one of the following selections:

- Sort by system ID
- Sort by VTAM netname
- Sort by system status
- Sort by connection type
- Sort by % links in use
- Sort by waits for links
- Sort by XLN status

**Select a System for Details**

To see more information for a particular system listed in the System ID column on the panel, enter S in the entry field next to the desired ID. The TCT System Entry panel then displays. The following figure shows the panel.

**FIGURE 129. TCT System Entry Panel**

For more information on all panels accessible through MRO/ISC, see the *OMEGAMON II for CICS Reference Manual*.
Analyze MRO/ISC Problems from the Region Status

You can analyze problems for MRO/ISC when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to MRO/ISC to view the Analyze MRO/ISC Problems panel. This panel lists the problems discovered, their current state, and the warning and critical thresholds. The following figure shows the Analyze MRO/ISC Problems panel.

**FIGURE 130. Analyze MRO/ISC Problems Panel**

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>MRO/ISC links to CI23 % in use</td>
<td>8%</td>
<td>75%</td>
<td>90%</td>
</tr>
<tr>
<td>Total waits for links to CS40</td>
<td>20</td>
<td>5</td>
<td>115</td>
</tr>
<tr>
<td>Exchange Logname status</td>
<td>On</td>
<td>On</td>
<td>Off</td>
</tr>
</tbody>
</table>

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Select any problem listed to display details for the connection that has exceeded its threshold.
Paging

By selecting Paging on the Region Status panel (enter S to show details) you display the Working Set Size and Paging Rates panel.

See CICS Address Space Statistics

The Working Set Size and Paging Rates panel presents statistics about the private and common areas of a CICS address space. The following figure shows the panel.

FIGURE 131. Working Set Size and Paging Rates Panel

The paging rate of your region is important because CICS transactions wait until page faults are resolved. Some paging is normal, but excessive paging can cause response time degradation. The type of processor you have determines whether the paging rate is excessive.

If your CICS region is defined in a performance group where storage isolation is in effect, you can see its minimum, maximum, and target working set size values. For more information on working set size, see the IBM MVS Initialization and Tuning Guide and the IBM CICS Performance Guide.
Working Set Size and Paging Rates Pushbuttons

Pushbuttons at the bottom of the panel navigate to the following panels:

<table>
<thead>
<tr>
<th>This Pushbutton:</th>
<th>Leads to this Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>CPU Rates</td>
</tr>
<tr>
<td>ASID</td>
<td>CICS Address Space Information</td>
</tr>
<tr>
<td>Job</td>
<td>CICS Job Information</td>
</tr>
<tr>
<td>TCBs</td>
<td>CICS Address Space TCBs</td>
</tr>
<tr>
<td>Modules</td>
<td>MVS Loaded Modules</td>
</tr>
<tr>
<td>MVS Resource</td>
<td>MVS Resources</td>
</tr>
<tr>
<td>XRF</td>
<td>XRF Information</td>
</tr>
</tbody>
</table>

For more information on the Paging panels, see the OMEGAMON II for CICS Reference Manual.

Analyze Paging Problems from the Region Status

You can analyze Paging problems when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to Paging to view the Analyze Paging Problems panel, shown in the following figure.

FIGURE 132. Analyze Paging Problems Panel

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Selecting a problem on this panel will display the Working Set Size and Paging Rates panel.
By selecting Storage from the Region Status panel (enter S to show details) you display the CICS Storage panel.

See Overview of Storage Usage and Storage Problems

The CICS Storage panel provides overview information about storage usage and storage problems in the CICS region. The following figure shows the panel for CICS Version 4.

FIGURE 133. CICS Storage Panel (CICS Version 4 and above)

This figure shows the panel for a CICS/ESA Version 3.2.1 region.
Different fields display on the CICS Storage panel depending on the version of CICS you use.

For CICS/ESA Version 3.3, there are five distinct DSA areas:

- CDSA
- UDSA
- ECDSA
- EUDSA
- ERDSA

For CICS/ESA Version 4 and above, there are three additional areas:

- RDSA
- SDSA
- ESDSA

For CICS/MVS versions, these additional fields display on the panel:

- Program compressions
- OSCOR requested
- Total GETMAINS above 16M
- Global storage above 16M
- Task storage above 16M

The Storage Violations field is selectable and navigates to the Storage Violations panel. This panel lists all transactions and terminals for which storage violations have been recorded.
The Free OSCOR field is also selectable and navigates to the Address Space Storage panel, which displays a virtual storage map of the CICS address space.

Select a Storage Area for Details

Storage areas listed in the Area column of CICS Storage are selectable. For versions of CICS prior to 4, CICS Storage navigates to the appropriate version of the Storage Allocation by Components panel. This panel displays a summary of storage broken down by component. The following figure shows this panel for CICS/ESA Version 3.

FIGURE 135. Storage Allocation by Components Panel

**Pushbuttons on Storage Allocation by Components.** Pushbuttons at the bottom of the panel navigate as follows:

**This Pushbutton:**

**Leads to this Panel:**

- **PAM**: Page Allocation Map
- **Details**: Storage Details
- **Allocations**: Allocations (CICS/ESA Version 4 and above)

For CICS Version 4 and above, selecting the DSA and EDSA storage areas from CICS Storage causes the panel to navigate to the DSA Storage panel. Selecting any of the storage areas other than DSA or EDSA on this panel causes it to navigate to the Storage Allocation by Components panel.

For more information on the Storage panels, see the *OMEGAMON II for CICS Reference Manual*. 
## Analyze Storage Problems from the Region Status

You can analyze Storage problems when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to Storage to view the Analyze Storage Problems panel, shown in the following figure.

![Analyze Storage Problems Panel](image)

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Selecting any problem listed displays a related panel to assist in further diagnosis of the problem.
Tapes

By selecting Tapes from the Region Status panel (enter S to show details) you display the Tape Drives panel.

See All Online Tape Devices

The Tape Drives panel displays all online tape devices, whether they are allocated to CICS or not. The following figure shows the panel.

FIGURE 137. Tape Drives Pane

The top box in this panel displays information on CICS devices only; the bottom box displays information on all tape devices.

Using the View Pull-down

Use the View pull-down menu to filter the contents of the Tape Drives panel by selecting Some or Problems. Sort the panel using one of the following selections:

- Sort by device
- Sort by volume
- Sort by user
- Sort by status
- Sort by I/Os
- Sort by permanent errors
- Sort by temporary errors
Select a Device for Details

To see more information on a device listed in the Device column of the Tape Drives panel, enter S next to that device. The Tape Drive Details panel then displays, as shown in the following figure.

FIGURE 138. Tape Drive Details Panel

Operators and systems programmers can use these panels to determine which drives are causing delays in CICS due to device errors or to see if an operator needs to intervene. For more information on the Tapes panels, see the OMEGAMON II for CICS Reference Manual.

Analyze Tape Problems from the Region Status

You can analyze problems for Tapes when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to Tapes to view the Analyze Tape Problems panel, shown in the following figure.
FIGURE 139. Analyze Tape Problems Panel

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mount pending on 0B83</td>
<td>On</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>Tape unit 0B82 not responding</td>
<td>On</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>Tape dropped ready at 0B12(1P3492)</td>
<td>On</td>
<td>Off</td>
<td>On</td>
</tr>
</tbody>
</table>

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Selecting any problem listed displays the Tape Drives panel.
TempStor (Temporary Storage)

By selecting TempStor from the Region Status panel (enter S to show details) you display the Temporary Storage panel.

See Status of CICS Temporary Storage

The Temporary Storage panel presents status information about the current use of CICS temporary storage. CICS uses temporary storage for basic mapping support (BMS), diagnostic information review, dynamic log spill, message switching, and MRO/ISC local queuing. Applications use temporary storage for scratchpad, data transfer, and queuing.

Use this panel to determine whether any of your tasks are waiting due to contention for temporary storage resources and to diagnose the cause of the bottleneck.

FIGURE 140. Temporary Storage Panel

Only one field, Tasks Suspended Now, is selectable on this panel. Selecting the field causes the Tasks panel to display with its contents filtered by tasks waiting for temporary storage.

For more information on the Temporary Storage panels, see the OMEGAMON II for CICS Reference Manual.
Push buttons on Temporary Storage

The push buttons at the bottom of the Temporary Storage panel allow you to navigate to the following panels:

<table>
<thead>
<tr>
<th>This Push button:</th>
<th>Leads to this Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queues</td>
<td>Temporary Storage Queues</td>
</tr>
<tr>
<td>Auxiliary</td>
<td>Auxiliary Temporary Storage</td>
</tr>
<tr>
<td>Statistics</td>
<td>Temporary Storage Statistics</td>
</tr>
</tbody>
</table>

Using the Temporary Storage Queues Panel

The Temporary Storage Queues panel displays when you select the Queues push button on the Temporary Storage panel. The following figure shows the panel.

**FIGURE 141. Temporary Storage Queues Panel**

This panel lists all the temporary storage queues that exist in this CICS system. For each queue, information such as the name of the queue, its type (that is, its location), and the number of items in the queue is shown.
Select Character or Hexadecimal Format for the Queue Display

The queue IDs listed on the Temporary Storage Queues panel can be displayed in character or hexadecimal format. You set the format in which the queues display by following these steps:

1. Access the Temporary Storage Thresholds pop-up through the Options pull-down (enter fast path OTRO). Press Enter. The Temporary Storage Thresholds pop-up displays.

2. Move the cursor to the Display Queue ID As field.

3. Press F4 to select either Char or Hex. Press Enter. The Save Region Options pop-up displays.

4. Type S to save the change only for this session; type P to save the change to the region profile. Press Enter.

Deleting Temporary Storage Queues

If you are authorized, you can use this panel to delete queues. (The default security level prohibits users with general authority from deleting temporary storage queues.)

To delete a queue, do one of the following:

1. Type D next to a queue in the Queue ID column. Then press Enter. A confirmation pop-up displays so you can confirm the deletion.

2. Type / next to a queue in the Queue ID column, then press Enter. When the Actions pull-down displays, select Delete Queue, then press Enter. A confirmation pop-up displays so you can confirm the deletion.

Analyze Temporary Storage Problems from the Region Status

You can analyze Temporary Storage problems when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to TempStor to view the Analyze Temporary Storage Problems panel, shown in the following figure.
This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Select any of the problems listed to display the Auxiliary Temporary Storage panel.
TranData (Transient Data)

By selecting TranData from the Region Status panel (enter S to show details) you display the Transient Data panel.

See Capacity and Use Statistics for Dataset

The Transient Data panel displays statistics about the capacity and current use of the CICS Transient Data VSAM dataset, including buffer and string information and the percentage of CIs in use. The following figure shows the panel.

FIGURE 143. Transient Data Panel

CICS uses transient data to build queues of data for later processing, put messages on system queues for printing, initiate tasks based on a queue trigger level, and request logging for recovery.

You can select the four fields in the top box of the panel to get more information. Selecting the Intrapartition Queues or Extrapartition Queues field on the panel navigates to the Destination Control Table (DCT) panel, filtered to display those queues.

Selecting the Queues Over Trigger Level or Queues Over Length Limit fields leads to the Destination Queues Over Limits panel.

You can select the Statistics pushbutton at the bottom of the panel to navigate to the Intrapartition Transient Data Statistics panel.
Deleting Intrapartition Transient Data Queues

If you are authorized, you can delete intrapartition transient data queues when you no longer need them. Deleting them frees upspace in the intrapartition dataset and makes the space available to other queues.

You can delete an indirect queue if the physical queue associated with the indirect queue is of type intrapartition. Similarly, you can delete remote queues if the associated queue is defined as intrapartition in the remote system. If you attempt to delete an indirect or remote queue that is associated with an extrapartition queue, an error message will display explaining that extrapartition queues cannot be deleted.

A queue should be manually deleted when

- it is associated with an out-of-service device
- it was created in error
- records in the queue contain an error as a result of a bug in the application that wrote the records

To delete a queue, do one of the following:

- enter **D** next to an ID with queue type Intra, Indirect, or Remote on the Destination Control Table panel (shown below), then press Enter. A confirmation pop-up displays after you select a queue, so you can confirm the deletion.

- enter / next to an ID with queue type Intra, Indirect, or Remote on the Destination Control Table panel, then press Enter. The Actions pull-down displays so you can select Delete Queue. After you press Enter, a confirmation pop-up displays so you can confirm the deletion.
An authorized user can delete a transient data queue from the detailed panel for a particular queue type by navigating from the Destination Control Table panel to one of the following panels:

- DCT Intrapartition Information
- DCT Indirect Information
- DCT Remote Information panel

Enter A to display the Actions pull-down, then select D (for Delete Queue) to delete the queue displayed on the panel. A confirmation pop-up displays after you select Delete Queue, so you can confirm the deletion.

The following figure shows a detailed panel for the intrapartition queue.
Analyze Transient Data Problems from the Region Status

You can analyze Transient Data problems when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to TranData to view the Analyze Transient Data Problems panel, shown in the following figure.
This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Selecting a problem listed displays either the Transient Data Statistics panel or the DCT Intrapartition Information panel as appropriate.
**Web Interface**

A Web-status light has been added to the Region Status panel allowing you to navigate to the Web Interface panel. Details about Web access are displayed here. The new panel lets you know if the interface is enabled or disabled. If the interface is disabled, the system informs you of this.

The new status light is available in CICS version 5.2 and above.

Following is a sample Web Interface panel.

**FIGURE 147. Web Interface panel**

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**Interface status . . . : Enabled**

**Host IP address . . . : 198.210.51.162**

**Local IP name . . . . : sp13.candle.com**

**Port number . . . . : 3001**

**External security . : None**

**Analyzer name . . . : DFHWBADX**

**CWM userid . . . . : CICSUSER**

**Default userid . . : CICSUSER**

**Trace status . . . : n/a**

**Web anchor block . : 09EF600**

**HTTP global work area : 0046004**

---

**The interface status exists in one of these states:**

- Enabled
- Disabled
- Normal disabled
- Immediate disable
- Not disabled
- Not installed

**The External Security exists in one of these states:**

- N/A
- None
- Enabled

**The Trace Status exists in one of these states:**

- N/A
- Started
- Stopped
TCP/IP Socket Activity

A new status light has been added to the Region Status panel. From this status light, you can see the current status of the TCP/IP Socket Interface. The new status light is based on the following thresholds:

**FIGURE 148. TCP/IP Thresholds**

```
+---------------------------------------------------------------------+
| KC2TCPT            TCP/IP Thresholds                                |
| Type any changes, then press Enter.                                 |
| Performance Measure                                  Warning Critical Monitor + |
| ----------------------------        -------  --------  ---------          |
| TCP/IP user exit not enabled . . .  On +     Off +     No            |
| TCP/IP listener failed . . . . . .  On +     Off +     No            |
| TCP/IP application waitig . . . . .  On +     Off +     No            |
| Frequency of data collection . . .  5 (1-99)                    |
| F1=Help  F4=Prompt  F5=Refresh  F12=Cancel F18=Default           |
+---------------------------------------------------------------------+
```

The new TCP/IP Socket Activity panel displays the details of the TCP/IP connection and the tasks using the TCP/IP sockets user exit.

Following is a sample TCP/IP Socket Activity panel:

**FIGURE 149. TCP/IP Socket Activity**

```
_____    Actions    GoTo    View    Index    Options    Help
------------------------------------------------------------- MM/DD/YY 12:21:04
KC2S01D TCP/IP Sockets Activity Region: CICSPROD
Fastpath: =RT Auto(60)

+-----------------------------------------------------------------------------+
| TCP/IP address space: TCPIP13    | _Global work area    : 0045004   |
| _TRUE module . . . : EZACIC01    | User exit status      : Enabled    |
| Number of listeners : 3          | _Error messages queue: TCPM    |
+-----------------------------------------------------------------------------+

CICS Tasks Using TCP/IP

```
<table>
<thead>
<tr>
<th>Number</th>
<th>Tran</th>
<th>Current</th>
<th>Return</th>
<th>Appl</th>
<th>Listener</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>CSKL</td>
<td>READ</td>
<td></td>
<td>Active</td>
<td>Process</td>
</tr>
<tr>
<td>1</td>
<td>LST2</td>
<td>GIVESOCKET</td>
<td>37</td>
<td>Active</td>
<td>Process</td>
</tr>
<tr>
<td>2</td>
<td>LST3</td>
<td>SELECTX</td>
<td></td>
<td>Waiting</td>
<td>Select</td>
</tr>
<tr>
<td>3</td>
<td>LST4</td>
<td>CONNECT</td>
<td>61</td>
<td>Waiting</td>
<td>Error</td>
</tr>
<tr>
<td>4</td>
<td>TCPT</td>
<td>GETHOSTBYNAME</td>
<td>Active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>AAAB</td>
<td>TAKESOCKET</td>
<td></td>
<td>Active</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
+-----------------------------------------------------------------------------+

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print
F15=Region Status  PA1=Switch
```
Introduction

This chapter describes the facility for monitoring Message Queuing (MQ) for OMEGAMON II for CICS.

The purpose of this facility provides the OMEGAMON II for CICS user with statistics about the MQ activity within a CICS region.

Chapter Contents

Overview ................................................................. 216
CUA Panels for MQ .................................................... 217
Implementing MQ .................................................... 218
MQ Monitoring Functions .......................................... 219
Displaying Application Trace Data for MQ ...................... 226
Resource Limiting of MQ Requests ............................ 228
Overview

The facility provides:

- An MQ status light on the OMEGAMON II for CICS Region Status panel.
- Common User Interface (CUA) panels in OMEGAMON II for CICS, on which the user can display statistics about CICS tasks using MQ.
- CUA panels for specifying MQ monitoring options including:
  - Specifying thresholds for controlling the MQ status light.
  - Specifying how often MQ statistics relating to CICS task activity are collected.
  - Identifying where statistics are stored (the OMEGAMON II for CICS task history collector data store for online task history display and/or System Management Facility (SMF) for batch reporting).
  - Turning MQ statistics collection on and off.

This facility also provides an enhancement to the DATABASE_COLLECTION parameter for specifying MQ monitoring options as an alternative to using the CUA panels in OMEGAMON II for CICS.

Requirements

The MQ status light on the Region Status panel and the CICS-MQ connection statistics panels are available for CICS/ESA Version 3.3 and higher regions. The MQ task history panels with clocks and counters data are available for CICS/ESA Version 4.1 and higher regions.
Panel Availability

The following CUA panels contain the MQ-related information for CICS/ESA, Version 3.1 and higher:

- Region Status
- MQ Thresholds
- MQ Activity
- CICS Tasks using MQ
- MQ Statistics
- API Requests

All of these panels are new with the exception of the Region Status panel.
Implementing MQ

Configuration requirements for MQ

Before you can use MQ, you must perform the following configuration steps

1. Define an event monitoring point (EMP) in the CICS monitoring control table (MCT).
2. Specify a parameter name for MQ in the USER_EVENT_MONITORING parameter.
3. Specify a parameter name for MQ in the DATABASE_COLLECTION parameter.

See the OMEGAMON II for CICS Configuration and Customization Guide for these detailed instructions.

Controlling the collection of MQ file-level statistics

You can control collection of MQ file-level statistics online from the CICS File/Database Collection pop-up. The fastpath to this pop-up shown below is OOF.

FIGURE 150. CICS File/Database Collection pop-up

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Task-level Monitor</th>
<th>File-level Monitor</th>
<th>Write to Data Store</th>
<th>Write to SMF</th>
</tr>
</thead>
<tbody>
<tr>
<td>VSAM</td>
<td>On</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>DB2</td>
<td>On_ +</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>DL/I</td>
<td>On_ +</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>MQ</td>
<td>On_ +</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>ADABAS</td>
<td>Off +</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>DATACOM</td>
<td>Off +</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>IDMS</td>
<td>Off +</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>SUPRA</td>
<td>Off +</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>USREVNT1</td>
<td>On_ +</td>
<td>On_ +</td>
<td>On_ +</td>
<td>Off</td>
</tr>
</tbody>
</table>

F1=Help  F4=Prompt  F5=Refresh  F12=Cancel  F18=Default
MQ Monitoring Functions

Region Status Panel

There are two versions of the OMEGAMON II for CICS Region Status panel with an MQ status light, depending on the version of CICS/ESA you are monitoring:

- One for CICS/ESA Versions 3.3 and 4.1
- One for CICS/ESA Version 5.1 and higher

These panels are shown below and on the following page.

FIGURE 151. Region Status Panel (CICS/ESA Versions 3.3 and 4.1)
Specifying Thresholds for Monitoring MQ Status

Perform the following procedure to specify the thresholds for controlling the behavior of the MQ status light on the Region Status panel:

1. Type action code L in the entry field preceding the MQ resource on the Region Status panel. The MQ Thresholds panel is displayed.
2. On the MQ Thresholds panel, you can take the following actions:

- **Start (Monitor=Yes) or stop (Monitor=No) monitoring the status of the MQ connection.**
- **Specify whether an inactive MQ connection status appears as a warning condition (Warning=On; Critical=Off) or critical condition (Warning=Off; Critical=On) on the MQ status light on the Region Status panel.**
- **Start (Monitor=Yes) or stop (Monitor=No) monitoring the status of busy Task Control Blocks (TCBs).**
- **Specify the number of busy TCBs that cause the MQ status light to signal a warning condition.**
- **Specify the number of busy TCBs that cause the MQ status light to signal a critical condition.**
- **Specify the frequency of data collection (from every 1 to every 99 seconds).**

Refer to the field helps on this panel for a detailed description of the contents of each field.

---

**FIGURE 153. MQ Thresholds Panel**

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>+--------</td>
<td>------</td>
<td>-------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>KC2QMQM</td>
<td>MQ Thresholds</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type any changes, then press Enter.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ Performance Measure</td>
<td>Warning</td>
<td>Critical</td>
<td>Monitor</td>
<td></td>
</tr>
<tr>
<td>MQ connection inactive . . . . . . . off +</td>
<td>On +</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MQ Busy TCBs . . . . . . . . . . . &gt; 6</td>
<td>&gt; 7</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frequency of data collection . . . . 5</td>
<td>(1-99)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F1=Help</td>
<td>F4=Prompt</td>
<td>F5=Refresh</td>
<td>F12=Cancel</td>
<td>F18=Default</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Functions</th>
<th>GoTo</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>+---------</td>
<td>------</td>
<td>-------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>KC2QMQM</td>
<td>MQ Thresholds</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type any changes, then press Enter.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ Performance Measure</td>
<td>Warning</td>
<td>Critical</td>
<td>Monitor</td>
<td></td>
</tr>
<tr>
<td>MQ connection inactive . . . . . . . off +</td>
<td>On +</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MQ Busy TCBs . . . . . . . . . . . &gt; 6</td>
<td>&gt; 7</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frequency of data collection . . . . 5</td>
<td>(1-99)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F1=Help</td>
<td>F4=Prompt</td>
<td>F5=Refresh</td>
<td>F12=Cancel</td>
<td>F18=Default</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Idle</th>
<th>DBCTL</th>
<th>Idle</th>
<th>Storage</th>
<th>OK</th>
<th>Enqueues</th>
<th>Idle</th>
</tr>
</thead>
<tbody>
<tr>
<td>TranRate</td>
<td>Idle</td>
<td>DL/I</td>
<td>Idle</td>
<td>Tapes</td>
<td>Idle</td>
<td>I/O Rate</td>
<td>Idle</td>
</tr>
<tr>
<td>Files</td>
<td>Idle</td>
<td>TempStor</td>
<td>Idle</td>
<td>VTAM ACB</td>
<td>Idle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Journals</td>
<td>Idle</td>
<td>TranData</td>
<td>Idle</td>
<td>XRF</td>
<td>Idle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LSR</td>
<td>Idle</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

F1=Help | F3=Exit | F4=Prompt | F5=Refresh | F6=Console | F10=Action Bar | F11=Print | PA1=Switch |
Displaying Overview Information About Tasks Using MQ

To display overview information about the MQ activity within the region being monitored:

1. Select the entry field preceding the MQ resource entry on the Region Status panel.

The MQ Activity panel is displayed. This panel provides high-level information about the status of the CICS-MQ connection and the number of CICS tasks using MQ.

FIGURE 154. MQ Activity Panel

2. To display information about each CICS Task that is using MQ, select the CICS Tasks using MQ field on the MQ Activity panel and press Enter.

The CICS Tasks using MQ panel is displayed.
3. Place the cursor in the entry field preceding the Task Number and press **Enter** to display the Task Details panel for the selected task.

See the *OMEGAMON II for CICS Reference Manual* for more information about the Task Details and related task panels. Refer to the field helps on each panel for a detailed description of field contents.
Displaying API, Syncpoint, and Recovery Statistics

To display statistics about the number of API requests, syncpoint activity, and recovery activity for CICS tasks using MQ:

1. Select the **Statistics** pushbutton on the MQ Activity panel. The MQ Statistics panel is displayed.

**FIGURE 156. MQ Statistics Panel**

2. To display a breakdown of API requests by request type, select the **API Requests** field on the MQ Statistics panel and press **Enter**. The API Requests pop-up panel is displayed.
<table>
<thead>
<tr>
<th></th>
<th>API requests</th>
<th>Flow calls</th>
<th>MQOPEN requests</th>
<th>MQCLOSE requests</th>
<th>MQGET requests</th>
<th>MQPUT requests</th>
<th>MQPUT1 requests</th>
<th>MQINQ requests</th>
<th>MQSET requests</th>
<th>Miscellaneous requests</th>
<th>F1=Help</th>
<th>F12=Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>4226</td>
<td>4756</td>
<td>1585</td>
<td>528</td>
<td>529</td>
<td>528</td>
<td>0</td>
<td>528</td>
<td>528</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Refer to the field helps on each panel for a detailed description of the contents of each field.
Displaying Application Trace Data for MQ

Introduction

If you are monitoring CICS/ESA Version 4.1 or above, you can collect application trace data for MQ API calls at the task level.

Displaying Application Trace Facility details for MQ tasks

1. On the Task History panel, select an entry for a task that used MQ from the Task End Time column by typing 'T'.

2. Press Enter to display the Application Trace panel for the selected task.

FIGURE 158. Application Trace panel

3. From the Application Trace panel, select a RMIIN or RMIOUT entry in the Trace Type column.

4. Press Enter to display the Application Trace Entry panel for the selected entry.
### FIGURE 159. Application Trace Entry panel

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>----------</td>
<td>------</td>
<td>-------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>11/26/97 11:45:19</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**KC2T52D**

**Application Trace Entry**

**Region: CICSPROD**

**Auto(Off)**

<table>
<thead>
<tr>
<th><strong>Task number</strong></th>
<th><strong>Transaction ID</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>183</td>
<td>AMG3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Time</strong></th>
<th><strong>Function code</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>11:24:00.231469</td>
<td>0082</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Trace type</strong></th>
<th><strong>Command</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>RMIIN</td>
<td>RESOURCE MANAGER</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Program</strong></th>
<th><strong>Resource</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>DKJMQ1</td>
<td>MQM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Offset</strong></th>
<th><strong>Elapsed time</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>988</td>
<td>00:00:00.000045</td>
</tr>
</tbody>
</table>

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F7=Bkwd  F8=Fwd  F10=Action
Bar  F11=Print  F15=Region Status  PA1=Switch
Introduction

If you want to limit the number of MQ API requests that a task can issue, you can use the Resource Limiting feature of OMEGAMON II for CICS. With this feature, you can specify a warning threshold that will result in a message if a task issues more than the specified number of MQ requests. You can also specify a kill limit that will result in an RLMQ abend if a task exceeds the specified threshold.

Specifying thresholds

You specify thresholds in the global data area module using the RESOURCE_LIMITING parameter as follows:

```
RESOURCE_LIMITING ENTRY,RESOURCE=MQ,
LIMIT=(mmmmmmmm,nnnnnnnnn),INCLUDED_TRANS=(aaaa,bbbb)
```

```
RESOURCE_LIMITING ENTRY,RESOURCE=MQ,
LIMIT=(mmmmmmmm,nnnnnnnnn),EXCLUDED_TRANS=(cccc,dddd)
```

where

- `mmmmmmmm` is the kill limit
- `nnnnnnnn` is the warning limit

For further information on the RESOURCE_LIMITING parameter, see the OMEGAMON II for CICS Configuration and Customization Guide for Version 520 in the Global Data Area Module chapter.

**Note:** You can also specify resource limits dynamically from the Resource Limits panel in the CUA interface (fastpath OOLL).
Introduction

This chapter describes the Alerts portion of the Region Status panel. Alerts allow you to anticipate problems and to take corrective action or preventative measures before problems become critical.

Alerts may be raised for the following reasons:

- Bottlenecks
- CICS loop
- Dumps
- Enqueues
- I/O rate
- VTAM ACB
- XRF

Chapter Contents

Bottlenecks ................................................................. 230
CICS Loop (CICS Time-of-Day Clock) ................................ 234
Dumps ................................................................. 236
Enqueues .......................................................... 238
I/O Rate .......................................................... 241
VTAM ACB ....................................................... 245
XRF (Extended Recovery Facility) ................................ 247
Bottlenecks

By selecting Bottlenecks from the Region Status panel (type `S` to show details) you see the Internal Bottlenecks panel.

See a Summary of Bottlenecks in the CICS Region

The Internal Bottlenecks panel displays a summary of all the detected bottlenecks in the CICS region, sorted in descending order of bottleneck ratio for each category of resource type.

If multiple bottlenecks exist for a given resource type with different resource names, the total ratio for the resource type is displayed with a resource name of "TOTAL", followed by the ratios for all bottlenecks belonging to the category listed in descending order.

The following figure shows the panel.

FIGURE 160. Internal Bottlenecks Panel

Since waiting for resources to become available, or events to complete, can have a significant impact on response time, you should identify which resources are responsible for these waits in order to minimize response time.

A group name can be entered in the Group Name field. The resulting panel will list only those bottlenecks impacting elements belonging to the group. Press F4 to see a list of valid names for the field. You can also enter an asterisk (*) in the field to display contention for all transactions. For information on defining groups, see "Defining Response Time Groups for Monitoring" on page 251.
For more information on the Bottlenecks panels, see the OMEGAMON II for CICS Reference Manual.

**Using the View Pull-down**

Use the View pull-down to filter the contents of the Internal Bottlenecks panel by selecting **Some** or **Problems** for all groups or for a particular group. Sort the panel contents using the following selections:

- Sort by resource type
- Sort by resource name
- Sort by wait type
- Sort by bottleneck ratio

**Internal Bottlenecks Pushbuttons**

The pushbuttons at the bottom of the panel allow you to navigate to the following panels:

<table>
<thead>
<tr>
<th>This Pushbutton:</th>
<th>Leads to this Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Contention</td>
<td>External Contention</td>
</tr>
<tr>
<td>Response Time</td>
<td>Response Time Details</td>
</tr>
</tbody>
</table>

**Select a Resource Type for Details**

To see details for a particular resource type listed in the Resource Type field of the Internal Bottlenecks panel, enter **S** in the entry field. The Internal Bottleneck Details panel then displays.
This panel shows how demand for a particular resource type is affecting the groups you have defined.

**Analyze Bottleneck Problems from the Region Status**

You can analyze problems for Bottlenecks when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to Bottlenecks to view the Analyze Bottleneck Problems panel, shown in the following figure.
FIGURE 162. Analyze Bottleneck Problems Panel

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Select a problem to display the Internal Bottleneck Details panel.
CICS Loop (CICS Time-of-Day Clock)

By selecting CICSloop from the Region Status panel (enter S to show details) you display the Common System Area (CSA) panel.

Check the CICS Time-of-Day Clock

Use the CICS time-of-day field on the CSA panel to check the status of the CICS time-of-day clock. When this clock is not being updated, the CICS dispatcher is not getting control. This condition may be caused by a looping task.

This panel also presents some general highlights of the CSA control block, and is a gateway for further information through its selectable fields. The following figure shows the panel.

FIGURE 163. CSA Panel

The top part of the panel displays status information on CICS and the bottom part displays control block and module addresses. You can select the following fields from this panel:

- Current tasks
- System at MXT limit
- System at CMXT limit
- System short-on-storage
- Any control block address

For more information on the CSA panels, see the OMEGAMON II for CICS Reference Manual.
Analyze CICS Loop Problems from the Region Status

You can analyze CICS loop problems when the CICS loop status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to CICSloop to view the Analyze CICS Loop Problems panel, shown in the following figure.

FIGURE 164. Analyze CICS Loop Problems Panel

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Select the listed problem to display the Common System Area (CSA) panel.
Dumps

By selecting Dumps from the Region Status panel (enter S to show details) you display the Dumps summary panel.

See the Status of Dump Datasets

The Dumps summary panel shows the current state of the Dump datasets and the Dump history by dump code. The following figure shows the panel (this example is for CICS/ESA only).

FIGURE 165. Dumps Panel

The selectable fields on this panel are Anchor Address, which navigates to the CICS Memory panel, and Current Extent DFHDMPx, which navigates to the File Details panel.

For more information on the Dumps panels, see the OMEGAMON II for CICS Reference Manual.

Using the View Pull-down

Use the View pull-down menu to filter the contents of the panel by selecting Some. Sort the contents of the panel using one of these selections:

- Sort by dump code
- Sort by dump type
- Sort by max allowed
Analyze Dump Problems from the Region Status

You can analyze problems for Dumps when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to the alert to go to the Analyze Dumps Problems panel, shown in the following figure.

FIGURE 166. Analyze Dump Problems Panel

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Select any problem to display the Dumps panel.
Enqueues

By selecting Enqueues on the Region Status panel (enter S to show details) you display the Enqueues panel.

See Current Enqueues in the CICS Region

The Enqueues panel shows all current enqueues in the region, information on the owning task, and how many, if any, other tasks are waiting for the same enqueue resource. This panel focuses on all enqueues in CICS, including those that may not be causing any conflicts.

The Number of Enqueue Conflicts field displays the total number of tasks waiting to enqueue on any resource. Select the Conflicts pushbutton to display these tasks.

FIGURE 167. Enqueues Pane

Selectable Fields on Enqueues

Selectable fields on this panel are as follows:

- **Enqueue Resource**: Navigates to the Enqueue Details panel
- **Owning Task No.**: Navigates to the Task Details panel

Using the View Pull-down

Use the View pull-down menu to filter the contents of the panel by selecting Some or Problems. Sort the panel contents using one of the following selections:

- Sort by enqueue resource
- Sort by waiting tasks
- Sort by owning task number
- Sort by owning transaction ID

**Pushbutton on Enqueues**

The pushbutton at the bottom of the panel allows you to navigate as follows:

<table>
<thead>
<tr>
<th>This Pushbutton:</th>
<th>Leads to this Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conflicts</td>
<td>Enqueue Conflicts</td>
</tr>
</tbody>
</table>

**Selecting Details for an Enqueue**

When you select a particular enqueue in the Enqueue Resource column on the Enqueues panel or on the Enqueue Conflicts panel, (enter S), the Enqueue Details panel displays. The following figure shows the panel.

**FIGURE 168. Enqueue Details panel**

This panel shows details for a particular enqueue resource you selected. Two types of enqueue resources can be displayed in the top portion of this panel: a variable-length resource name or a fixed four-byte address. The resource name is displayed in both character and hexadecimal format. For address enqueue resources, the resource name is displayed as an address only.

For more information on all the Enqueues panels, see the *OMEGAMON II for CICS Reference Manual*. 
Analyze Enqueue Problems from the Region Status

You can analyze problems for Enqueues when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to Enqueues to view them Analyze Enqueues Problems panel, shown in the following figure.

FIGURE 169. Analyze Enqueue Problems Panel

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tasks waiting for enqueue ENQWAIT</td>
<td>1</td>
<td>0</td>
<td>3</td>
</tr>
</tbody>
</table>

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Selecting problems listed on this panel will display either the Enqueue Details panel or the Enqueue Conflicts panel, depending on the problem.
I/O Rate

By selecting I/O Rate from the Region Status panel (enter S to show details) you display the DASD I/O Rate panel.

See Total and CICS I/O Rates for DASD

The DASD I/O Rate panel shows both the total and CICS I/O rates either for all DASD devices or just for those devices on which CICS datasets are allocated. The following figure shows the DASD I/O Rate panel.

FIGURE 170. DASD I/O Rate Panel

<table>
<thead>
<tr>
<th>Device</th>
<th>Volume</th>
<th>Total I/Os per second</th>
<th>CICS I/Os per second</th>
</tr>
</thead>
<tbody>
<tr>
<td>169</td>
<td>TSO002</td>
<td>18</td>
<td>0</td>
</tr>
<tr>
<td>159</td>
<td>OMON30</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>153</td>
<td>OMON29</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>32A</td>
<td>OMON22</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>30C</td>
<td>PPSMP3</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>31C</td>
<td>OMON23</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>14B</td>
<td>OMON27</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>338</td>
<td>OMON20</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<Performance> (I/O Rate)  <Statistics>
F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  **=Bkwd  F8=Fwd
F10=Action Bar  F11=Print  F15=Region Status
Display All or Allocated Devices
You can choose whether the DASD I/O Rate panel displays all devices or only those on which CICS datasets are allocated using the DASD Thresholds pop-up window. To do so, follow these steps:

1. Select Thresholds from the Options pull-down menu. The Thresholds pop-up window displays.
2. Select Resources. The Resources Thresholds pop-up window displays.
3. Select DASD. The DASD Thresholds pop-up window displays.
4. In the Display Only CICS DASD or All field, select CICS or All by pressing F4 to toggle between the settings. Press Enter. The Save Region Options pop-up displays.
5. Enter 1 to save the change only for this session; enter 2 to save the change to the region profile.

Using the View Pull-down
Use the View pull-down menu to filter the contents of the panel by selecting Some or Problems. Sort the panel contents using one of the following selections:
- Sort by device
- Sort by volume
- Sort by total I/Os per second
- Sort by CICS I/Os per second

DASD I/O Rate Pushbuttons
The pushbuttons on the bottom of the DASD I/O Rate panel navigate as follows:

<table>
<thead>
<tr>
<th>This Pushbutton:</th>
<th>Leads to this Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance</td>
<td>CICS DASD Performance</td>
</tr>
<tr>
<td>Statistics</td>
<td>DASD Statistics</td>
</tr>
</tbody>
</table>

Select a Device for Details
When you select a particular device in the Device column on the DASD I/O Rate panel, the DASD Details for a Device panel displays. This panel gives you more information on the device you selected. The following figure shows the panel.
To see details for a different device, enter the device or volume serial number in the Device and Volume fields on the panel, or press F4 while at either field for a list of devices or volumes. If you enter data into both fields and there is a discrepancy, the Device field takes precedence over the Volume field.

The one selectable field on the panel, CICS open DCBs, navigates to the CICS Datasets on a DASD Volume panel.

For more information on the I/O Rates panels, see the *OMEGAMON II for CICS Reference Manual*. 

---

**FIGURE 171. DASD Details for a Device Panel**

| Device . . . . . . . . . 0156_+ | Volume . . . . . . . OMON30_+ |
| Total open DCBs . . . : 95 | Total I/Os per second : : .6 |
| CICS open DCBs . . . . : 8 | CICS I/Os per second . : 0 |
| I/O queue . . . . . . : 0 | % busy . . . . . . . . : 35% |
| DASD not ready . . . : No | DASD not responding . : No |
| Status . . . . . . . . : Online | Dynam. I/O configuration: Static |
| Type . . . . . . . . . : 3380 | Response time period : 4:13 MN |
| Component | Response 0...............................................60 |
| IOS queue | 20ms|------------------| |
| Pending | 25ms|------------------| |
| Connect | 7ms|------> |
| Disconnect | 25ms|------------------| |
| Total | 79ms|------------------| |

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print  F15=Region Status
Analyze I/O Problems from the Region Status

You can analyze problems for I/O Rate when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to I/O Rate to view the Analyze I/O Rate Problems panel, shown in the following figure.

FIGURE 172. Analyze I/O Problems Panel

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Select the problem listed to display the DASD I/O Rate panel.
VTAM ACB

By selecting VTAM ACB from the Region Status panel (enter S to show details) you display the Terminal Control Table Prefix panel.

See the VTAM ACB Status for the CICS Region

The Terminal Control Table Prefix panel shows the status of the VTAM ACB for this CICS region, options global to CICS terminal control, and information on autoinstall. The following figure shows the panel.

FIGURE 173. Terminal Control Table Prefix (TCTFX) Panel

Selectable fields on this panel are the TCT Address field, which navigates to the CICS Memory panel, and the Exit Program Name field, which navigates to the Program Detail panel.

For more information, see the OMEGAMON II for CICS Reference Manual.

Analyze VTAM Problems from the Region Status

You can analyze problems for VTAM ACB when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter A in the entry field next to VTAM ACB to view the Analyze VTAM ACB Problems panel, shown in the following figure.
This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Selecting the listed problem will display the Terminal Control Table Prefix panel.
**XRF (Extended Recovery Facility)**

By selecting XRF on the Region Status panel (enter S to show details) you display the XRF Information panel.

**Monitor the Status of the Primary and Alternate CICS Regions**

The XRF Information panel shows the status of the primary and alternate CICS regions. XRF provides recovery of a region by having a fully defined alternate region readily available to replace the operation of the failed region. The following figure shows the XRF Information panel.

**FIGURE 175. XRF Information Panel**

This panel contains one selectable field, Control File DSN, which navigates to the File Details panel or the VSAM Details panel, depending on whether the file is closed or open, respectively. The File Details panel is discussed in “Journals” on page 182 the VSAM Details panel is discussed in “Files” on page 177.

To see information about the XRF-related SIT (System Initialization Table) operands, TAKEOVER, ADI and JESDI, type IS on the home position, then press Enter. The Search Index pop-up window displays. Next, type SIT on the Search field, then press Enter. The Search Argument pop-up displays, showing the title of the System Initialization Table panel. Press Enter. The System Initialization Table panel displays.
XRF Information Pushbuttons

The pushbuttons at the bottom of the panel allow you to navigate to the following panels:

<table>
<thead>
<tr>
<th>This Pushbutton</th>
<th>Leads to this Panel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>CPU Rates</td>
</tr>
<tr>
<td>Paging</td>
<td>Working Set Size and Paging Rates</td>
</tr>
<tr>
<td>ASID</td>
<td>CICS Address Space Information</td>
</tr>
<tr>
<td>Job</td>
<td>CICS Job Information</td>
</tr>
<tr>
<td>TCBs</td>
<td>CICS Address Space TCBs</td>
</tr>
<tr>
<td>Modules</td>
<td>MVS Loaded Modules</td>
</tr>
<tr>
<td>MVS Resources</td>
<td>MVS Resources</td>
</tr>
</tbody>
</table>

For more information on the XRF Information panel, see the OMEGAMON II for CICS Reference Manual.

Starting an Alternate CICS Region

You can issue a command at the System Console panel to start the alternate region that has become inactive. Press F6 at the XRF Information panel to display the System Console panel. The following figure shows the panel.
To start the alternate CICS region:

1. Enter a number from 01 through 99 in the Console ID field to specify the console ID to receive the command. Press Enter. If you do not specify a console ID, the ID defaults to the master console.

2. Type the command to start the alternate region on the Command line of the System Console panel. Press Enter.

See the *OMEGAMON II for CICS Reference Manual* for more information on the System Console panel.
Analyze XRF Problems from the Region Status

You can analyze problems for XRF when the status bar on the Region Status panel indicates a warning or critical condition. Either condition indicates that thresholds you set previously (or default thresholds) have been exceeded. Enter **A** in the entry field next to XRF to view the Analyze XRF Problems panel, shown in the following figure.

**FIGURE 177. Analyze XRF Problems Panel**

This panel does not refresh on entry so you can continue to see the conditions that caused a problem on the Region Status panel.

Select the problem to display the XRF Information panel.
Introduction

Defining response time groups allows you to establish logical associations between objects of the same type. Types of objects that can be set up as groups are transactions, programs, terminals, and VTAM logical units (LUs). You may place one or more transactions, programs, terminals or VTAM LUs in a group. But note that each group should contain objects (called elements) of only one type.

Chapter Contents

Importance of Defining Groups ......................................................... 252
How to Use This Chapter ............................................................. 253
Managing Groups ........................................................................... 254
Importance of Defining Groups

OMEGAMON II system components use groups so that you can focus your CICS monitoring efforts on specific sets of resources. A resource for which response time data is required must be described by an element belonging to a group. An element may belong to more than one group. The following OMEGAMON II components use the control blocks and definitions of the Groups feature:

- Internal Bottlenecks
- Task History
- Interval Recorder
- Response Time

Components that support the group structure gather data for the elements (contents) of each group. A maximum of 30 groups and an aggregate maximum of 2048 elements are supported.
How to Use This Chapter

You might find it helpful to use the sections in this chapter as described below.

If You Are Defining New Groups
If you want to define new groups, see these sections of the chapter as needed:

- “Creating a New Group” on page 256.
- “Defining Elements for a Group” on page 258.
- “Adding Elements to One or More Groups” on page 262.

If You Are Modifying Existing Groups
If you want to modify existing groups, see these sections of the chapter as needed:

- “Modifying Groups and Elements” on page 264.
- “Adding Elements to One or More Groups” on page 262.
- “Deleting Groups and Elements” on page 265.
Managing Groups

OMEGAMON II is shipped with predefined groups whose defaults you can change as desired. You can add or delete groups and add or delete elements from groups. Once you create a group, its contents can be displayed and modified.

The Response Time Collector

Before you modify the structure for one or more groups, you must stop the Response Time collector if it is active; otherwise, the change you are attempting to make will not be implemented.

Whenever the Response Time collector is active, the Stop Response Time Collection pop-up displays when you attempt to create or modify groups or elements. If the Response Time collector is inactive, the Stop Response Time Collection pop-up will not display.

OMEGAMON II displays the Stop Response Time Collection pop-up window to allow you to stop the subtask. You can restart the collector through the Start Response Time Collection pop-up window, which is automatically displayed when you exit the Response Time Groups component.

FIGURE 178. Start Response Time Collection Pop-up

```
+-----------------------------------------------------------+
|   KC2QRS       Start Response Time Collection             |
|                                                           |
|   You are exiting the Groups component; the Response      |
|   Time Analysis subtask was stopped while changes were    |
|   made to groups.                                         |
|                                                           |
|   Select one of the following, then press Enter.          |
|                                                           |
|   1  1. Start the Response Time Analysis subtask         |
|       2. Do not start the Response Time Analysis subtask. |
|                                                           |
|   F1=Help    F12=Cancel                                  |
+-----------------------------------------------------------+
```
Managing Groups

**FIGURE 179. Stop Response Time Collection Pop-up**

<table>
<thead>
<tr>
<th>KC2QRP</th>
<th>Stop Response Time Collection</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are attempting to make a change to the groups</td>
<td>and the Response Time Analysis subtask needs to be stopped for the change to be implemented.</td>
</tr>
<tr>
<td>Select one of the following, then press Enter.</td>
<td></td>
</tr>
<tr>
<td>1  1. Stop the Response Time Analysis subtask.</td>
<td>2. Do not stop the Response Time Analysis subtask.</td>
</tr>
<tr>
<td>F1=Help  F12=Cancel</td>
<td></td>
</tr>
</tbody>
</table>

**Duration of Changes**

The changes you make to groups on-line are dynamic and remain in effect only until OMEGAMON II is stopped. To make permanent changes to the group structure, you must assemble and link the group definition parameters into the GLOBAL_OPTIONS module. This is the recommended method. For information on how to do this, see the *OMEGAMON II for CICS Configuration and Customization Guide*.

The following sections describe how to create, modify, copy, and delete groups.
Creating a New Group

You can create (or define) a new group using either of two methods:

- Enter a new group name.
- Copy an existing group.

Enter a New Group Name

Follow these steps to create a group using a new name:

1. From the Options pull-down menu, select Response time groups. Press Enter. The Response Time Groups panel displays.

FIGURE 180. Response Time Groups Panel

2. Type the 1- to 12-character name of the new group on the blank line in the first Group Name column.

   Note: Each group name must be unique. Be sure that the name you enter is different from any group name that exists.

3. Tab to the Type column and enter the group type. Press F4 to select from a list of valid group types. Press Enter. If the Response Time collector is active, the Stop Response Time Collection pop-up window displays. See Figure on page 255.

   Note: If the Response Time collector is inactive, the Elements in a Group panel is displayed instead.
4. Enter 1 to stop the Response Time collector.

   **Note:** *If you do not stop response time collection, a new group will not be created.*

Press Enter. The Elements in a Group panel displays (see “The Elements in a Group Panel” on page 260 for information on this panel).

This panel shows the name of the new group you defined, its group type, and its default warning and critical average response time thresholds. Through this panel you can define elements for this group. See “Defining Elements for a Group” on page 258 for the procedures to follow.

**Copy an Existing Group**

Follow these steps to create a new group by copying from an existing one:

1. On the Response Time Groups panel, type 1 to 12 characters on the blank line in the Group Name column.

   **Note:** *Each group name must be unique. Be sure that the name you enter is different from any group name that exists.*

2. Type C next to the existing group whose attributes and elements you want to copy. Press Enter.

   The attributes of the existing group are copied to the new group name you specified. In addition, the Elements in a Group panel displays so you can define or modify the elements of the group and their thresholds. See “Defining Elements for a Group” on page 258 for the procedures to follow.
Defining Elements for a Group

You can use the Elements in a Group panel to define elements for a group, using either of two methods:

- Enter a new element name.
- Copy from an existing element.

For a description of the Elements in a Group panel, see “The Elements in a Group Panel” on page 260.

Enter a New Element Name

To define a new element name, follow these steps:

1. On the Elements in a Group panel, type a new name on the blank line in the Element column.

   Note: When typing the element name, use up to 4 characters for transaction and terminal elements; use up to 8 characters for programs and LUs.

2. On the blank lines in the Response threshold column, enter a warning value in the range 0.1 to 99.9 seconds. Press Enter.

   The element name and threshold values are added to the Element and Response columns of the panel. If any fields are omitted, OMEGAMON II will assign a default value.

   Note: If you are defining elements for an LU group type, you will also need to enter threshold values, in a range of 0.1-99.9 seconds, in the Network and Host columns.

3. Repeat the steps for each element you want to add to the group. Remember that each element within a single group must be of a single resource type; that is, transaction, terminal, program, or VTAM LU.

Using Wildcard Characters

Elements can also be defined using wildcard characters for all group types except VTAM LU. Wildcard characters allow you to add to the group elements containing common characters (for example, all transactions starting with the letters “AB”). Type AB* to add to the group all transactions starting with “AB”. The wildcard can be used anywhere in the element’s name. For example, to include all transactions with four character IDs that start with “A” and end with “B”, type A**B. To include all four character IDs that end with “AB”, type **AB. The wildcard character needs to be repeated for each position, unless the “*” is the last character when it represents one or more characters.
Copy from an Existing Element

To define an element for a group by copying from an existing element, follow these steps:

1. On the Elements in a Group panel, type a new name on the blank line in the Element column.

2. Type C next to the element you want to copy from. Press Enter. The attributes of the element you selected are copied to the element name you specified. The Element Manipulation panel is displayed.

   Note: When typing the element name, use up to 4 characters for transaction and terminal elements; use up to 8 characters for programs and LUs.

3. On the Element Manipulation panel, you can keep the copied element as it is, or modify it by changing its thresholds. To change its thresholds, simply overtype the threshold values in the Response, Network, or Host columns.

   The new elements you’ve defined for a group you’ve created can be added to one or more additional groups (see “Adding Elements to One or More Groups” on page 262) or deleted from groups (see “Deleting Groups and Elements” on page 265).
The Elements in a Group Panel

In the Elements in a Group panel, you can modify the list of elements, and their thresholds, belonging to a group. If you had selected an existing group from the Response Time Groups panel, existing elements for that group would appear on this panel. The following figure shows the panel.

FIGURE 181. Elements in a Group Panel

This panel displays the average response time thresholds of the group as a whole and all elements belonging to the group with their individual thresholds.

On this panel, an element may be added, copied, modified, or deleted.

**Note:** The Network and Host thresholds apply only to the LU group type.
The following fields appear on this panel.

**Group Name**  
This field displays a group name.  
To display the elements of a different group, you can either overtype the name or press F4 to choose from a list of groups.

**Group Type**  
This field indicates the type of group displayed. The group type can be one of the following:  
Tran (transactions)  
Term (terminals)  
Prog (programs)  
LU (VTAM logical units)

**Warning Average Response Threshold**  
This field allows you to change the average response time warning threshold for the displayed group. The critical threshold is double the warning threshold. This threshold is compared to the actual average response time for all elements within the displayed group.

The warning and critical average response time thresholds are used to determine the color of the fields on the Response Times panel, which shows average response time by group over the last 9 one-minute intervals.

The color of the Curr Minn field on the Response Times panel for the group that has most severely exceeded its thresholds determines the color of the Response status bar on the Region Status panel.

**Element**  
This column displays one or more elements belonging to the group.  
The blank line at the top of the column enables you to add a new element to a group. See “Defining Elements for a Group” on page 258 for procedure on how to do this.

**Response Time Warning Threshold**  
This field allows you to set the response time warning threshold for a particular element. The critical threshold is double the warning threshold.

For groups comprised of programs, transactions, and terminals, response time is the elapsed time between the start and end times of a CICS task. For LU type groups, the response time is the sum of network and host times and is the elapsed time between the user pressing a key (for example, ENTER, F1 through F24, PA1, PA2, PA3 or CLEAR) and receiving a response at the terminal.

**Network Warning Threshold**  
The thresholds in this column apply only to LU group types.  
Network time is the sum of the times that the transaction spends travelling from the terminal to VTAM on the inbound request and from VTAM back to the terminal on the outbound response.

**Host Warning Threshold**  
The thresholds in this column also apply only to LU group types.  
Host time is the time that the request spends travelling from VTAM, through CICS, and back to VTAM.

**Note:** The response, network, and host thresholds determine the color of the response times on the Response Time Details panel, which displays response times for each element of a single group.
Adding Elements to One or More Groups

You can add elements you’ve defined for a group to one or more additional groups.

Add the Elements

Follow these steps to add elements to one or more groups:

1. On the Elements in a Group panel, type M next to the desired element. Press Enter. The Element Manipulation panel displays, showing the current thresholds for the element and a list of groups of the same type, which indicate whether or not the element is already associated with the group. (“Yes” appears in the Element is in this Group column next to the group name.)

2. To add the element to additional groups, type A next to one or more groups in which you want the element to be included. Press Enter. (“Yes” appears in the Element is in this Group column next to the groups you select.)

See the following section for information on the Element Manipulation panel.

The Element Manipulation Panel

The Element Manipulation panel allows you to add the elements you’ve defined for a group to additional groups. The following figure shows the panel.

FIGURE 182. Element Manipulation Panel

<table>
<thead>
<tr>
<th>Group Name</th>
<th>Element is in this group</th>
<th>Average Threshold Warning</th>
<th>Critical</th>
<th>Current Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>_TRAN GRP A*</td>
<td>Yes</td>
<td>&gt; 1.0s</td>
<td>&gt; 2.0s</td>
<td>2</td>
</tr>
<tr>
<td>_TRAN GRP C*</td>
<td>Yes</td>
<td>&gt; 3.1s</td>
<td>&gt; 6.2s</td>
<td>1</td>
</tr>
<tr>
<td>_TRAN GRP Z*</td>
<td>Yes</td>
<td>&gt; 6.0s</td>
<td>&gt; 12.0s</td>
<td>2</td>
</tr>
</tbody>
</table>
The list of groups in the Group Name column shows the groups to which the element belongs. To display a different element, overtype the Element and Type fields and press Enter. The following fields are defined for this panel.

**Element**
This field allows you to change the element being displayed. Overtype the existing name or press F4 for a list of choices.

**Element Type**
This field allows you to change the element type being displayed. Overtype the existing type or press F4 for a list of choices.

**Response Time Warning Threshold**
This field allows you to change the response time warning threshold for a particular element.

The critical threshold is double the warning threshold.

For groups comprised of programs, transactions, and terminals, response time is the elapsed time between the start and end times of a CICS task. For LU type groups, the response time is the sum of network and host times and is the elapsed time between the user pressing a key (for example, Enter, F1 through F24, PA1, PA2, PA3 or Clear) and receiving a response at the terminal.

**Network Warning Threshold**
The thresholds in this column apply only to LU group types.

Network time is the sum of the times that the transaction spends travelling from the terminal to VTAM on the inbound request and from VTAM back to the terminal on the outbound response.

**Host Warning Threshold**
The thresholds in this column also apply only to LU group types.

Host time is the time that the request spends travelling from VTAM, through CICS, and back to VTAM.

**Group Name**
This field allows you to add or delete the displayed element to or from this group.

**Average Response Time Thresholds**
This column displays the average response time thresholds for each group.

These thresholds are used to determine the color of the fields on the Response Times panel, which averages the element response times for each group over the last 9 one-minute intervals. The most critical color in the Curr Min field of the Response Time panel determines the color of the response time status bar on the Region Status panel.

The Response status bar on the Region Status panel uses these thresholds.

**Current Elements**
This column displays the number of elements within a group.
Modifying Groups and Elements

The Response Time Groups component allows you to modify existing groups and the elements associated with them. This section contains the procedures to follow.

Modify a Group
To modify a group (either predefined or user-defined), follow these steps:

1. On the Options pull-down, select Response time groups. Press Enter. The Response Time Groups panel displays.
2. Type M next to a name of a group in the Group Name column. Press Enter. The Elements in a Group panel displays.
3. On the Elements in a Group panel, you can modify a group by
   - modifying the Warning average response time threshold for the group. Simply overtype the threshold in the upper right corner of the panel.
   - defining a new element for the group (see “Defining Elements for a Group” on page 258).
   - deleting an element from the group (see “Deleting Groups and Elements” on page 265).
   - modifying the thresholds for an element that belongs to the group (see “Modify Group Elements” on page 264).

Modify Group Elements
To modify elements for a group, do one of the following:

- On the Response Time Groups panel, type M next to a group and press Enter. When the system navigates to the Elements in a Group panel, overtype the thresholds for one or more elements in the group. Press Enter.
- On the Elements in a Group panel, type M next to an element to be modified. Press Enter. When the system navigates to the Element Manipulation panel, modify the thresholds for the element. Press Enter.

The change you made takes effect for all groups in which the element exists.

Note: The Network and Host thresholds apply only to the LU group type.
Deleting Groups and Elements

You can delete an entire group or just elements from a group. To do so, follow the steps below.

**Delete a Group**

To delete an entire group:

1. On the Response Time Groups panel, type **D** next to the name of the group to be deleted.
2. A confirmation pop-up displays to allow you to confirm the deletion. The following figure shows the pop-up.

![FIGURE 183. Confirm Request to Delete a Group](image)

3. Enter **1** or **P** to confirm the deletion.

**Delete an Element from a Single Group**

To delete an element from a single group, you can delete it from either the Elements in a Group panel or the Element Manipulation panel.
Managing Groups

*Delete an Element Using the Elements in a Group Panel*

To delete an element from a single group using the Elements in a Group panel, follow these steps:

1. Do either of the following:
   - On the Response Time Groups panel, enter M next to a group from which you want to delete an element. Press Enter. The Elements in a Group panel displays.
   - On the Elements in a Group panel, overtype the Group Name field with the name of the group from which you want to delete the element. Press F4 to see a list of valid group names. Press Enter.

2. Type D next to the element to be deleted. A confirmation pop-up window displays to allow you to confirm the deletion. The following figure shows the confirmation pop-up.

![FIGURE 184. Confirm Request to Delete an Element](image)

3. Enter 1 or P to confirm the deletion. Press Enter. The element is deleted from the group.

*Delete an Element Using the Element Manipulation Panel*

To delete an element from a single group using the Element Manipulation panel, follow these steps:

1. In the Element and Type column on the Element Manipulation panel, select the element you want to delete by overtyping the fields. Press F4 to see a list of valid element names and types.

2. Scroll through the groups listed in the Group Name column to see which group contains the element (“Yes” displays next to the group in the Element is in this Group column).

3. Enter D next to the group from which you want to delete the element. Press Enter. A confirmation pop-up window displays to allow you to confirm the deletion.

4. Enter 1 or P to confirm the deletion. Press Enter. The element is deleted from the group.
Delete an Element from Multiple Groups

To delete an element from multiple groups, follow these steps:

1. On the Element Manipulation panel, make sure the element you want to delete is displayed in the Element and Type fields. Press F4 to see a list of valid element names and types.

2. Scroll through the groups listed in the Group Name column to find the first group from which you want to delete the element (“Yes” is displaying next to the group in the Element is in this Group column).

3. Enter D next to each group from which you want to delete the element. Press Enter. A confirmation pop-up window displays to allow you confirm the deletion for each selected group.

4. For each group enter 1 or P to confirm the deletion. Press Enter. The element is deleted from each group in turn.
Introduction

You can use OMEGAVIEW as an alternative method of logging onto OMEGAMON II. In OMEGAVIEW you can select an OMEGAMON II for CICS status light and zoom directly into an OMEGAMON II for CICS session.

When you zoom from OMEGAVIEW, you can automatically navigate to one of several OMEGAMON II screens that analyze or show you more detail about the cause of the problem.

Important

You can use this zoom facility only if you are running OMEGAMON II with OMEGAVIEW Version 110 and OMEGAVIEW PTFs QMV0090 and QSD0020 have been applied.

Chapter Contents

Zooming from OMEGAVIEW to OMEGAMON II ................................................. 270
Zoom Summary Table ................................................................. 271
Default or First Zoom Destination Choice ................................................. 273
Alternate Zoom Destinations .............................................................. 274
Usage Notes ........................................................................... 276
Zooming from OMEGAVIEW to OMEGAMON II

Note: To ensure an acceptable amount of zoom time from OMEGAVIEW to OMEGAMON II, be sure to run the CUA interface (KC2PROC) and the menu system interface (CANSOCnn) on the same system. You can run OMEGAVIEW on any system that you want.

Note: The nn variable in CANSOCnn designates an address space from 00–55 in which to run the started task. For example, CANSOC03 specifies 03 as the address space.

To zoom from OMEGAVIEW to OMEGAMON II, follow these steps:
1. Access OMEGAVIEW. (See the OMEGAVIEW documentation for details.)
2. Type S next to an OMEGAMON II for CICS status light and press Enter.
3. Do either of the following:
   - Select your zoom destination from a menu of zoom destination choices. (The Confirm Zoom to Session pop-up must be enabled.)
   - Zoom directly to a default zoom destination. (The Confirm Zoom to Session pop-up is disabled.)

You will arrive at a selected OMEGAMON II panel as shown in “Default or First Zoom Destination Choice” on page 273 and “Alternate Zoom Destinations” on page 274. You can then navigate within OMEGAMON II as usual.

For more information about procedures within OMEGAVIEW, see the OMEGAVIEW documentation.

To return to OMEGAVIEW at any time, press the OMEGAVIEW trigger that you had defined in OMEGAVIEW.
### OMEGAVIEW to OMEGAMON II for CICS Zoom Summary

The following table presents a summary of the relation between OMEGAVIEW zoom source panels and OMEGAMON II zoom destination panels, when the OMEGAVIEW zoom pop-up is enabled. The first zoom choice is also the default zoom destination, which is used when the zoom pop-up is disabled.

<table>
<thead>
<tr>
<th>OMEGAVIEW Status Light</th>
<th>First Destination Choice</th>
<th>Second Destination Choice</th>
<th>Third Destination Choice</th>
</tr>
</thead>
<tbody>
<tr>
<td>AID Workloads</td>
<td>Analyze AID Problems</td>
<td>Automatic Initiate</td>
<td>Region Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptors (AIDs)</td>
<td></td>
</tr>
<tr>
<td>ICE Workloads</td>
<td>Analyze ICE Problems</td>
<td>Interval Control Elements</td>
<td>Region Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(ICEs)</td>
<td></td>
</tr>
<tr>
<td>Response Time</td>
<td>Analyze Response Time</td>
<td>Response Times</td>
<td>Region Status</td>
</tr>
<tr>
<td>Workloads</td>
<td>Problems</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task Workloads</td>
<td>Analyze Task Problems</td>
<td>Tasks</td>
<td>Region Status</td>
</tr>
<tr>
<td>Transaction Rate</td>
<td>Analyze Transaction Rate</td>
<td>Transaction Rates</td>
<td>Region Status</td>
</tr>
<tr>
<td>Workloads</td>
<td>Problems</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU Resources</td>
<td>Analyze CPU Problems</td>
<td>CPU Rates</td>
<td>Region Status</td>
</tr>
<tr>
<td>DASD Resources</td>
<td>Analyze DASD Problems</td>
<td>CICS DASD Performance</td>
<td>Region Status</td>
</tr>
<tr>
<td>DB2 Resources</td>
<td>Analyze DB2 Problems</td>
<td>DB2 Activity</td>
<td>Region Status</td>
</tr>
<tr>
<td>DBCTL Resources</td>
<td>Analyze DBCTL Problems</td>
<td>DBCTL Activity</td>
<td>Region Status</td>
</tr>
<tr>
<td>DL/I Resources</td>
<td>Analyze DL/I Problems</td>
<td>DL/I Activity</td>
<td>Region Status</td>
</tr>
<tr>
<td>File Resources</td>
<td>Analyze File Problems</td>
<td>Open VSAM Files</td>
<td>Region Status</td>
</tr>
<tr>
<td>Journal Resources</td>
<td>Analyze Journal Problems</td>
<td>Datasets Allocated to</td>
<td>Region Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CICS</td>
<td></td>
</tr>
<tr>
<td>LSR Resources</td>
<td>Analyze LSR Problems</td>
<td>Local Shared Resources</td>
<td>Region Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(LSR)</td>
<td></td>
</tr>
<tr>
<td>MRO/ISC Resources</td>
<td>Analyze MRO/ISC Problems</td>
<td>Terminal Control Table</td>
<td>Region Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>System Entries</td>
<td></td>
</tr>
<tr>
<td>Paging Resources</td>
<td>Analyze Paging Problems</td>
<td>Working Set Size and</td>
<td>Region Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Paging Rates</td>
<td></td>
</tr>
<tr>
<td>Storage Resources</td>
<td>Analyze Storage Problems</td>
<td>CICS Storage</td>
<td>Region Status</td>
</tr>
<tr>
<td>Tape Resources</td>
<td>Analyze Tape Problems</td>
<td>Tape Drives</td>
<td>Region Status</td>
</tr>
<tr>
<td>Temporary Storage</td>
<td>Analyze Temporary</td>
<td>Temporary Storage</td>
<td>Region Status</td>
</tr>
<tr>
<td>Resources</td>
<td>Storage Problems</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transient Data Resources</td>
<td>Analyze Transient Data</td>
<td>Transient Data</td>
<td>Region Status</td>
</tr>
<tr>
<td></td>
<td>Problems</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 1. OMEGAVIEW to OMEGAMON II for CICS Zoom Summary

<table>
<thead>
<tr>
<th>OMEGAVIEW Status Light</th>
<th>First Destination Choice</th>
<th>Second Destination Choice</th>
<th>Third Destination Choice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottleneck Alerts</td>
<td>Analyze Bottleneck Problems</td>
<td>Internal Bottlenecks</td>
<td>Region Status</td>
</tr>
<tr>
<td>CICS Loop Alerts</td>
<td>Analyze CICS Loop Problems</td>
<td>Common System Area (CSA)</td>
<td>Region Status</td>
</tr>
<tr>
<td>Dump Alerts</td>
<td>Analyze Dump Problems</td>
<td>Dumps</td>
<td>Region Status</td>
</tr>
<tr>
<td>Enqueue Alerts</td>
<td>Analyze Enqueue Problems</td>
<td>Enqueues</td>
<td>Region Status</td>
</tr>
<tr>
<td>I/O Rate Alerts</td>
<td>Analyze I/O Problems</td>
<td>DASD I/O Rate</td>
<td>Region Status</td>
</tr>
<tr>
<td>VTAM ACB Alerts</td>
<td>Analyze VTAM Problems</td>
<td>Terminal Control Table Prefix (TCTFX)</td>
<td>Region Status</td>
</tr>
<tr>
<td>XRF Alerts</td>
<td>Analyze XRF Problems</td>
<td>XRF Information</td>
<td>Region Status</td>
</tr>
</tbody>
</table>
Default or First Zoom Destination Choice

This section shows an example of a panel you can zoom to as the default or first zoom destination choice. All the OMEGAMON II Analyze Problem panels are default or first zoom destination choices.

FIGURE 185. Analyze AID Problems Panel

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>Index</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

--- 05/14/93 16:42:31

KC2B02D  Analyze AID Problems  Region: CICSPROD
Auto(60)

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Value</th>
<th>Warning</th>
<th>Critical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of AIDs</td>
<td>175</td>
<td>100</td>
<td>300</td>
</tr>
</tbody>
</table>

F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar  F11=Print
F15=Region Status
Alternate Zoom Destinations

In addition to the default or first zoom destination choice, you have the choice of two other zoom destinations.

Show Details—Second Zoom Choice

The second zoom destination choice for each basic status light is the associated Show Details panel.

For example, when you zoom from the basic File Resources status light and choose the second destination, you will zoom to the Open VSAM Files panel, shown in the following figure. (This Open VSAM Files panel is displayed for all CICS versions prior to CICS/ESA Version 5.1.0.)

FIGURE 186. Open VSAM Files Panel (CICS/ESA Version 4 and earlier)
Region Status - Third Zoom Choice

If you zoom from any basic status light, the third zoom destination choice is the Region Status panel, as shown below. (This Region Status panel is displayed for all CICS versions prior to CICS/ESA Version 5.1.0.)

FIGURE 187. Region Status Panel (prior to CICS/ESA Version 5.1.0)
Usage Notes

The benefit of using OMEGAVIEW is that you can monitor multiple CICS regions at once. You can also zoom directly to an OMEGAMON II CUA interface panel that provides information about the selected OMEGAVIEW status light.

Once you zoom into OMEGAMON II, you can navigate normally within the product. If the zoom destination panel does not provide adequate data to determine what actually caused the status light on the OMEGAVIEW panel to report a warning or critical condition, you can investigate further.

OMEGAMON II saves you time by letting the enhanced zoom feature automatically navigate to the panel most likely to explain the problem.

For more information on the enhanced zoom feature, refer to the OMEGAVIEW documentation.

OMEGAVIEW Customized Panels

In addition to the OMEGAVIEW Default Status panel, if your custom-designed OMEGAVIEW panels include any of the OMEGAMON II for CICS basic status lights, you can zoom from them to the destinations described in “Default or First Zoom Destination Choice” on page 273 and “Alternate Zoom Destinations” on page 274.

For further information on OMEGAVIEW panel customization, see the OMEGAVIEW documentation.
Introduction

The fast path mnemonics contained in this appendix allow you, in many instances, to navigate to a panel directly, rather than through a series of panels, to reach your destination. This appendix also contains mnemonics that let you access items on the Options and Help pull-down menus.

Chapter Contents

- Entering the Fast Path .................................................. 278
- Fast Path Tables ......................................................... 279
Entering the Fast Path

You can enter a fast path mnemonic on any panel that has an action bar.

1. Move the cursor to the home position.

2. Type the fast path character (=) followed by the mnemonic string (for example, =WAA).

   **Note:** You do not need to use the fast path character when entering fast paths to access the Options or Help pull-down menus (fast paths for these menus start with H or O). For example, type HG to access the glossary from the Help pull-down menu.

3. Press Enter.
Fast Path Tables

The panels you can navigate to and their fast path mnemonic strings are arranged alphabetically by panel title in the following tables.

### A

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>HA</td>
</tr>
<tr>
<td>Address Space Information</td>
<td>=RCA</td>
</tr>
<tr>
<td>Address Space Storage</td>
<td>=RSA</td>
</tr>
<tr>
<td>Address Space Task Control Blocks (TCBs)</td>
<td>=RCT</td>
</tr>
<tr>
<td>Address Symbol Definition</td>
<td>=MY</td>
</tr>
<tr>
<td>AIDs (Automatic Initiate Descriptors)</td>
<td>=WA</td>
</tr>
<tr>
<td>AID Details</td>
<td>=WAD</td>
</tr>
<tr>
<td>AIDs Thresholds</td>
<td>OTWA</td>
</tr>
<tr>
<td>Allocations</td>
<td>=RSL</td>
</tr>
<tr>
<td>Authorized Commands—Disable</td>
<td>OCD</td>
</tr>
<tr>
<td>Authorized Commands—Enable</td>
<td>OCE</td>
</tr>
<tr>
<td>Auxiliary Temporary Storage</td>
<td>=ROA</td>
</tr>
</tbody>
</table>

### B

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottlenecks Thresholds</td>
<td>OTAB</td>
</tr>
</tbody>
</table>

### C

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chase Chain</td>
<td>=MC</td>
</tr>
<tr>
<td>CICS Address Space Information</td>
<td>=RCA</td>
</tr>
<tr>
<td>CICS Address Space TCBs</td>
<td>=RCT</td>
</tr>
<tr>
<td>CICS DASD Performance</td>
<td>=RD</td>
</tr>
<tr>
<td>CICS DASD Status</td>
<td>=RDA</td>
</tr>
<tr>
<td>CICS Datasets on a DASD Volume</td>
<td>=RDED</td>
</tr>
<tr>
<td>CICS Dataspaces</td>
<td>=MD</td>
</tr>
<tr>
<td>CICS File/Database Collection</td>
<td>OOF</td>
</tr>
<tr>
<td>CICS Job Information</td>
<td>=RCJ</td>
</tr>
</tbody>
</table>
## Fast Path Tables

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>CICS Loop Threshold</td>
<td>OTAC</td>
</tr>
<tr>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td>CICS Memory</td>
<td>=M</td>
</tr>
<tr>
<td>CICS Shutdown Option</td>
<td>OS</td>
</tr>
<tr>
<td>CICS Storage</td>
<td>=RS</td>
</tr>
<tr>
<td>CICS Storage Thresholds</td>
<td>OTRS</td>
</tr>
<tr>
<td>CICS Tables</td>
<td>=C</td>
</tr>
<tr>
<td>CICS Tasks Using DL/I</td>
<td>=RIK</td>
</tr>
<tr>
<td>Close Print Log</td>
<td>OL</td>
</tr>
<tr>
<td>Common System Area (CSA)</td>
<td>=AC</td>
</tr>
<tr>
<td>CPU Rates</td>
<td>=RC</td>
</tr>
<tr>
<td>CPU Thresholds</td>
<td>OTRC</td>
</tr>
</tbody>
</table>

**D**

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>DASD Details for a Device</td>
<td>=RDE</td>
</tr>
<tr>
<td>DASD I/O Rate</td>
<td>=AI</td>
</tr>
<tr>
<td>DASD Performance</td>
<td>=RD</td>
</tr>
<tr>
<td>DASD Statistics</td>
<td>=RDS</td>
</tr>
<tr>
<td>DASD Status</td>
<td>=RDA</td>
</tr>
<tr>
<td>DASD Thresholds</td>
<td>OTRD</td>
</tr>
<tr>
<td>Datasets Allocated to CICS</td>
<td>=RFA</td>
</tr>
<tr>
<td>Datasets on a DASD Volume</td>
<td>=RDED</td>
</tr>
<tr>
<td>Dataspace Indirect Addressing</td>
<td>=MDMI</td>
</tr>
<tr>
<td>Dataspace Memory</td>
<td>=MDM</td>
</tr>
<tr>
<td>Dataspaces</td>
<td>=MD</td>
</tr>
<tr>
<td>DB2 Activity</td>
<td>=RB</td>
</tr>
<tr>
<td>DB2 Thresholds</td>
<td>OTRB</td>
</tr>
<tr>
<td>DB2 Transaction Details</td>
<td>=RBD</td>
</tr>
<tr>
<td>DBCTL Activity</td>
<td>=RL</td>
</tr>
<tr>
<td>DBCTL Tasks</td>
<td>=RLK</td>
</tr>
<tr>
<td>DBCTL Thresholds</td>
<td>OTRT</td>
</tr>
<tr>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td>To navigate to this panel</td>
<td>Enter this fast path</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>DCT Indirect Information</td>
<td>=CDI</td>
</tr>
<tr>
<td>DCT Intrapartition Information</td>
<td>=CDP</td>
</tr>
<tr>
<td>DCT Remote Information</td>
<td>=CDR</td>
</tr>
<tr>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td>Destination Queues Over Limits</td>
<td>=RNL</td>
</tr>
<tr>
<td>Disable Authorized Commands</td>
<td>OCD</td>
</tr>
<tr>
<td>DL/I Activity</td>
<td>=RI</td>
</tr>
<tr>
<td>DL/I Configuration</td>
<td>=RIC</td>
</tr>
<tr>
<td>DL/I Database Details</td>
<td>=RIDE</td>
</tr>
<tr>
<td>DL/I Database Directory (DDIR)</td>
<td>=CI</td>
</tr>
<tr>
<td>DL/I Databases</td>
<td>=RID</td>
</tr>
<tr>
<td>DL/I Interface Addresses</td>
<td>=RIA</td>
</tr>
<tr>
<td>DL/I Interface ECBs</td>
<td>=RIE</td>
</tr>
<tr>
<td>DL/I ISAM/OSAM Buffers</td>
<td>=RIB</td>
</tr>
<tr>
<td>DL/I PSB Directory Entry</td>
<td>=CBE</td>
</tr>
<tr>
<td>DL/I PSB Directory (PDIR)</td>
<td>=CB</td>
</tr>
<tr>
<td>DL/I—CICS Tasks Using</td>
<td>=RIK</td>
</tr>
<tr>
<td>DL/I Thresholds</td>
<td>OTRI</td>
</tr>
<tr>
<td>DSA Storage</td>
<td>=RST</td>
</tr>
<tr>
<td>Dumps</td>
<td>=AD</td>
</tr>
<tr>
<td>Dumps Thresholds</td>
<td>OTAD</td>
</tr>
</tbody>
</table>

### E

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Authorized Commands</td>
<td>OCE</td>
</tr>
<tr>
<td>Enqueue Conflicts</td>
<td>=AEC</td>
</tr>
<tr>
<td>Enqueue Details</td>
<td>=AED</td>
</tr>
<tr>
<td>Enqueues</td>
<td>=AE</td>
</tr>
<tr>
<td>Enqueues Thresholds</td>
<td>OTAE</td>
</tr>
<tr>
<td>Exit Program Blocks (EPBs)</td>
<td>=CEP</td>
</tr>
<tr>
<td>Extended Help</td>
<td>HE</td>
</tr>
<tr>
<td>External Contention</td>
<td>=ABC</td>
</tr>
<tr>
<td>External Contention Details</td>
<td>=ABCD</td>
</tr>
</tbody>
</table>
### Fast Path Tables

**F**

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td>File Control Table Entry</td>
<td>=CFE</td>
</tr>
<tr>
<td>File Control Table Entry - Data Table</td>
<td>=CFT</td>
</tr>
<tr>
<td>File Control Table Entry - Logging</td>
<td>=CFL</td>
</tr>
<tr>
<td>File Control Table Entry - Statistics</td>
<td>=CFS</td>
</tr>
<tr>
<td>File Details</td>
<td>=RFD</td>
</tr>
<tr>
<td>File/VSAM Thresholds</td>
<td>OTRF</td>
</tr>
<tr>
<td>Front End Programming Interface</td>
<td>WTE</td>
</tr>
</tbody>
</table>

**G**

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global User Exits (GLUEs)</td>
<td>=CE</td>
</tr>
<tr>
<td>Glossary</td>
<td>HG</td>
</tr>
</tbody>
</table>

**H**

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help for help</td>
<td>HH</td>
</tr>
<tr>
<td>Help Index</td>
<td>HI</td>
</tr>
</tbody>
</table>

**I**

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICE Details</td>
<td>=WID</td>
</tr>
<tr>
<td>ICEs Thresholds</td>
<td>OTWI</td>
</tr>
<tr>
<td>Indirect Addressing</td>
<td>=MI</td>
</tr>
<tr>
<td>Internal Bottleneck Collection</td>
<td>OOB</td>
</tr>
<tr>
<td>Internal Bottleneck Details</td>
<td>=ABD</td>
</tr>
<tr>
<td>Internal Bottleneck Display Controls</td>
<td>OOD</td>
</tr>
<tr>
<td>Internal Bottlenecks</td>
<td>=AB</td>
</tr>
<tr>
<td>Interval Control Elements (ICEs)</td>
<td>=WI</td>
</tr>
<tr>
<td>Interval Recording</td>
<td>OOI</td>
</tr>
</tbody>
</table>
### Fast Path Tables

#### Fast Path Tables

<table>
<thead>
<tr>
<th>Panel Description</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intrapartition Transient Data Statistics</td>
<td>=RNS</td>
</tr>
<tr>
<td>I/O Rate Thresholds</td>
<td>=OTAI</td>
</tr>
</tbody>
</table>

#### J

<table>
<thead>
<tr>
<th>Panel Description</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal Control Table Entry</td>
<td>=CJE</td>
</tr>
<tr>
<td>Journal Control Table (JCT)</td>
<td>=CJ</td>
</tr>
<tr>
<td>Journal Details</td>
<td>=RJD</td>
</tr>
<tr>
<td>Journal Models</td>
<td>=RJM</td>
</tr>
<tr>
<td>Journal Thresholds</td>
<td>=OTRJ</td>
</tr>
<tr>
<td>Journals</td>
<td>=RJ</td>
</tr>
</tbody>
</table>

#### K

<table>
<thead>
<tr>
<th>Panel Description</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keys Help</td>
<td>HK</td>
</tr>
</tbody>
</table>

#### L

<table>
<thead>
<tr>
<th>Panel Description</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Shared Resources (LSR) Pools</td>
<td>=RL</td>
</tr>
<tr>
<td>Log Streams</td>
<td>=RJL</td>
</tr>
<tr>
<td>LSR Buffer Pool Details</td>
<td>=RLD</td>
</tr>
<tr>
<td>LSR Buffer Waits</td>
<td>=RFB</td>
</tr>
<tr>
<td>LSR Compound Buffers</td>
<td>=RLDC</td>
</tr>
<tr>
<td>LSR Data Buffers</td>
<td>=RLDA</td>
</tr>
<tr>
<td>LSR Hiperspace Compound Buffers</td>
<td>=RLDH</td>
</tr>
<tr>
<td>LSR Hiperspace Data Buffers</td>
<td>=RLDT</td>
</tr>
<tr>
<td>LSR Hiperspace Index Buffers</td>
<td>=RLDX</td>
</tr>
<tr>
<td>LSR Index Buffers</td>
<td>=RLDI</td>
</tr>
<tr>
<td>LSR Thresholds</td>
<td>=OTRRL</td>
</tr>
</tbody>
</table>
### Fast Path Tables

#### M

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td>Memory</td>
<td>=M</td>
</tr>
<tr>
<td>MQ Activity</td>
<td>=RQ</td>
</tr>
<tr>
<td>MRO/ISC Thresholds</td>
<td>OTRM</td>
</tr>
<tr>
<td>MVS Loaded Modules</td>
<td>=RCM</td>
</tr>
<tr>
<td>MVS Resources</td>
<td>=RCR</td>
</tr>
<tr>
<td>MVS Storage Thresholds</td>
<td>OTRV</td>
</tr>
</tbody>
</table>

#### N

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Features</td>
<td>HN</td>
</tr>
</tbody>
</table>

#### O

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMEGAMON II for CICS Address Symbol Definition</td>
<td>=MOY</td>
</tr>
<tr>
<td>OMEGAMON II for CICS Chase Chain</td>
<td>=MOC</td>
</tr>
<tr>
<td>OMEGAMON II for CICS Dataspaces</td>
<td>=MA</td>
</tr>
<tr>
<td>OMEGAMON II for CICS Indirect Addressing</td>
<td>=MOI</td>
</tr>
<tr>
<td>OMEGAMON II for CICS Memory</td>
<td>=MO</td>
</tr>
<tr>
<td>OMEGAMON II for CICS Scan Memory</td>
<td>=MON</td>
</tr>
<tr>
<td>OMEGAMON II for CICS Zap Memory</td>
<td>=MOZ</td>
</tr>
<tr>
<td>Open VSAM Files</td>
<td>RF</td>
</tr>
</tbody>
</table>

#### P

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Allocation Map</td>
<td>=RSM</td>
</tr>
<tr>
<td>Paging Thresholds</td>
<td>OTRP</td>
</tr>
<tr>
<td>Preferences</td>
<td>OP</td>
</tr>
<tr>
<td>Program Check/Abend Trace Table (CICS/MVS)</td>
<td>=CRP</td>
</tr>
<tr>
<td>Program Compressions (CICS/MVS)</td>
<td>=RSP</td>
</tr>
<tr>
<td>Program Detail</td>
<td>=CPE</td>
</tr>
</tbody>
</table>
### Fast Path Tables

#### Programs =CP

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region Profile</td>
<td>OR</td>
</tr>
<tr>
<td>Resources Thresholds</td>
<td>OTR</td>
</tr>
<tr>
<td>Response Times</td>
<td>=WR</td>
</tr>
<tr>
<td>Response Time Collection</td>
<td>OOR</td>
</tr>
<tr>
<td>Response Time Details</td>
<td>=WRD</td>
</tr>
<tr>
<td>Response Time History</td>
<td>=WRH</td>
</tr>
<tr>
<td>Response Time History Details</td>
<td>=WRHD</td>
</tr>
<tr>
<td>Response Time Groups</td>
<td>OG</td>
</tr>
</tbody>
</table>

#### Storage =RS

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Dataspace Memory</td>
<td>=MDMN</td>
</tr>
<tr>
<td>Scan Memory</td>
<td>=MN</td>
</tr>
<tr>
<td>Screen Print Output Routing Options</td>
<td>OCO</td>
</tr>
<tr>
<td>Sequential TCTTE</td>
<td>=CTQ</td>
</tr>
<tr>
<td>Session Defaults</td>
<td>OCS</td>
</tr>
<tr>
<td>Shutdown Option</td>
<td>OS</td>
</tr>
<tr>
<td>Storage</td>
<td>=RS</td>
</tr>
<tr>
<td>Storage Allocation by Components</td>
<td>=RSC</td>
</tr>
<tr>
<td>Storage Allocation by Tasks</td>
<td>=RSCT</td>
</tr>
<tr>
<td>Storage Details</td>
<td>=RSD</td>
</tr>
<tr>
<td>Storage Subpools</td>
<td>=RSCS</td>
</tr>
<tr>
<td>Storage Violations</td>
<td>=RSV</td>
</tr>
<tr>
<td>System Initialization Table (SIT)</td>
<td>=CS</td>
</tr>
</tbody>
</table>

---

Fast Pathing in the CUA Interface  285
## Fast Path Tables

To navigate to this panel | Enter this fast path
---|---
Tables | =C
Tape Drives | =RA
Tape Drive Details | =RAD
Tapes Thresholds | OTRA
Task Addresses | =WTA
Task Bridge Details | =WTB
Task Details | =WTD
Task File Statistics | =WTF
Task History | =H
Task History Collection | OOH
Task Remote Information | =WTR
Task Statistics | =WTS
Task Storage | =WTO
Task Terminal Statistics | =WTM
Task Thresholds | OTWT
Task Time Analysis | =WTI
Task Umbrella Data | =WTU
Tasks | =WT
Tasks Using DL/I | =RIK
TCB Details | =RCTD
TCP/IP Thresholds | =RT
TCTSE Statistics | =RMS
TCT System Entry (TCTSE) | =RME
TCTTE | =CTE
TCTTE Statistics | =CTS
Temporary Storage | =RO
Temporary Storage Queues | =ROQ
Temporary Storage Statistics | =ROS
Temporary Storage Table (TST) | =CO
Temporary Storage Thresholds | OTRO
Terminal Control Table Prefix (TCTFX) | =AV
Terminal Control Table System Entries (TCTSEs) | =RM
<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Control Table (TCT)</td>
<td>=CT</td>
</tr>
<tr>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td>Transaction Detail</td>
<td>=CNE</td>
</tr>
<tr>
<td>Transaction Rates</td>
<td>=WN</td>
</tr>
<tr>
<td>Transaction Rate Thresholds</td>
<td>OTWN</td>
</tr>
<tr>
<td>Transactions</td>
<td>=CN</td>
</tr>
<tr>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td>Transient Data</td>
<td>=RN</td>
</tr>
<tr>
<td>Transient Data Thresholds</td>
<td>OTRN</td>
</tr>
<tr>
<td>Tutorial</td>
<td>HT</td>
</tr>
</tbody>
</table>

**U**

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>UOWs</td>
<td>=WU</td>
</tr>
<tr>
<td>UOW Details</td>
<td>=WUD</td>
</tr>
<tr>
<td>UOW Enqueues</td>
<td>=WUQ</td>
</tr>
<tr>
<td>UOW Links</td>
<td>=WUL</td>
</tr>
<tr>
<td>UOW Statistics</td>
<td>=WUS</td>
</tr>
<tr>
<td>Userid Profile</td>
<td>OU</td>
</tr>
<tr>
<td>User Information</td>
<td>HU</td>
</tr>
</tbody>
</table>

**V**

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>VSAM Data Component Allocation</td>
<td>=RFVT</td>
</tr>
<tr>
<td>VSAM Data Component Statistics</td>
<td>=RFVD</td>
</tr>
<tr>
<td>VSAM Details</td>
<td>=RFV</td>
</tr>
<tr>
<td>VSAM Index Component Allocation</td>
<td>=RFVX</td>
</tr>
<tr>
<td>VSAM Index Component Statistics</td>
<td>=RFVI</td>
</tr>
<tr>
<td>VSAM String Waits</td>
<td>=RFS</td>
</tr>
<tr>
<td>VTAM ACB Thresholds</td>
<td>OTAV</td>
</tr>
</tbody>
</table>
## Fast Path Tables

### W

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Interface</td>
<td>=RW</td>
</tr>
<tr>
<td>Working Set Size and Paging Rates</td>
<td>=RP</td>
</tr>
<tr>
<td>Workloads Thresholds</td>
<td>OTW</td>
</tr>
</tbody>
</table>

### X

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>XRF Information</td>
<td>=AX</td>
</tr>
<tr>
<td>XRF Thresholds</td>
<td>OTAX</td>
</tr>
</tbody>
</table>

### Z

<table>
<thead>
<tr>
<th>To navigate to this panel</th>
<th>Enter this fast path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zap Dataspace Memory</td>
<td>=MDMZ</td>
</tr>
<tr>
<td>Zap Memory</td>
<td>=MZ</td>
</tr>
</tbody>
</table>
Introduction

This appendix provides you with information about using two new OMEGACENTER features.

- With the new session switching feature, you can switch directly among all OMEGAMON sessions defined to OMEGAVIEW without having to return to OMEGAVIEW.
- With *transplex* navigation, you can track transactions as they execute throughout the *sysplex*. This feature lets you observe a transaction being processed in CICS, IMS, DBCTL, or DB2. Context-sensitive pushbuttons provide the mechanism to navigate from one OMEGAMON to another to follow the transaction, regardless of which subsystem it is running on.

Terminology

The following terms are defined:

```markdown
**sysplex**
A multiple-MVS system environment that allows MCS consoles or extended MCS consoles to receive messages and send commands across systems.

**transplex**
All parts of the sysplex involved in the processing of a transaction.
```

Chapter Contents

- Session Switching ................................................................. 290
- Transplex Navigation ............................................................. 291
- Using Transplex Navigation with OMEGAMON II for CICS ........... 293
Session Switching

The OMEGACENTER session switching feature lets you switch among your OMEGAMON sessions without returning to OMEGAVIEW. This allows quick access to problem information.

Session Switching Procedure

Use the following procedure to switch sessions.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | To switch sessions from any OMEGAMON panel or from the OMEGAVIEW main panel, press the session switch key. (PA1 is the default key.)  
To switch sessions from the OMEGAVIEW main panel action bar, select **Switch** and press Enter.  
**Result:** OMEGAVIEW displays the Switch to Session pop-up menu. |
| 2    | From the Switch to Session pop-up menu, you can do one of the following:  
- Type the name of the session you want in the input field at the top of the session list and press Enter.  
- Move the cursor next to the session you want and press Enter.  
- Use the **Find** key (F14) when you do not know the exact name of the session.  
For example, if you know your session begins with ABC, press **F14** to get the Find Session pop-up. From the Find Session pop-up, type ABC in the Session Name input field and press Enter. OMEGAVIEW returns you to the Switch to Session pop-up menu; the session list will now begin with the session that precedes all of the ABC sessions.  
Select a session with the cursor and press Enter.  
**Result:** OMEGAVIEW switches to the session you have chosen. |
**Transplex Navigation**

With transplex navigation, you can follow a specific transaction from a panel in one OMEGAMON to a panel in another OMEGAMON that contains information corresponding to that transaction. You invoke this feature with a context-sensitive pushbutton that provides the mechanism to navigate between OMEGAMON panels.

**Sample Panel**

The following figure shows how the DBCTL transplex navigation pushbutton (<GoTo DBCTL>) looks on an OMEGAMON II for CICS panel. The subsystem name on the pushbutton depends on the product and panel you are navigating from, but the location of the pushbutton is the same for all of the OMEGAMONs.

**FIGURE 188. Transplex Navigation Pushbutton**

<table>
<thead>
<tr>
<th>File Type</th>
<th>Total Requests</th>
<th>Total Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ VSAM</td>
<td>117</td>
<td>n/a</td>
</tr>
<tr>
<td>_ DL/I</td>
<td>1345</td>
<td>1.237s</td>
</tr>
<tr>
<td>_ DR2</td>
<td>613</td>
<td>0.961s</td>
</tr>
<tr>
<td>_ MQ</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>_ ADABAS</td>
<td>10</td>
<td>0.613s</td>
</tr>
<tr>
<td>_ DATACOM</td>
<td>0</td>
<td>0.000s</td>
</tr>
<tr>
<td>_ IDMS</td>
<td>13</td>
<td>1.226s</td>
</tr>
<tr>
<td>_ SUPRA</td>
<td>1</td>
<td>0.036s</td>
</tr>
<tr>
<td>_ USREVNT1</td>
<td>10</td>
<td>41.034s</td>
</tr>
</tbody>
</table>

**Usage Examples**

The following table shows examples of how you can use transplex navigation to monitor transactions.

<table>
<thead>
<tr>
<th>IF you are at...</th>
<th>AND...</th>
<th>USE Transplex navigation to go to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>an OMEGAMON II for CICS Task File Statistics panel</td>
<td>a transaction is spending too much time in DL1</td>
<td>the corresponding Thread Detail panel in OMEGAMON II for DBCTL for more information</td>
</tr>
</tbody>
</table>
Product Versions and PTFs

The following table shows the minimum product versions that support transplex navigation and the PTFs that you must apply to enable this feature.

<table>
<thead>
<tr>
<th>Product</th>
<th>Version</th>
<th>PTFs</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMEGAVIEW</td>
<td>110</td>
<td>QMV0156</td>
</tr>
<tr>
<td>OMEGAMON II for CICS</td>
<td>100</td>
<td>QOC0728 QC20729</td>
</tr>
<tr>
<td>OMEGAMON II for DB2</td>
<td>260</td>
<td>QO2C169</td>
</tr>
<tr>
<td>OMEGAMON II for IMS</td>
<td>110</td>
<td>QOI1790 QI21791 QI22030</td>
</tr>
<tr>
<td>OMEGAMON II for DBCTL</td>
<td>110</td>
<td>QOI0090 QI20091 QI22030</td>
</tr>
</tbody>
</table>

You must be at the latest cumulative maintenance level for each product. We recommend that you review preventive service planning (PSP) information for these products to ensure that you are at the latest maintenance level. PSP information is available through Candle Electronic Customer Support (CECS) or by calling Candle Support Services.

Higher versions of the products listed above will support transplex navigation. In that case, be sure to apply PTFs for corrective maintenance.

The rest of this appendix provides instructions on how to use transplex navigation from OMEGAMON II for CICS.
Using Transplex Navigation with OMEGAMON II for CICS

From the following panels, you can use transplex navigation to go to the corresponding OMEGAMON II for DBCTL panel, the corresponding OMEGAMON II for DB2 panel, or the corresponding remote OMEGAMON II for CICS panel.

- Task Details
- Task Addresses
- Task File Statistics
- Task Remote Information
- Task Statistics
- Task Storage
- Task Time Analysis
- Task Umbrella Data
- Front End Programming Interface
- Task Terminal Statistics

The procedures below describe how to access and use transplex navigation from these panels.

Requirement

For each target OMEGAMON that you navigate to, the OMEGAVIEW collector session for that OMEGAMON must be active. If an OMEGAMON collector session is not active, OMEGAVIEW displays a message with instructions to contact your system administrator.
Navigating from a Tasks Panel to DBCTL

You can use session switching to reach an OMEGAMON II for CICS session either from OMEGAVIEW or another OMEGAMON; refer to “Session Switching” on page 290 for instructions. Then use the following procedure to access a Tasks panel and use transplex navigation.

**Note:** Transplex navigation is invoked with a pushbutton. If there is no transaction activity to monitor, this pushbutton does not appear on the panel.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the Region Status panel, select <strong>Tasks</strong> and press Enter.</td>
<td>The Tasks panel appears.</td>
</tr>
<tr>
<td>2</td>
<td>From the Tasks panel, select a task and press Enter.</td>
<td>The Task Details panel appears.</td>
</tr>
<tr>
<td>3</td>
<td>From the Task Details panel, select a pushbutton, for example, <strong>Files</strong>, at the bottom of the screen.</td>
<td>The Task File Statistics panel appears.</td>
</tr>
</tbody>
</table>
| 4    | From the Task File Statistics panel, select the **GoTo DBCTL** pushbutton at the bottom of the screen. | The OMEGAMON II for DBCTL target panel appears.  
If you want to return to OMEGAMON II for CICS, select the **Return to CICS** pushbutton at the bottom of the screen.  
**Note:** If the transaction you are monitoring is no longer active, an informational pop-up message appears. |
Navigating from a Tasks Panel to DB2

You can use session switching to reach an OMEGAMON II for CICS session either from OMEGAVIEW or another OMEGAMON; refer to “Session Switching” on page 290 for instructions. Then, use the following procedure to access a Tasks panel and use transplex navigation.

**Note:** Transplex navigation is invoked with a pushbutton. If there is no transaction activity to monitor, this pushbutton does not appear on the panel.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the Region Status panel, select <strong>Tasks</strong> and press Enter.</td>
<td>The Tasks panel appears.</td>
</tr>
<tr>
<td>2</td>
<td>From the Tasks panel, select a task number and press Enter.</td>
<td>The Task Details panel appears.</td>
</tr>
<tr>
<td>3</td>
<td>From the Task Details panel, select a pushbutton, for example, <strong>Files</strong>, at the bottom of the screen.</td>
<td>The Task File Statistics panel appears.</td>
</tr>
<tr>
<td>4</td>
<td>From the Task File Statistics panel, select the <strong>GoTo DB2</strong> pushbutton at the bottom of the screen.</td>
<td>The OMEGAMON II for DB2 target panel appears. If you want to return to OMEGAMON II for CICS, select the <strong>Return to CICS</strong> pushbutton at the bottom of the screen. <strong>Note:</strong> If the transaction you are monitoring is no longer active, an informational pop-up message appears.</td>
</tr>
</tbody>
</table>
Navigating from a Tasks Panel to Remote CICS

You can use session switching to reach an OMEGAMON II for CICS session either from OMEGAVIEW or another OMEGAMON; refer to “Session Switching” on page 290 for instructions. Then, use the following procedure to access a Tasks panel and use transplex navigation.

**Note:** Transplex navigation is invoked with a pushbutton. If there is no transaction activity to monitor, this pushbutton does not appear on the panel.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the Region Status panel, select <strong>Tasks</strong> and press Enter.</td>
<td>The Tasks panel appears.</td>
</tr>
<tr>
<td>2</td>
<td>From the Tasks panel, select a task number and press Enter.</td>
<td>The Task Details panel appears.</td>
</tr>
<tr>
<td>3</td>
<td>From the Task Details panel, select a pushbutton, for example, <strong>Remote</strong>, at the bottom of the screen.</td>
<td>The Task Remote Information panel appears.</td>
</tr>
<tr>
<td>4</td>
<td>From the Task Remote Information panel, select the <strong>GoTo Remote CICS</strong> pushbutton at the bottom of the screen.</td>
<td>The remote OMEGAMON II for CICS target panel appears. If you want to return from the remote OMEGAMON II for CICS, select the <strong>Return from remote CICS</strong> pushbutton at the bottom of the screen. <strong>Note:</strong> If the transaction you are monitoring is no longer active, an informational pop-up message appears.</td>
</tr>
</tbody>
</table>
Introduction

This appendix describes how you can modify attributes for some CICS resources directly on OMEGAMON II for CICS panels.

Chapter Contents

Purpose ................................................................. 298
Summary of Panel Changes ................................. 302
Purpose

You can manage CICS resources more easily by modifying resource attributes directly on the Common User Access (CUA) summary and detail panels in OMEGAMON II for CICS.

Description

The following changes have been made to the CUA panels in OMEGAMON II for CICS:

- New actions codes have been added to specific CUA panels.
- To aid memorization, new action codes are displayed on summary panels.
- Some previously display-only fields are now entry fields, and new entry fields have been added to some panels. With these changes, you can modify a resource attribute (for example, the Maximum Tasks Limit) displayed in a field.

Requirements

You must be authorized in OMEGAMON II for CICS to perform the specified actions. There are two kinds of security:

- If you are using function-level security, user authorization is controlled by the CUA function level security resource `cicsname.KC2.MEM.CEMT`
- If you are using menu system security, you can control user authorization for the actions by restricting access to the CMT command

Procedures for Modifying Resource Attributes

Performing actions from a Summary Panel

Action codes are usually displayed directly on a summary panel to indicate the actions you can perform on a resource. For example, the following `Programs` panel shows the action codes (E, I, N, and P) you can specify for programs. Action codes differ depending on the panel that is displayed.

On the `Programs` panel, for example, you type the appropriate code in the action entry field preceding the `Program ID` to change the attribute for that program. In the following example, the `NewCopy(N)` action is selected for the CMRTRNJ0 program.
Performing Actions from a Detail Panel

From a detail panel, you can select the action you want to perform on the resource from the **Actions** pulldown menu. The choices on the **Actions** menu differ depending on the panel that is displayed. For example, the following **Actions** pulldown menu for the **Programs Entry** detail panel lists the actions (Enable, Disable, Newcopy, and Phasein) you can perform on the CMRTRNJ0 program.

In this example, the **NewCopy(N)** action is selected for the CMRTRNJ0 program.

**Note:** You can also type the mnemonic AN on the action bar to perform this action.
FIGURE 190. Actions Pulldown Menu for the Program Entry Panel.
Typing Attribute Values in Entry Fields

Another method you can use to modify selected resource attributes is to type a value into an entry field on the panel. In this example (for a system monitoring CICS Release 4.1.0), you can type a value into a field in the **Active Limit** column to change the maximum tasks limit (MXT) or the maximum number of tasks for the defined transaction classes.

**FIGURE 191. Entry Fields on the Transaction Statistics Panel**
Summary of Panel Changes

Introduction
The resource attributes you can modify differ depending on the release of CICS you are monitoring as shown in the following tables.

Each table provides the following information:

- CICS resource
- Resource attribute
- CUA panel name on which you can specify the resource attribute
- Fast path code for accessing the panel

CICS Release 2.1.2
The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 2.1.2.

Table 2. CUA Panel Enhancements (CICS Release 2.1.2)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>Start auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destinations</td>
<td>New actions:</td>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td></td>
<td>Open queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td></td>
<td>Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>DCT Intrapartition Information</td>
<td>=CDP</td>
</tr>
<tr>
<td></td>
<td>Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSA cushion size</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Cushion size</td>
<td>Storage Details</td>
<td>=RSD</td>
</tr>
<tr>
<td>Files</td>
<td>New actions:</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>Open file</td>
<td>File Control Table Entry</td>
<td>=CFE</td>
</tr>
<tr>
<td></td>
<td>Close file</td>
<td>File Control Table Entry - Statistics</td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>Enable file</td>
<td>File Control Table - Logging</td>
<td>=CFL</td>
</tr>
<tr>
<td></td>
<td>Disable file</td>
<td>File Control Table - Data Table</td>
<td>=CFT</td>
</tr>
<tr>
<td>Internal trace</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start internal trace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stop internal trace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trace</td>
<td>= CR</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum active tasks limit</th>
<th>New entry field:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum active tasks</td>
<td></td>
</tr>
<tr>
<td>AMXT Active Limit</td>
<td></td>
</tr>
<tr>
<td>CICS Master Terminal</td>
<td>= ME</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum active tasks limit</th>
<th>New entry field:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum active tasks</td>
<td></td>
</tr>
<tr>
<td>MXT Active Limit</td>
<td></td>
</tr>
<tr>
<td>Transaction Statistics</td>
<td>= WTN</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Programs</th>
<th>New actions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable program</td>
<td></td>
</tr>
<tr>
<td>Disable program</td>
<td></td>
</tr>
<tr>
<td>Newcopy</td>
<td></td>
</tr>
<tr>
<td>Programs</td>
<td>= CP</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region exit interval</th>
<th>New entry field:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region exit interval</td>
<td></td>
</tr>
<tr>
<td>CICS Master Terminal</td>
<td>= ME</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Runaway task interval</th>
<th>New entry field:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Runaway task interval</td>
<td></td>
</tr>
<tr>
<td>CICS Master Terminal</td>
<td>= ME</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stall time interval</th>
<th>New entry field:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stall time interval</td>
<td></td>
</tr>
<tr>
<td>CICS Master Terminal</td>
<td>= ME</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Systems</th>
<th>New actions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set terminal inservice</td>
<td></td>
</tr>
<tr>
<td>Set terminal outservice</td>
<td></td>
</tr>
<tr>
<td>Acquire session</td>
<td></td>
</tr>
<tr>
<td>Release session</td>
<td></td>
</tr>
<tr>
<td>Terminal Control Table System Entries</td>
<td>= RM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Systems</th>
<th>New actions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCT System Entry</td>
<td></td>
</tr>
<tr>
<td>TCT System Entry Statistics</td>
<td>= RMS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Terminals</th>
<th>New actions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set terminal inservice</td>
<td></td>
</tr>
<tr>
<td>Set terminal outservice</td>
<td></td>
</tr>
<tr>
<td>Acquire session</td>
<td></td>
</tr>
<tr>
<td>Release session</td>
<td></td>
</tr>
<tr>
<td>Terminal Control Table (TCT)</td>
<td>= CT</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Terminals</th>
<th>New actions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCTTE</td>
<td></td>
</tr>
<tr>
<td>Sequential TCTTE</td>
<td>= CTQ</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transaction class limits</th>
<th>New entry fields:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class 1 - Class 10 maximum tasks</td>
<td></td>
</tr>
<tr>
<td>CICS Master Terminal</td>
<td>= ME</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transaction class limits</th>
<th>New entry fields:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class01 - Class10 Active Limit</td>
<td></td>
</tr>
<tr>
<td>Transaction Statistics</td>
<td>= WTN</td>
</tr>
</tbody>
</table>
## Summary of Panel Changes

<table>
<thead>
<tr>
<th>Transactions</th>
<th>New actions:</th>
<th>Transactions</th>
<th>= CN</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enable transaction</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disable transaction</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transactions</th>
<th>= CNE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Entry</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>VTAM ACB</th>
<th>New actions:</th>
<th>Terminal Control Table Prefix (TCTFX)</th>
<th>= AV</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open VTAM ACB</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close VTAM ACB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**CICS Release 3.1.1 or 3.2.1**

The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 3.1.1 or 3.2.1.

### Table 3. CUA Panel Enhancements (CICS Release 3.1.1 or 3.2.1)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Pause auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Switch dataset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destinations</td>
<td>New actions:</td>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td></td>
<td>- Open queue</td>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td></td>
<td>- Close queue</td>
<td>DCT Intrapartition Information</td>
<td>=CDP</td>
</tr>
<tr>
<td></td>
<td>- Enable queue</td>
<td>Destination Queues Over Limits</td>
<td>=RNL</td>
</tr>
<tr>
<td></td>
<td>- Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSA cushion sizes</td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- DSA storage cushion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- EDSA storage cushion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The cushion size for the selected area is given in the new <strong>Cushion size</strong> entry field.</td>
<td>Storage Details</td>
<td>=RSD</td>
</tr>
<tr>
<td>Files</td>
<td>New actions:</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>- Open file</td>
<td>File Control Table Entry</td>
<td>=CFE</td>
</tr>
<tr>
<td></td>
<td>- Close file</td>
<td>File Control Table Entry - Statistics</td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>- Enable file</td>
<td>File Control Table - Logging</td>
<td>=CFL</td>
</tr>
<tr>
<td></td>
<td>- Disable file</td>
<td>File Control Table - Data Table</td>
<td>=CFT</td>
</tr>
<tr>
<td>GTF trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>- Start internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Stop internal trace</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 3. CUA Panel Enhancements (CICS Release 3.1.1 or 3.2.1)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum active tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Maximum active task</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New entry field:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>AMXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Maximum tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New entry field:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>MXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programs</td>
<td>New actions:</td>
<td>Programs</td>
<td>=CP</td>
</tr>
<tr>
<td></td>
<td>Enable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Newcopy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Phasein</td>
<td>Program Entry</td>
<td>=CPE</td>
</tr>
<tr>
<td>Region exit interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Region exit interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway task interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Runaway task interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan delay interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Scan delay interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Systems</td>
<td>New actions:</td>
<td>Terminal Control Table System Entries</td>
<td>=RM</td>
</tr>
<tr>
<td></td>
<td>Set terminal inservice</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set terminal outservice</td>
<td>TCT System Entry</td>
<td>=RME</td>
</tr>
<tr>
<td></td>
<td>Acquire session</td>
<td>TCT System Entry Statistics</td>
<td>=RMS</td>
</tr>
<tr>
<td></td>
<td>Release session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminals</td>
<td>New actions:</td>
<td>Terminal Control Table (TCT)</td>
<td>=CT</td>
</tr>
<tr>
<td></td>
<td>Set terminal inservice</td>
<td>TCTTE</td>
<td>=CTE</td>
</tr>
<tr>
<td></td>
<td>Set terminal outservice</td>
<td>Sequential TCTTE</td>
<td>=CTQ</td>
</tr>
<tr>
<td></td>
<td>Acquire session</td>
<td>TCTTE Statistics</td>
<td>=CTS</td>
</tr>
<tr>
<td></td>
<td>Release session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction class limits</td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Class 1 - Class 10 maximum tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New entry fields:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>Class01 - Class10 Active Limit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 3. CUA Panel Enhancements (CICS Release 3.1.1 or 3.2.1)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactions</td>
<td>New actions:</td>
<td>Transactions</td>
<td>=CN</td>
</tr>
<tr>
<td></td>
<td>■ Enable transaction</td>
<td>Transaction Entry</td>
<td>=CNE</td>
</tr>
<tr>
<td></td>
<td>■ Disable transaction</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VTAM ACB</td>
<td>New actions:</td>
<td>Terminal Control Table Prefix (TCTFX)</td>
<td>=AV</td>
</tr>
<tr>
<td></td>
<td>■ Open VTAM ACB</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Close VTAM ACB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

CICS Release 3.3.0

The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 3.3.0.

Table 4. CUA Panel Enhancements (CICS Release 3.3.0)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>■ Start auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Pause auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Stop auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Switch dataset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destinations</td>
<td>New actions:</td>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td></td>
<td>■ Open queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Close queue</td>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td></td>
<td>■ Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>DCT Intrapartition Information</td>
<td>=CDP</td>
</tr>
<tr>
<td></td>
<td>■ Enable queue</td>
<td>Destination Queues Over Limits</td>
<td>=RNL</td>
</tr>
<tr>
<td></td>
<td>■ Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSA cushion sizes</td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>■ CDSA cushion size</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ USDA cushion size</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ ERDSA cushion size</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ ECDSA cushion size</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ EUDSA cushion size</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cushion size for the selected area is given in the new <strong>Cushion size</strong> entry field.</td>
<td>Storage Details</td>
<td>=RSD</td>
</tr>
</tbody>
</table>
### Table 4. CUA Panel Enhancements (CICS Release 3.3.0)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files</td>
<td>New actions:</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>Open file</td>
<td>File Control Table Entry</td>
<td>=CFE</td>
</tr>
<tr>
<td></td>
<td>Close file</td>
<td>File Control Table Entry - Statistics</td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>Enable file</td>
<td>File Control Table - Logging</td>
<td>=CFL</td>
</tr>
<tr>
<td></td>
<td>Disable file</td>
<td>File Control Table - Data Table</td>
<td>=CFT</td>
</tr>
<tr>
<td>GTF trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>Start GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>Start internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum active tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Maximum active tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AMXT Active Limit</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td>Maximum tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Maximum tasks</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>MXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programs</td>
<td>New actions:</td>
<td>Programs</td>
<td>=CP</td>
</tr>
<tr>
<td></td>
<td>Enable program</td>
<td>Program Entry</td>
<td>=CPE</td>
</tr>
<tr>
<td></td>
<td>Disable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Newcopy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Phasein</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region exit interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Region exit interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway task interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Runaway task interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan delay interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>Scan delay interval</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 4. CUA Panel Enhancements (CICS Release 3.3.0)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Systems</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Set terminal in-service</td>
<td>Terminal Control Table System Entries</td>
<td>=RM</td>
</tr>
<tr>
<td></td>
<td>- Set terminal out-service</td>
<td>TCT System Entry</td>
<td>=RME</td>
</tr>
<tr>
<td></td>
<td>- Acquire session</td>
<td>TCT System Entry Statistics</td>
<td>=RMS</td>
</tr>
<tr>
<td></td>
<td>- Release session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminals</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Set terminal in-service</td>
<td>Terminal Control Table (TCT)</td>
<td>=CT</td>
</tr>
<tr>
<td></td>
<td>- Set terminal out-service</td>
<td>TCTTE</td>
<td>=CTE</td>
</tr>
<tr>
<td></td>
<td>- Acquire session</td>
<td>Sequential TCTTE</td>
<td>=CTQ</td>
</tr>
<tr>
<td></td>
<td>- Release session</td>
<td>TCTTE Statistics</td>
<td>=CTS</td>
</tr>
<tr>
<td></td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Class 1 - Class 10 maximum tasks</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>- Class 01 - Class 10 Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New entry fields:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Class 1 - Class 10 maximum tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Class 01 - Class 10 Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>Transactions</td>
<td>=CN</td>
</tr>
<tr>
<td></td>
<td>- Enable transaction</td>
<td>Transaction Entry</td>
<td>=CNE</td>
</tr>
<tr>
<td></td>
<td>- Disable transaction</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VTAM ACB</td>
<td>New actions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Open VTAM ACB</td>
<td>Terminal Control Table Prefix (TCTFX)</td>
<td>=AV</td>
</tr>
<tr>
<td></td>
<td>- Close VTAM ACB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
CICS Release 4.1.0

The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 4.1.0

Table 5. CUA Panel Enhancements (CICS Release 4.1.0)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>■ Start auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Pause auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Stop auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Switch dataset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destinations</td>
<td>New actions:</td>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td></td>
<td>■ Open queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Close queue</td>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td></td>
<td>■ Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>DCT Intrapartition Information</td>
<td>=CDP</td>
</tr>
<tr>
<td></td>
<td>■ Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Disable queue</td>
<td>Destination Queues Over Limits</td>
<td>=RNL</td>
</tr>
<tr>
<td>DSA limits</td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>■ DSA limit</td>
<td>CICS Storage</td>
<td>=RS</td>
</tr>
<tr>
<td></td>
<td>■ EDSA limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Files</td>
<td>New actions:</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>■ Open file</td>
<td>File Control Table Entry</td>
<td>=CFE</td>
</tr>
<tr>
<td></td>
<td>■ Close file</td>
<td>File Control Table Entry - Statistics</td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>■ Enable file</td>
<td>File Control Table - Logging</td>
<td>=CFL</td>
</tr>
<tr>
<td></td>
<td>■ Disable file</td>
<td>File Control Table - Data Table</td>
<td>=CFT</td>
</tr>
<tr>
<td>GTF trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>■ Start GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Stop GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>■ Start internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Stop internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CICS Resource</td>
<td>Resource Attributes</td>
<td>CUA Panel Name</td>
<td>Fast Path</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------</td>
<td>------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Maximum tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>■ Maximum tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New entry field:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>■ MXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programs</td>
<td>New actions:</td>
<td>Programs</td>
<td>=CP</td>
</tr>
<tr>
<td></td>
<td>■ Enable program</td>
<td>Program Entry</td>
<td>=CPE</td>
</tr>
<tr>
<td></td>
<td>■ Disable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Newcopy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Phasein</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region exit interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>■ Region exit interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway task interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>■ Runaway task interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan delay interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>■ Scan delay interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Systems</td>
<td>New actions:</td>
<td>Terminal Control Table System Entries</td>
<td>=RM</td>
</tr>
<tr>
<td></td>
<td>■ Set terminal inservice</td>
<td>TCT System Entry</td>
<td>=RME</td>
</tr>
<tr>
<td></td>
<td>■ Set terminal outservice</td>
<td>TCT System Entry Statistics</td>
<td>=RMS</td>
</tr>
<tr>
<td></td>
<td>■ Acquire session</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Release session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminals</td>
<td>New actions:</td>
<td>Terminal Control Table (TCT)</td>
<td>=CT</td>
</tr>
<tr>
<td></td>
<td>■ Set terminal inservice</td>
<td>TCTTE</td>
<td>=CTE</td>
</tr>
<tr>
<td></td>
<td>■ Set terminal outservice</td>
<td>Sequential TCTTE</td>
<td>=CTQ</td>
</tr>
<tr>
<td></td>
<td>■ Acquire session</td>
<td>TCTTE Statistics</td>
<td>=CTS</td>
</tr>
<tr>
<td></td>
<td>■ Release session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction class limits</td>
<td>New entry fields:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>■ An <strong>Active Limit</strong> field for each defined transaction class</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transactions</td>
<td>New actions:</td>
<td>Transactions</td>
<td>=CN</td>
</tr>
<tr>
<td></td>
<td>■ Enable transaction</td>
<td>Transaction Entry</td>
<td>=CNE</td>
</tr>
<tr>
<td></td>
<td>■ Disable transaction</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VTAM ACB</td>
<td>New actions:</td>
<td>Terminal Control Table Prefix (TCTFX)</td>
<td>=AV</td>
</tr>
<tr>
<td></td>
<td>■ Open VTAM ACB</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Close VTAM ACB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### CICS Release 5.1.0

The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 5.1.0.

**Table 6. CUA Panel Enhancements (CICS Release 5.1.0)**

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Trace</td>
<td>New actions:</td>
<td>Trace</td>
<td>=CR</td>
</tr>
<tr>
<td></td>
<td>• Start auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pause auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Stop auxiliary trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Switch dataset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destinations</td>
<td>New actions:</td>
<td>Destination Control Table (DCT)</td>
<td>=CD</td>
</tr>
<tr>
<td></td>
<td>• Open queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Close queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>DCT Extrapartition Information</td>
<td>=CDE</td>
</tr>
<tr>
<td></td>
<td>• Enable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Disable queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSA limits</td>
<td>New entry fields:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>• DSA limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• EDSA limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Files</td>
<td>New actions:</td>
<td>File Control Table (FCT)</td>
<td>=CF</td>
</tr>
<tr>
<td></td>
<td>• Open file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Close file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Enable file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Disable file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>File Control Table Entry</td>
<td>=CFE</td>
</tr>
<tr>
<td></td>
<td>• Start GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Stop GTF trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New actions:</td>
<td>File Control Table Entry - Statistics</td>
<td>=CFS</td>
</tr>
<tr>
<td></td>
<td>• Start internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Stop internal trace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Journals</td>
<td>New action:</td>
<td>Journals</td>
<td>=RJ</td>
</tr>
<tr>
<td></td>
<td>• Enable journal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Disable journal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Flush journal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Reset journal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New action:</td>
<td>Journal Details</td>
<td>=RJD</td>
</tr>
</tbody>
</table>

This table provides a summary of panel changes for CICS Release 5.1.0, detailing new actions and enhancements for various CICS components, including auxiliary trace, destinations, DSA limits, files, GTF trace, internal trace, and journals.
<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum tasks limit</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Maximum tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New entry field:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>- MXT Active Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programs</td>
<td>New actions:</td>
<td>Programs</td>
<td>=CP</td>
</tr>
<tr>
<td></td>
<td>- Enable program</td>
<td>Program Entry</td>
<td>=CPE</td>
</tr>
<tr>
<td></td>
<td>- Disable program</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Newcopy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Phasein</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region exit interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Region exit interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway task interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Runaway task interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan delay interval</td>
<td>New entry field:</td>
<td>CICS Master Terminal</td>
<td>=ME</td>
</tr>
<tr>
<td></td>
<td>- Scan delay interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Systems</td>
<td>New actions:</td>
<td>Terminal Control Table System Entries</td>
<td>=RM</td>
</tr>
<tr>
<td></td>
<td>- Set terminal inservice</td>
<td>TCT System Entry</td>
<td>=RME</td>
</tr>
<tr>
<td></td>
<td>- Set terminal outservice</td>
<td>TCT System Entry Statistics</td>
<td>=RMS</td>
</tr>
<tr>
<td></td>
<td>- Acquire session</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Release session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Bridge information</td>
<td>Task Bridge Details</td>
<td>=WTB</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>TCP/IP Sockets</td>
<td>TCP/IP Sockets Activity</td>
<td>=RT</td>
</tr>
<tr>
<td>Terminals</td>
<td>New actions:</td>
<td>Terminal Control Table (TCT)</td>
<td>=CT</td>
</tr>
<tr>
<td></td>
<td>- Set terminal inservice</td>
<td>TCTTE</td>
<td>=CTE</td>
</tr>
<tr>
<td></td>
<td>- Set terminal outservice</td>
<td>Sequential TCTTE</td>
<td>=CTQ</td>
</tr>
<tr>
<td></td>
<td>- Acquire session</td>
<td>TCTTE Statistics</td>
<td>=CTS</td>
</tr>
<tr>
<td></td>
<td>- Release session</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction class limits</td>
<td>New entry fields:</td>
<td>Transaction Statistics</td>
<td>=WTN</td>
</tr>
<tr>
<td></td>
<td>- An <strong>Active Limit</strong> field for each defined transaction class</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transactions</td>
<td>New actions:</td>
<td>Transactions</td>
<td>=CN</td>
</tr>
<tr>
<td></td>
<td>- Enable transaction</td>
<td>Transaction Entry</td>
<td>=CNE</td>
</tr>
<tr>
<td></td>
<td>- Disable transaction</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Summary of Panel Changes

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>UOW</td>
<td>New actions:</td>
<td>UOWs</td>
<td>=WU</td>
</tr>
<tr>
<td></td>
<td>▪ Force commit</td>
<td>UOW Details</td>
<td>=WUD</td>
</tr>
<tr>
<td></td>
<td>▪ Force backout</td>
<td>UOW Enqueues</td>
<td>=WUQ</td>
</tr>
<tr>
<td></td>
<td>▪ Force defined action</td>
<td>UOW Links</td>
<td>=WUL</td>
</tr>
<tr>
<td>UOW links</td>
<td>New action:</td>
<td>UOW Links</td>
<td>=WUL</td>
</tr>
<tr>
<td></td>
<td>▪ Delete UOW link</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VTAM ACB</td>
<td>New actions:</td>
<td>Terminal Control Table Prefix (TCTFX)</td>
<td>=AV</td>
</tr>
<tr>
<td></td>
<td>▪ Open VTAM ACB</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Close VTAM ACB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web</td>
<td>CICS Web Information</td>
<td>Web Interface</td>
<td>=RW</td>
</tr>
</tbody>
</table>
CICS Release 5.2.0

The following table describes the OMEGAMON II for CICS panel changes you will see when you are monitoring CICS Release 5.2.0.

Table 7. CUA Panel Enhancements (CICS Release 5.2.0)

<table>
<thead>
<tr>
<th>CICS Resource</th>
<th>Resource Attributes</th>
<th>CUA Panel Name</th>
<th>Fast Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>DB2 Active Transactions</td>
<td>DB2TRANSACTIONS with active threads</td>
<td>=RBA</td>
</tr>
<tr>
<td>DB2</td>
<td>DB2ENTRY Detail</td>
<td>DB2ENTRY Details</td>
<td>=RBED</td>
</tr>
<tr>
<td>DB2</td>
<td>DB2ENTRY Names</td>
<td>DB2ENTRYs</td>
<td>=RBE</td>
</tr>
<tr>
<td>DB2</td>
<td>DB2TRAN Names</td>
<td>DB2TRANs</td>
<td>=RBT</td>
</tr>
</tbody>
</table>
Introduction

Candle Corporation is committed to producing top-quality software products and services. To assist you with making effective use of our products in your business environment, Candle is also committed to providing easy-to-use, responsive customer support.

Precision, speed, availability, predictability—these terms describe our products and Customer Support services.

Included in this Guide to Candle Customer Support is information about the following:

Base Maintenance Plan ................................................................. 318
  – Telephone Support
  – eSupport
  – Description of Severity Levels
  – Service-level objectives
  – Recording and monitoring calls for quality purposes
  – Customer Support Escalations
  – Above and Beyond

Enhanced Support Services ........................................................... 322
  – Assigned Support Center Representative (ASCR)
  – Maintenance Assessment Services (MAS)
  – Multi-Services Manager (MSM)

Customer Support Contact Information ........................................ 323
  – Link to Worldwide Support Telephone and E-mail information
Base Maintenance Plan

Overview

Candle offers a comprehensive Base Maintenance Plan to ensure that you realize the greatest value possible from your Candle software investments. We have more than 200 technicians providing support worldwide, committed to being responsive and to providing expedient resolutions to support requests. Technicians are available worldwide at all times during the local business day. In the event of an after-hours or weekend emergency, our computerized call management and forwarding system will ensure that a technician responds to Severity One situations within one hour. For customers outside of North America, after-hours and weekend support is provided in English language only by Candle Customer Support technicians located in the United States.

Telephone support

Candle provides consistently reliable levels of service—thanks to our worldwide support network of dedicated experts trained for specific products and operating systems. You will always work with a professional who truly understands your problem.

We use an online interactive problem management system to log and track all customer-reported support requests. We give your support request immediate attention by routing the issue to the appropriate technical resource, regardless of geographic location.

- **Level 0 Support** is where your call to Candle Customer Support is first handled. Your support request is recorded in our problem management system, then transferred to the appropriate Level 1 support team. We provide Level 0 manual interaction with our customers because we support more than 170 products. We feel our customers would prefer personal interaction to a complex VRU or IVR selection menu.

- **Level 1 Support** is the service provided for initial support requests. Our Level 1 team offers problem determination assistance, problem analysis, problem resolutions, installation assistance, and preventative and corrective service information. They also provide product usage assistance.

- **Level 2 Support** is engaged if Level 1 cannot provide a resolution to your problem. Our Level 2 technicians are equipped to analyze and reproduce errors or to determine that an error is not reproducible. Problems that cannot be resolved by Level 2 are escalated to Candle’s Level 3 R&D support team.

- **Level 3 Support** is engaged if a problem is identified in Candle product code. At Level 3, efforts are made to provide error correction, circumvention or notification that a correction or circumvention is not available. Level 3 support provides available maintenance modifications and maintenance delivery to correct appropriate documentation or product code errors.

**eSupport**

In order to facilitate the support process, Candle also provides eSupport, an electronic full-service information and customer support facility, via the World Wide Web at www.candle.com/support/. eSupport allows you to open a new service request and update
existing service requests, as well as update information in your customer profile. New and updated service requests are queued to a support technician for immediate action. And we can respond to your request electronically or by telephone—it is your choice.

eSupport also contains a continually expanding knowledge base that customers can tap into at any time for self-service access to product and maintenance information.

The Candle Web Site and eSupport can be accessed 24 hours a day, 7 days a week by using your authorized Candle user ID and password.

**Description of Candle severity levels**

Responses to customer-reported product issues and usage questions are prioritized within Candle according to Severity Code assignment. Customers set their own Severity Levels when contacting a support center. This ensures that we respond according to your individual business requirements.

<table>
<thead>
<tr>
<th>Severity 1</th>
<th>A crisis affects your ability to conduct business, and no procedural workaround exists. The system or application may be down.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity 2</td>
<td>A high-impact problem indicates significant business effect to you. The program is usable but severely limited.</td>
</tr>
<tr>
<td>Severity 3</td>
<td>A moderate-impact problem involves partial, non-critical functionality loss or a reasonable workaround to the problem. A “fix” may be provided in a future release.</td>
</tr>
<tr>
<td>Severity 4</td>
<td>A low-impact problem is a “how-to” or an advisory question.</td>
</tr>
<tr>
<td>Severity 5</td>
<td>This is a request for software or documentation enhancement. Our business units review all requests for possible incorporation into a future release of the product.</td>
</tr>
</tbody>
</table>

**Candle has established the following service-level objectives:**

<table>
<thead>
<tr>
<th>Call Status</th>
<th>Severity 1 Goal</th>
<th>Severity 2 Goal</th>
<th>Severity 3 Goal</th>
<th>Severity 4 Goal</th>
<th>Severity 5 Goal</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Call Time to Answer</td>
<td>90% within one minute</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level 1 Response</td>
<td>90% within 5 minutes</td>
<td>90% within one hour</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Normal Business Hours)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level 2 Response</td>
<td>Warm Transfer</td>
<td>90% within two hours</td>
<td>90% within eight hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Normal Business Hours)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The above information is for guideline purposes only. Candle does not guarantee or warrant the above service levels. This information is valid as of October 1999 and is subject to change without prior notice.
<table>
<thead>
<tr>
<th>Call Status</th>
<th>Severity 1 Goal</th>
<th>Severity 2 Goal</th>
<th>Severity 3 Goal</th>
<th>Severity 4 Goal</th>
<th>Severity 5 Goal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled follow-up (status update)</td>
<td>Hourly or as agreed</td>
<td>Daily or as agreed</td>
<td>Weekly or as agreed</td>
<td>Notification is made when an enhancement is incorporated into a generally available product.</td>
<td>Notification is made when a fix is incorporated into a generally available product.</td>
</tr>
</tbody>
</table>

The above information is for guideline purposes only. Candle does not guarantee or warrant the above service levels. This information is valid as of October 1999 and is subject to change without prior notice.
Recording and Monitoring Calls for Quality Purposes

Candle is committed to customer satisfaction. To ensure that our customers receive high levels of service, quality and professionalism, we’ll monitor and possibly record incoming and outgoing Customer Support calls. The information gleaned from these calls will help us serve you better. If you prefer that your telephone call with Candle Customer Support in North America not be monitored or recorded, please advise the representative when you call us at (800) 328-1811 or (310) 535-3636.

Customer Support Escalations

Candle Customer Support is committed to achieving high satisfaction ratings from our customers. However, we realize that you may occasionally have support issues that need to be escalated to Candle management. In those instances, we offer the following simple escalation procedure:

If you experience dissatisfaction with Candle Customer Support at any time, please escalate your concern by calling the Candle support location closest to you. Ask to speak to a Customer Support manager. During standard business hours, a Customer Support manager will be available to talk with you or will return your call. If you elect to hold for a manager, you will be connected with someone as soon as possible. If you wish a return call, please tell the Candle representative coordinating your call when you will be available. After contacting you, the Customer Support manager will develop an action plan to resolve your issue. All escalations or complaints received about support issues are logged and tracked to ensure responsiveness and closure.

Above and Beyond

What differentiates Candle’s support services from our competitors? We go the extra mile by offering the following as part of our Base Maintenance Plan:

- Unlimited multi-language defect, installation and operations support
- eSupport using the World Wide Web
- Regularly scheduled product updates and maintenance provided at no additional charge
- Over 200 specialized technicians providing expert support for your Candle products
Enhanced Support Services

Overview

Our Base Maintenance Plan provides a high level of software support in a packaged offering. However, in addition to this plan, we have additional fee-based support services to meet unique customer needs.

The following are some examples of our added-value support services:

- **Assigned Support Center Representative Services (ASCR)**
  - An assigned focal point for managing support escalation needs
  - Proactive notification of available software fixes
  - Proactive notification of product version updates
  - Weekly conference calls with your ASCR to review active problem records
  - Monthly performance reviews of Candle Customer Support service levels
  - Optional on-site visits (extra charges may apply)

- **Maintenance Assessment Service (MAS)**
  - On-site assessment services
  - Advice about product maintenance and implementation
  - Training your staff to develop efficient and focused procedures to reduce overall cost of ownership of your Candle software products
  - Analysis of your Candle product environment: versions, updates, code correction history, incident history and product configurations
  - Reviews to ensure that purchased Candle products and solutions are used effectively

- **Multi-Services Manager (MSM)**
  Multi-Services Manager provides highly valued services to customers requiring on-site full time expertise to complement their technical resources.
  - Dedicated on-site Candle resource (6 months or one year) at your site to help ensure maximum use and effectiveness of your Candle products
  - Liaison for all Candle product support activities, coordination and assistance with implementation of all product updates and maintenance releases
  - Works with your staff to understand business needs and systems requirements
  - Possesses technical and systems management skills to enhance your staff’s knowledge and expertise
  - Other projects as defined in Statement of Work for MSM services
Customer Support Contact Information

Link to Worldwide Support Telephone and E-mail information

To contact Customer Support, the current list of telephone numbers and e-mail addresses can be found on the Candle Web site, www.candle.com/support/.

Select Support Contacts from the list on the left of the page.
Index

Numeric
3270 terminal/emulator 33

A
accessing OMEGAMON II
  through direct logon 48
  through OMEGAVIEW 52
account level security 49
account number 48
action bar
  Actions 35
  GoTo 35
  help 35, 40
  home position on 35
  Index 35
  moving cursor to the 35
  Options 35
  selecting from the 35
  using the 35
  View 35
action code 38, 60
  explicit 74
  implicit 74
Actions pull-down menu 60
active elements 142
address space initialization 48
Adobe portable document format 17
alerts
  bottlenecks 230
  CICS loop 234
  CICS time-of-day 234
dumps 236
enqueues 238
I/O rate 241
VTAM ACB 244
XRF 247
all-uppercase text display 34
alternate CICS region, starting 248
alternative logon method 52
analyzing problems
  DASD 169
  for bottlenecks 232
  for CICS loops 235
  for CPU 165
  for DB2 172
  for DBCTL 173
  for DL/I 176
  for dumps 237
  for enqueues 240
  for files 179
  for I/O rate 244
  for journals 187
  for local resource pools (LSR) 191
  for storage 200
  for tapes 202
  for temporary storage 206
  for transient data 211
  for VTAM ACB 245
  for XRF 250
application trace data
  controlling collection of data 89
  setting filters 89
application, poor response 110
ASCR
  assigned support center representative 322
  assigned support center representative
    ASCR 322
asterisk (*) 33
  entering an 142, 185, 230
authorized commands
  disable 79
  enable 79
auto refresh interval 58, 77
automatic initiate descriptor (AID) 130
  analyze problems for 134
  terminating 131

B
batch reports
  historical reporter 30
  SAS (Statistical Analysis System) 30
  user-written programs 30
beep 73
bottleneck analysis 143, 230
  external bottlenecks 106
  internal bottlenecks 106, 143

C
CICS control blocks 62
CICS File/Database (CUA)
  activating collection 85
CICS Memory panel 63
CICS monitoring 87
CICS region 47
  monitoring a 58
  OMEGAVIEW Switch Session key 58
  profile, settings for 94
  region profile search order 58
  switching to another 58
CICS shutdown task purge option 89
CICS Tables panel 62
CL/Engine address space 48
clock, CICS 234
Close Print Log option 95
CMXT exception 145
Collection Controls option 80
color, highlighting 33
commands, protected 51
common interface password 51
Common System Area (CSA) 234
data collection 57
CPU consumption 164
CUA interface 15, 26, 31
  accessing through direct logon 26, 48
  accessing through OMEGAVIEW 26, 52
  customizing options for the 72
  exiting from 45
  panels 32
  session 72
  using 26
customer service
telephone support 318
customer support
  base maintenance plan 318
  contact information 323
  enhanced support services 322
  eSupport 318
  severity levels 319
customization defaults, verifying 52

D
DASD 167
data collection 80
  for CICS file/database information 85
  for internal bottlenecks 80
  for interval recording 83
  for response time 82
  for task history 84
  frequency of 57
data display area 32
data integrity, loss of 146
date and time
  format 74
  stamp 58
DB2 170
DBCTL 173
default
  options 72
  settings (changing response time) 140
  userid profile 92
  view 77
Default view 77
direct logon 48
disable authorized commands 79
DL/I 175
documentation set 16
dropped ready 167
dump analysis
  controlling collection time for counts 88
  resetting the count 88
dumps 236
dynamic groups 254
Dynamic Profile Update Facility 96

E
elements
  deleting from multiple groups 267
  deleting from single group 265
Elements in a Group panel 260
eUSSP
  customer support 318
  excessive CPU usage 100, 164
  excessive response time 104
  enqueues 238
  enter key 42
  eSupport
  customer support 318
  excessive CPU usage 100, 164
  excessive response time 104
  enqueues 238
  exit from CUA interface 45
  explicit selection 60
  extended recovery facility (XRF) 247
eXternal contention 106

F
fast path character 38, 278
fast pathing (CUA) 38, 39, 65
tables 277
features, monitoring 28
field-level help 41
file organization
  ESDS 179
  KSDS 179
  RRDS 179
Files 177
filtering criteria 70
filters for application trace data
  ATF filters 89
force purge task 147
frequency of data collection 57
function keys 32, 43, 74

G
getting started 47
Go To pull-down menu 61
group level security 49
group types
  program 261
terminal 261
  transaction 261
  VTAM logical unit (LU) 261
groups
  adding elements to 262
  copying from existing 257
  copying from existing element 259
  creating new 256
  defining 251, 267
  defining elements for 258
  defining elements for (using wildcard characters) 258
  defining permanently 254
  deleting entire 265
  logical unit 140
  modifying 264
  modifying (defining dynamically) 254
  modifying (start Response Time collection) 254
  modifying (stop Response Time collection) 254
  modifying elements for 264
  number of elements supported 252
  purpose of 252
  response time 140

H
help
  from a panel 41
  from an input field 41
  from the action bar 40
glossary 41
  online 40
  search help glossary 40
  search help index 40
  system (CUA interface) 97
Help index 41
Help pull-down menu 40, 97
highlighting
  color 33
  fields 33
  types of text 33
  underscore 33
  historical data 63

I
I/O rate 241
ICE 135
  identifying problems 99
  implicit action/selection 38, 74
  index of panels 65
Index pull-down menu
  fast path codes based on 65
  input field 41
internal bottleneck
  activating collection 80
  analysis 81
  collection 28
  display controls 81
  internal security 133, 137
  intersystem communication 192
  interval control element (ICE) 135
  analyze problems for 139
  details panel 138
  summary panel 135
  terminating a single ICE 136
  terminating ICES for a terminal 136
  interval control element ICE)
  terminating ICES for a transaction 136
  interval recording (CUA) 83
  intrapartition transient data queues, deleting 209
Introduction 25

J
Japanese 74
Journal Models panel 183
journals 182
Journals Details panel 183
Journals panel 182
  pushbuttons 183

K
kill
  AID 131
  ICE 136
  task 146

L
Local Shared Resources (LSR) 189
Log Streams panel 183
  logical tuning approach 27
  logon 269
  options 49
security entry 49
to OMEGAMON II (direct) 48
to OMEGAMON II (through OMEGAVIEW) 52
loop, CICS 234

M
maintenance assessment service
 MAS 322
MAM
 maintenance assessment service 322
measuring performance 27
menu system 26
message queueing (MQ)
 CUA panels 217
displaying application trace data 226
displaying MQ activity 222
limiting resource requests 228
monitoring 215
monitoring functions 219
specifying thresholds 220
migrate profile 51
mnemonics 38, 73
monitoring
 controls, setting 90
 features 28
 message queueing 215
 performance 27
 monitoring, levels of control
 CICS 87
 OMEGAMON II 87
 SMF data collection 87
 monochrome terminal 33
 selecting items on 38
 unavailable items on 33
 more information
 displaying 34
 using More 34
 using overtypable line 34
 MRO/ISC 192
 MSM
 multi-services manager 322
 multi-services manager
 MSM 322
 MXT, % of 145

N
national language 74
navigation
 fast path 38, 39
 point and shoot 38
to all panels 38
transplex 39

with pushbuttons 38, 39
new application has poor response 110

O
OMEGACENTER 289
OMEGAMON 25
OMEGAMON II monitoring 87
OMEGAVIEW 269
 logon 52
 session switching 289
 zoom time from 270
 online help 40, 97
 Options pull-down menu
 delete confirmation 74
 exit confirmation 74

P
Paging field 195
paging rate 195
panel characteristics
 action bar 32
 asterisks 33
 body 32
 color 33
 function keys 32
 help 41
 ID 73
 pushbuttons 32
password 48
 authorized commands 51
 change 49
 common interface 51
 duration of 51
 entering 49
 reset authorization for 51
 performance 99
 data collection 80
 identifying problems 27
 measure 54, 90
 monitoring 27, 90
 setting standards 27
 solving problems 27, 125
 status bar 33
 permanent groups 254
 plus sign (+) 33
 plus sign (+), minus sign (-) 34
 point and shoot 26
 poor response (application) 110
 pop-up window 37
 Preferences option 73
 primary CICS region 247
 printing problems 17
problems
  - identifying 99
  - solving 99, 125
profile
  - default region 93
  - default user ID 91
  - managing, region 93
  - managing, user 91
program changes not reflected 115
program, response time 140
pull-down menu 36
purge
  - task 165
purge tasks at shutdown 89
purge, task 146
pushbuttons 32
  - fastpathing to 38

realtime monitor 25
record level sharing 180
region
  - profile 72, 93
  - profile, search order for 58
  - profile, settings for 94
Region Profiles option 93
Region Status panel 54, 60
report methods 30
reporter, historical 30
resetting the count 88
resource limiting
  - global data area module 86
  - KOCRLIM macro 86
  - setting thresholds 86
resource usage 57
resources 163
  - CPU consumption 164
  - CPU Rates panel (excluded tasks on) 164
DASD 167
DB2 170
DBCTL 173
DL/I 175
files 177
IMS pool types 175
journals 182
local shared resources (LSR) 189
MRO/ISC 192
paging 195
storage 197
tapes 201
temporary storage 204
transient data 208
  - (intrapartition transient data queues, deleting) 209
response time
  - analyze problems for 144
  - collection of 140, 254
  - groups 140, 251
  - poor 105, 108, 110
  - programs, end-to-end 140
  - terminals 140
  - transactions 140
VTAM LU 140
response time (CUA)
  - activating collection 82
restoring values 70
reverse video 33
RLS 180

SAS 30
screen print log 95
scrolling 34
scrolling indicator 34
search facility
  - for help glossary 41
  - for help index 41
Search Index 65
security program 51
selectable field 32
service level 90
service level agreement 90
service level indicator 90
session defaults 72, 77
session switching 289
  - default key 290
  - procedure for 290
severity levels
  - customer support 319
Share control 179
Sign On panel 49
SMF (System Management Facility)
  - records 30
SMF data collection 87
software performance monitor 25
solving problems 99
starting an OMEGAMON II session 52
Statistical Analysis System (SAS)
  - statistics collection VSAM 88
status
  - bar 33
  - characters 77
  - condition, following 27
  - words 77
status bar
color of 33
storage violation analysis
  controlling collection time for counts 88
sysplex, definition of 289
system defaults, changing 72
system features 28
System Management Facility (SMF) 83
Systems Application Architecture (SAA) 26

T
Task History (CUA)
  activating collection 84
Task History panel 63
task purge option 89
task statistics 86
Tasks 145
  AMXT, % of 145
  CMXT, highest % of 145
  summary panel (excluded tasks on) 145
  terminating 146
  wait reasons 146
TCP/IP socket activity 214
telephone support
customer service 318
Temporary Storage Queues panel
deleting queues 206
  hexadecimal queue ID display 206
terminal response time 140
terminal, color 33
terminating CICS, risk of 146
thresholds 54, 72
  critical 90
  default response time settings 140
  values 90
  warning 90
Thresholds option 90
time
  afternoon indicator 75
  morning indicator 75
  separator character 75
time format 75
  valid 75
time and date display 74
time-of-day, CICS 234
tip of the day 52
tips list 41
transaction (Menu)
  response time 140
transient data queues 209
transplex navigation 39, 289
  with OMEGAMON for CICS 293
  transplex, definition of 289
trigger key 64, 77
tuning CICS 27
typical CICS problems
  complaints on bad response 108
  excessive CPU usage 100
  excessive response time 104
  new application has poor response 110
  program changes not reflected 115

U
uppercase text display 34
user complaints on bad response 108
user ID 48
user interfaces
  CUA 26
  menu system 26
  userid profile 50, 72, 91
  settings for 92
Userid Profiles option 91

V
values, restoring 70
Version 520 enhancements 21
View pull-down menu 67
View Some pop-up window
  fields and columns, promptable 69
  for all panels except Task History 67
  for the Task History panel 70
  search criteria 69
  value column, asterisks in 69
virtual storage 63
VSAM analysis
  controlling statistics collection 88
VSAM record level sharing 180
VTAM
  applids 48
  logical units (LUs) 261

W
wait reasons 81
  for CICS/ESA 146
  provided by OMEGAMON II 146
web interface 213
wildcard characters 258
workloads
  automatic initiate descriptor (AID) 130
  interval control element (ICE) 135
  response 140
tasks 145

X
XRF 247
Z

zoom
from OMEGAVIEW to OMEGAMON II 270

return to the CUA interface 64
through OMEGAVIEW 269
to OMEGAMON II menu system 64